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CHAPTER 1. WELCOME TO INFORM 

Akoya's inForm® Tissue Finder™ advanced image analysis software has been developed to 

address the biggest challenge facing microscopists after quantitative imagery has been 

acquired: extracting data. Because signals can be weak and highly mixed, the challenge 

increases when dealing with multiplexed assays. 

inForm provides a powerful and fast solution with an intuitive, easy-to-use software interface. 

What might have been impossible, or have taken days, can now be done in minutes. 

inForm solves challenging image analysis problems by combining fast and easy learn-by-

example automated image processing with object recognition and data analysis tools. It is 

based on machine learning, which means that you can train the program to create an 

effective solution by simply selecting examples of what you want to find within the images. 

inForm then creates an algorithm that you can subsequently apply across the entire image or 

across as many images as you want. 

inForm can read and analyze Akoya's multispectral images and industry-standard RGB 

images, including TIFF files, which are generated using the Akoya Biosciences Quantitative 

Pathology Imaging and Slide Scanning systems. (See Figure 1.1) 

inForm is for research use only. It is not for use in diagnostic procedures. 
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FIGURE 1.1. Sample inForm screen. 

Getting Started – New Users 

Be sure to review the topics in the Introduction to familiarize yourself with the features and 

specifications of the software. 
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CHAPTER 2. INTRODUCTION 

The topics in this section provide basic information about inForm, what it is for, and what you 

can do with it. 

Section Page 

2.1. About inForm 7 

2.2. Software Configuration 8 

2.3. Key Terms 10 

2.4. Using Online Documentation 11 

2.5. Installing and Starting inForm 12 

2.6. Activating the License 13 

2.7. Contacting Akoya Biosciences 14 

2.1. ABOUT INFORM 

inForm operates on monochrome, color, or multispectral images of tissue sections. Sections 

can be stained with standard stains, immunohistochemical stains (IHC), or 

immunofluorescence stains (IF), including Qdot®. Stains can be single or multiplexed up to 50 

markers for multi-analyte analyses to support applications such as signaling pathway research 

in oncology.  

inForm is available in different configurations, with each configuration providing additional 

capabilities for different applications. 

• inForm Tissue Finder can be trained to find virtually any tissue type or structure, such 

as tumor, fibrosis, inflammation, stroma, granuloma, or vessels. 

• inForm Cell Analysis can be used to assess IHC or IF staining levels on a cell-by-cell 

basis for cell prototyping. It can also generate object counts. 

• inForm Viewer can visualize component data and then reconstruct the unmixed 

signals into a composite image. 
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Features 

• Compatibility with Akoya's digital slides (.qptiff) up to 50 channels, Akoya's 

multispectral images (.im3) and conventional color images (.tif, .jpg, etc.). 

• Full range of software configurations, which can include capabilities from simple tissue 

area measurements to cell-as-a-unit multiplexed molecular phenotyping. To view the 

levels of inForm and the capabilities of each level, see Chapter 2.2. Software 

Configuration. 

• Computationally efficient; runs on a standard laptop. 

Specifications 

• Operates on Akoya Biosciences multispectral images (.im3), digital slides (.qptiff) up to 

50 channels, and on monochrome or color images (TIFF, BMP, JPEG, PNG). 

• Computer Specifications: Microsoft® Windows® 10, 64-bit with 32GB RAM 

recommended. (Minimum: Microsoft Windows 10, 64-bit with 8GB RAM). 

2.2. SOFTWARE CONFIGURATION 

inForm is available in the following software configurations, where each configuration 

provides for specific tasks for viewing, selecting, segmenting, and counting. 

Viewer 

inForm Viewer includes the following features: 

• View images. 

• Unmix images. 

• View components and their signals. 

• View a composite of the component images. 

• Export images. 
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Cell Analysis 

inForm Cell Analysis includes all the features that are available in inForm Basic Analysis, plus 

the following features: 

• Manually segment tissue. 

• Create threshold maps. 

• Create colocalization maps. 

• Generate quantitative data for threshold and colocalization maps. 

• Save projects and algorithms. 

• Batch process images. 

• Export data tables. 

• Use cell segmentation to identify cells and cellular compartments. 

• Assign phenotypes to segmented cells. 

• Score segmented cells. 

• Use object segmentation to identify objects. 

Tissue Finder 

inForm Tissue Finder includes all the features that are available in inForm Cell Analysis, plus 

the following features: 

• Train the Tissue Segmenter to automatically identify tissue categories. 

• Automatically segment the image into tissue categories. 

• Merge data files from a set of images or slides into summary data files. 

Steps Available in Each Software Configuration 

The algorithm steps and software features are available in each software configuration are 

summarized below. (See Table 2.1.) 
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TABLE 2.1. Algorithm steps and software features available  

 Viewer Cell Analysis Tissue Finder 

Prepare Images X X X 

Manual Tissue Segmentation  X X 

Trainable Tissue Segmentation   X 

Threshold  X X 

Colocalization  X X 

Cell Segmentation  X X 

Object Segmentation  X X 

Phenotyping  X X 

Score (only used with Cell 
Segmentation) 

 X X 

Export X X X 

Batch Processing  X X 

Review/Merge   X 

 

2.3. KEY TERMS 

The following table lists the key terms that are core to using the inForm software. Refer to the 

terms below when using the software. (See Table 2.2.) 

TABLE 2.2. inForm software terminology 

Term Definition 

Algorithm 

Algorithms include all the steps in processing an image, from image 
preparation, tissue segmentation and/or cell segmentation, object counting 
or scoring, to export. Depending on the project created to analyze the image, 
algorithms can also include threshold or colocalization settings.  

Processing 
Region 

Processing regions are user-drawn regions of interest. Use processing 
regions to process only specific regions on an image. All areas that fall 
outside of the marked processing regions are ignored. 
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Term Definition 

Project 

inForm projects include the images that you added to the project and the 
settings for each step in the algorithm. A new project that contains only the 
Prepare Images and Export Step is automatically created when opening 
inForm. You can work in the new default project, create a new project, or 
open a saved project. 

Spectral 
Region 

Spectral regions are user-drawn regions that identify autofluorescence on an 
image. Spectral regions can be used to create inForm spectral libraries that 
are exported for use with Lamina systems. 

Tissue 
Category 

Tissue Categories identify structures such as tumor cells vs. healthy cells that 
are present in the tissue samples. Regions in the image can be marked 
manually using inForm Basic Analysis or higher. Use inForm Tissue Finder to 
use the Tissue Segmenter to automatically classify tissue. 

Tissue 
Segmenter 

The Tissue Segmenter automatically identifies regions of tissue or regions 
that correspond to specific types of tissue. When you “train” a tissue 
segmenter, it learns how to identify structures in the images based on the 
training regions within each tissue category. The tissue regions or areas that 
the tissue segmenter detects can then be segmented to detect cells and 
perform IHC or IF scoring, or can be used for object counting. Available only 
with inForm Tissue Finder. 

Training Set 

The set of images used to train the Tissue Segmenter to identify tissue 
categories automatically. If you draw a training region on an image, then 
image is automatically added to the training set. To remove an image from 
the training set, right-click the large image in the image display area, and 
then click Training Set. If you remove an image from the training set, then 
the training regions that are on the image are not used when training the 
Tissue Segmenter. (The training regions are not deleted from the image, so 
you can always add the image to the training set again.) You can also use the 
Available Images window to add or remove images from the training set. 

 

2.4. USING ONLINE DOCUMENTATION 

This guide contains detailed information about the inForm application and is designed to be 

used as a reference tool in your everyday work with inForm. The guide explains how to use 

inForm through detailed explanations of features and step-by-step procedures for common 

tasks using realistic scenarios. The PDF file can be read online or can be printed for reference. 

inForm also includes complete documentation in an HTML-based help system, which includes 

all the information in this User Guide. Online help provides three ways of locating information: 
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Use the Contents tab to navigate through the document; use the Index tab to find topics by 

keyword; or use the Search tab to look up topics that contain specific words or phrases. 

2.5. INSTALLING AND STARTING INFORM 

Before you begin the inForm installation, close all open applications. Installation requires an 

administrator account.  

Installing the Software 

inForm requires R 3.1.0 and several R packages to be present on the machine prior to 

installation. If you have not done so already, please download and install R from the inForm 

section of the Akoya Biosciences software downloads site at 

https://www.akoyabio.com/support/software/#inform_tissue_analysis_software. 

After R is installed, launch the inForm installer and follow the wizard prompts to install the 

software. inForm requires the Microsoft .NET 4.5 framework. The installer installs Microsoft 

.NET 4.5 if it is not already installed. 

The installer asks which fluorophores are commonly in use at your lab. Selecting these choices 

sets the default fluorophore values for available Measured and Synthetic Spectra. You can 

change this default in Chapter 3.5. Stain Store Management. 

Starting inForm 

Select Start > Akoya Biosciences > inForm 

OR 

double-click the inForm shortcut on the Windows desktop. 

To use any software configuration other than inForm Viewer, see Chapter 2.6. Activating the 

License. 

https://www.akoyabio.com/support/software/#inform_tissue_analysis_software.
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2.6. ACTIVATING THE LICENSE 

After inForm is installed, the only options that are available are for inForm Viewer. You must 

activate the customer license to enable any purchased software options. License activation 

requires an administrator account. 

To activate a customer license: 

1. Log into the computer using an account with Windows Administrator permissions. 

2. From the Windows start menu, start the inForm Licensing Application: Start > Akoya 

Biosciences > inForm License App. (See Figure 2.1.) 

 

FIGURE 2.1. inForm License Application window to active your license. 

3. Click Activate License.  

The Activate the Software dialog box opens. 

4. Select Activate, and then click the OK. 

The Enter Your License Number dialog box opens.  

5. Enter your 20-character license number. 

The Activation Options are enabled: Internet and Offline. 

6. Activate your license.  

a. If the Internet (online) activation is available, then select this option. 

After you successfully activate inForm online, the Enter Your License Number 
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dialog box closes. You can then close the inForm License Application dialog box 

and start inForm. 

b. If the Internet (online) activation is not available, select Offline to open the Offline 

Activation dialog box, and then carry out the following steps to activate your 

software offline: 

i. Click Copy to Clipboard to copy the text that is displayed in the Offline 

Activation dialog box to the Windows clipboard. 

ii. Email the copied text to the email address that is shown in the Offline 

Activation dialog box, and then wait to receive the email that contains the text 

for the response key. 

iii. Enter or paste the response key from the email where indicated in the Offline 

Activation dialog box, and then click OK. 

iv. The Offline Activation dialog box closes. You can then close the inForm License 

Application dialog box and start inForm. 

2.7. CONTACTING AKOYA BIOSCIENCES 

For more information, contact Akoya Biosciences or your local authorized distributor. 

Akoya Biosciences, Inc. 

100 Campus Drive, 6th Floor Marlborough, MA 01752, USA 

Technical Support: 

Phone: +1 855-896-8401 

Fax: +1 855-404-0061 

Akoya Biosciences Web Site: http://www.akoyabio.com  

Email: CustomerCare@akoyabio.com  

Email (Outside the US): CustomerCareEMEA@akoyabio.com   

http://www.akoyabio.com/
mailto:CustomerCare@akoyabio.com
mailto:CustomerCareEMEA@akoyabio.com
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CHAPTER 3. UNDERSTANDING THE INFORM WORK 
AREA 

Section Page 

3.1. View Editor 24 

3.2. Available Images Window 26 

3.3. New Project Window 27 

3.4. Spectral Library Window 29 

3.5. Stain Store Management 31 

 

The inForm work area contains the step bar, process editor panel, image display toolbar, and 

image display area. The example below shows the Manual Analysis tab with a brightfield 

image that has been segmented into two tissue categories. (See Figure 3.1.) 

 

FIGURE 3.1. inForm work area with an unmixed composite image from a multiplexed 
fluorescence slide. (A) Step Bar. (B) Manual Analysis Tab. (C) Toolbar. (D) Image Display Area. (E) 

Batch Analysis Tab. (F) Review/Merge Tab. (G) Build Libraries. 
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A. Step Bar 

The Step bar displays an icon for each processing step included in the project that is open in 

the Manual Analysis tab. The Step bar is displayed only when the Manual Analysis tab is 

selected. A new project is automatically created when inForm opens. By default, the new 

project only includes the Prepare Images and Export steps. To create a new project with 

additional steps, see Chapter 5.1. Creating an inForm Projects. To add, remove, or change the 

steps in the open project, see Chapter 5.2. Reconfiguring a Saved inForm Project. 

Click the icons in the step bar at the top of the work area to display the settings for each step 

in the Manual Analysis tab. (See Table 3.1.) For example, click Prepare Images to display the 

Image Preparation Settings panel in the Manual Analysis tab; click Export to display the Export 

Settings panel 

TABLE 3.1. Step Bar icon names and descriptions 

Button Name Description 

 

Configure 
Opens the Configure Project window to change the steps 
in the current project. See Chapter 5. Working with 
Projects and Algorithms for instructions.  

 

Prepare 
Images 

Use to specify the image format and sample format, 
change the image resolution, load a spectral library, 
convert images to optical density, and unmix images. 
Also, export unmixing libraries for use by PhenoImager™ 
HT. See Chapter 8. Preparing Images for instructions. 

 

Manual 
Classification 

Use to create tissue categories and manually draw tissue 
regions on the images in the project. Exported data 
includes position, shape, and component signal statistics 
for each segmented tissue region. See Chapter 9. Manual 
Tissue Segmentation for instructions. This feature is 
available with inForm Basic Analysis or higher. 

 

Segment 
Tissue 

Use to train the automated tissue segmenter and 
automatically segment the images. Exported data 
includes position, shape, and component signal statistics 
for each segmented tissue region. See Chapter 10. 
Trainable Tissue Segmentation for instructions. This 
feature is only available with inForm Tissue Finder. 
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Button Name Description 

 

Threshold 

Use to create and analyze threshold maps. Exported data 
includes position, shape, and component signal statistics 
for each thresholded region. See Chapter 11. Threshold for 
instructions. This feature is available with inForm Basic 
Analysis or higher. 

 

Colocalize 

Use to create and analyze colocalization maps. Exported 
data includes position, shape, and component signal 
statistics for the colocalization region, as well as position, 
shape, and component signal statistics for the underlying 
component regions. See Chapter 12. Colocalization for 
instructions. This feature is available with inForm Basic 
Analysis or higher. 

 

Segment 
Cells 

Use to segment cell nuclei and optionally segment 
cytoplasm and membrane. Exported data includes 
position, shape, and component signal statistics for each 
segmented cell. See Chapter 13. Segmenting Cells for 
instructions. This feature is available with inForm Cell 
Analysis or higher. 

 

Phenotype 
Cells 

Use to create a phenotyping algorithm that can 
automatically phenotype cells after segmentation. See 
Chapter 14. Phenotyping Cells for instructions. This 
feature is available with inForm Cell Analysis or higher. 

 

Score IHC or 
IF 

Use to quantify IHC or IF staining levels in segmented 
cells. The tools provided are intended to automate visual 
assessment (Positivity, 0-3+, 10-bin, 50bin, and Double 
Positivity) and to provide histogram data of staining 
levels. Exported data includes the score for each selected 
cell compartment. See Chapter 15. Scoring IHC or IF for 
instructions. This feature is available with inForm Cell 
Analysis or higher. 

 

Count 
Objects 

Use to segment objects other than cells. Exported data 
includes the position, shape, and component signal 
statistics for each segmented object. See Chapter 16. 
Counting Objects for instructions. This feature is available 
with inForm Cell Analysis or higher. 
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Button Name Description 

 

Export 
Use to select the export directory, the images to export, 
the data to export, and the file name options. See Chapter 
18. Exporting the Data for instructions. 

B. Manual Analysis Tab 

The Manual Analysis tab on the left displays the settings for each step. Use these panels to 

select the settings for the algorithm or project. You can edit these settings only if you are 

viewing a single image, and not while viewing images in Gallery mode. See D. Image Display 

Area. 

C. Toolbar 

The toolbar enables you to adjust the image zoom level, draw processing regions, draw 

training regions, and adjust the view settings. The tools available on the toolbar change based 

on the current processing step. The toolbar displays in the Manual Analysis tab. Toolbar button 

names and descriptions are shown below. (See Table 3.2.) 

TABLE 3.2. Toolbar button names and descriptions  

Button Name Description 

 

Select 
Return the cursor to the default pointer mode. Click and 
drag to pan around the image. Use the mouse wheel to 
zoom in and out at the cursor location. 

 

View Data 
Hover over the image to display the signal intensity of 
each component at any location, as well as any object 
information at that location. 

 

Zoom In 
Click on the image to re-center the image and to zoom in. 
Click-and-drag to zoom in on a specific region of the 
image. 

 

Zoom Out 
Click on the image to re-center the image and to zoom 
out. Double-click on the image with this tool to return 
magnification to 100%. 



USER GUIDE | inForm 

 

AKOYABIO.COM 19  

Button Name Description 

 

Zoom to Full Click to view the image at 100%. 

 

Pan Click-and-drag the image to view the desired region in 
the window. 

 

Draw Processing 
Regions 

Click-and-drag to outline the desired processing region. 
Only the areas of the image within the processing regions 
are analyzed. 

 

Draw Region of 
Disinterest 

Click-and-drag to outline an area to ignore within the 
image. This area will not be processed. 

 

Delete a Region Click inside a processing region, region of disinterest, or 
training region to remove the region. 

 

Draw Training 
Regions 

Click-and-drag to identify regions of the image that 
represent the selected tissue category when training the 
tissue segmenter. This tool selects automatically when 
you select a tissue category from the category list. When 
in draw mode, you can continue drawing training regions. 
Only available during the Segment Tissue step. 

 

Draw Classification 
Regions 

Click-and-drag to identify regions of the image that 
contain the selected tissue category. Only available during 
the Manual Classification step. 

 

Edit the Tissue 
Segmentation 

Click the button to select the tissue category and then 
click-and-drag to manually draw the selected tissue 
category over an area. After segmenting the images, 
inspect the images to make sure the tissue regions are 
segmented as you intended. If areas are under the wrong 
masks (the tumor mask over non-tumor cells, for 
example), use this tool to draw the desired mask over an 
area. Only available during the Segment Tissue step. 
Select Clear Edits to clear all manual edits to the tissue 
masks. 

 

Select Regions to 
Unclassify 

Click-and-drag to outline the area on the image to 
unclassify. Only available during the Manual Classification 
step. 

 

Select Pixels to 
Unclassify 

Click-and-drag over the specific pixels to remove from the 
classification region. Only available during the Manual 
Classification step. 



USER GUIDE | inForm 

 

AKOYABIO.COM 20  

Button Name Description 

 

White Picker 

Click a white area on a Brightfield image to select the 
white background spectra prior to converting the image 
to OD (optical density). Available only during the Prepare 
Images step. 

 

Autofluorescence 
Picker 

Click-and-drag on an area of autofluorescence in the 
image to add autofluorescence to the spectral library. 
Available only during the Prepare Images step when 
creating a spectral library. 

 

Spectral Curves 

Hover over an area to see the spectral curve of that 
particular pixel. Available only during the Prepare Images 
step when the Spectral Library Window is open, and in the 
Build Libraries tab. 

 

Add to 
Thresholded 
Regions 

Click the button to select the desired unmixed 
component and then click-and-drag to outline the area 
on the image to be added to the selected threshold map. 
Only available during the Threshold step. 

 

Erase Thresholded 
Regions 

Click the button to select the desired unmixed 
component and then click-and-drag to outline the region 
to remove from the threshold map. Only available during 
the Threshold step. 

 

Edit Phenotypes Click on a segmented cell to assign a phenotype. Available 
only during the Phenotype Cells step. 

 

Color Button 

Click to select the conventional color view of your image. It 
performs the same function as selecting Color Image 
from the Data Displayed drop-down menu in the View 
Editor. 

 

Component 
Button 

Click to select the which unmixed component to view 
from a dropdown list. If inForm can identify a DAPI or 
hematoxylin counterstain, it will display the component as 
a conventional brightfield IHC stain on a hematoxylin 
counterstain. As a convenience, the up and down arrow 
keys on your keyboard let you switch rapidly amongst 
each component in the display window. 

 

Composite Button 

Click to select the composite image of the unmixed 
fluorescence image in the Image Display Area. See 
Chapter 17. Displaying the Extracted Data for more 
detailed information on viewing your color and unmixed 
component images. 
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Button Name Description 

 

View Editor 

Click to open the View Editor Window to choose the type 
of image or table to view and to change the display 
settings. You can also view or hide cells, masks, and 
regions. Buttons to quickly show or hide image maps are 
available on the left side of the image display area. 

Show/Hide Map Option 

Click to show or hide the image maps. You can show or 
hide segmentation maps, training regions, and 
processing regions. (Most Show/Hide options are also 
available on the View Editor. (See Chapter 3.1. View Editor) 
The buttons include: 

 

Tissue 
Segmentation Map Click to show/hide the Tissue Segmentation Map. 

 

Nuclear 
Segmentation Map Click to show/hide the Nuclear Segmentation Map. 

 

Cytoplasm 
Segmentation Map Click to show/hide the Cytoplasm Segmentation Map. 

 

Membrane 
Segmentation Map Click to show/hide the Membrane Segmentation Map. 

 

Phenotype Map 
Click to display a menu which allows you to show/hide 
individual phenotypes. 

 

Training Regions Click to show/hide the Training Regions. 

 

Processing 
Regions Click to show/hide the Processing Regions. 

 

Spectral Regions Click to show/hide the Autofluorescence Regions. 

 

Legend Click to show/hide the Legend of Components in view. 

 

D. Image Display Area 

The image display area in the Manual Analysis tab has two modes: Single and Gallery as 

illustrated in Table 3.3. 
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TABLE 3.3. Image Display Area modes 

Mode Button 

Single 

 

Gallery 

 

 

Single mode displays one image in the large Image area and displays a row of thumbnails of 

all other open images below the large image. The image name and current display are listed 

below. Click any thumbnail to view the image in the display area. A blue square on a 

thumbnail indicates that the image is included in the training set; a green square indicates 

the image is in the processing set. The Algorithm settings in the left-hand panel can only be 

edited in Single mode. 

Gallery mode displays all the project images in the large Image area. Use the Image Size 

slider at the top of the workspace to adjust the number of open images shown in the image 

display area. In Gallery mode, all Algorithm settings are read only. Gallery mode is for image 

and table review only; you cannot edit the Algorithm settings in this mode. 

Context Menu 

The following actions are accessible by right-clicking an image in the Image Display area: 

• Save: Saves a copy of the image (as shown in the Image Display Area) to a file in the 

selected format (.tif, .jpg, .png, .gif, or .bmp). (Default is the last selected image format.) 

• Delete Region: Deletes the region that you right-clicked on. (Only available if you 

right-clicked on a region.) 

• Delete Regions: Provides options to delete all training regions, all processing regions, 

or both, from an image. (Only available if training regions and/or processing regions 

have been created on the image.) 
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• Show Regions: Provides options to show/hide all training regions, processing regions, 

or both, on an image. 

• Processing Set: Adds or removes the image from the processing set. If checked, the 

image is included in the processing set. If cleared, the image is not included in the 

processing set. Click the option to toggle the check mark. 

• Training Set: Adds or removes the image from the training set. If checked, the image 

is included in the training set. If cleared, the image is not included in the training set. 

Click the option to toggle the check mark. Only displays if training images have been 

drawn on the image. Draw training regions on the image or use the Available Images 

Window to add images without training regions to the training set. (See Chapter 3.2.) 

• View Editor: Opens the View Editor to select the display options. (See Chapter 3.1.) 

• Remove from Project: Removes the image from the project. 

E. Batch Analysis Tab 

After a suitable project or algorithm for processing images has been created, validated, and 

saved, use the Batch Analysis tab to process large numbers of images. Use the Batch Analysis 

Editor to select a project or an algorithm for batch processing, select export directory/folder 

preferences, and select the image/table options. (See Chapter 19. Batch Processing.) Note that 

this feature is only available with inForm Basic Analysis or higher. 

F. Review/Merge Tab 

After completing a batch run, which often generates large numbers of output files, use the 

Review/Merge Editor to combine the data from multiple output files into a single file for 

detailed and quantitative analysis. The Review/Merge Editor has tools to filter out data from 

samples that are inadequately prepared, stained, and/or segmented, so that merged data sets 

are reliable. (See Chapter 20. Merging the Data.) Note that this feature is only available with 

inForm Tissue Finder. 
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G. Build Libraries 

The Build Libraries tab allows you to characterize stains and fluorophores by extracting the 

pure spectral information from them and adding them to the Stain Store. This allows you to 

build up your libraries of spectral data and easily separate multiplexed stains and fluorophores 

in single tissue sections. Stains and fluorophores in the Stain Store may be re-used with new 

images, so long as the images are from specimens that were prepared and imaged in the 

same manner. (See Chapter 21. Building Libraries.) 

3.1. VIEW EDITOR 

Use the View Editor to select the display options for images or data tables after processing. 

The images and data tables available are determined by the steps in the project. The steps 

available are determined by the inForm license. This section lists the views that are available 

for each software configuration. For definitions of the options, see Chapter 17. Displaying the 

Extracted Data. To open the View Editor, click the View Editor button on the image toolbar. 

(See Figure 3.2.) 

3.1.1. Views Available in Viewers 

Color Image: Shows the original color image plus the regions selected in the Image Options. 

Component Image: Shows an image of a single unmixed component. 

Composite Image: Shows a reconstructed image of components selected for viewing. 
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FIGURE 3.2. View Editor. 

3.1.2. Views Available in Cell Analysis 

The views available in cell analysis includes all views in the Viewer plus: 

Tissue Segmentation Data: This table is available when an algorithm contains a manual 

segmentation step. The table provides information on the manually segmented tissue regions. 

(See Chapter 17.5. Viewing the Tissue Segmentation Data Table for detailed information.) 

Quant Data: This table is available when an algorithm contains a threshold or colocalization 

step. The table provides information on the thresholded regions. (See Chapter 17.10. Viewing 

the Quant Data for detailed information.) 

Colocalization Data: These tables are available when an algorithm contains a colocalization 

step. (See Chapter 17.8. Viewing the Colocalization Data for detailed information.) There are 3 

tables: 

Colocalization Table: Shows colocalization data of the selected components and positivity 

data for each selected component. 

In Channel Table: Shows the positivity of one component within another for all selected 

colocalization components. 

Quant Table: Shows stats for the whole image and colocalization region. 
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Cell Segmentation Data: This table is available when an algorithm contains a cell 

segmentation step. The table provides information on the segmented cells. (See Chapter 17.6. 

Viewing the Cell Segmentation Data for detailed information.) If the algorithm contains a 

phenotyping step, this table will contain the cell's phenotype information. 

Object Segmentation Data: This table is available when an algorithm contains an object 

segmentation step. The table provides information on the segmented objects.  

(See Chapter 17.9. Viewing the Count Data for detailed information.) 

Score Data: This table is available when an algorithm contains a score step. The available data 

changes depending on the type of scoring (positivity, 0-3+, 10-bin, 50-bin, and Double 

Positivity). (See Chapter 17.7. Viewing the Score Data for detailed information.) 

3.1.3. Views Available in Tissue Finder 

Includes all views in Cell Analysis. Tissue Segmentation data displays in the Tissue 

Segmentation Table. (See Chapter 17.6. Viewing the Tissue Segmentation Data for detailed 

information.) 

3.2. AVAILABLE IMAGES WINDOW 

Use the Available Images Window to view a list of all images in the project and to add images 

to or remove images from the processing set or the training set. (The training set is only 

supported in inForm Tissue Finder when training the Tissue Segmenter.) Access this via Tools 

> Image List Editor. (See Figure 3.3.) 

To load additional images into the project, click Load Image. The new images must be 

compatible with the Prepare Images settings in the current project. New images must have 

the same spectral wavelength characteristics as the existing images in the project. 

To remove an image, right-click the image name, and then click Remove. 
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FIGURE 3.3. Available Images window. 

3.3. NEW PROJECT WINDOW 

Use the New Project Window to select the steps to include in the project. (See Figure 3.4.) 

Certain steps are only available if a software option has been purchased and installed. For 

available configurations, see Chapter 2.2. Software Configurations. 

 

FIGURE 3.4. New Project window. 
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The New Project window contains the following options and buttons: 

Prepare Images: Required for all projects. Specifies the Image Format and Sample format, 

changes the image resolution, loads a spectral library, unmixes the spectral components, and 

removes haze from the images. See Chapter 8. Preparing Images for details. 

Segment Tissue: Segment the image into specific tissue categories. 

• Manual Tissue Segmentation: Tissue categories are manually drawn on each image. 

See Chapter 9. Manual Tissue Segmentation for details. 

• Trainable Tissue Segmentation: The tissue segmenter is trained to identify different 

tissue types in the images. Processing the images automatically assigns the 

appropriate tissue categories. See Chapter 10. Trainable Tissue Segmentation for 

details. 

Find Features: Find features in the images using thresholds or segmentation algorithms. 

• Adaptive Cell Segmentation: Identifies individual cells or subcellular objects in the 

image using an adaptive thresholding method. This algorithm is best suited for 

fluorescence imagery with membrane staining. See Chapter 13. Segmenting Cells for 

details. 

• Cell Segmentation: Identifies individual cells or subcellular objects in the image using 

either thresholded or algorithmic segmentation. See Chapter 13. Segmenting Cells for 

details. 

• Object Segmentation: Identifies objects on an image using either thresholded or 

algorithmic segmentation. See Chapter 16. Counting Objects for details. 

• Colocalization: Identifies regions on an image where multiple unmixed component 

thresholds overlap. Threshold values for each component are specified individually. See 

Chapter 12. Colocalization for details. 

• Threshold: Identifies regions on an image where a component is above a specific 

threshold. See Chapter 11. Threshold for details. 

Phenotyping: Assign phenotypes to cells. 
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• Phenotyping: Train a phenotyping algorithm by assigning a few cells to each 

phenotype. Processing the images will automatically assign phenotypes to the 

remaining cells. See Phenotyping Cells for details. 

• Rules-Based Phenotyping: Use a predefined algorithm that assigns phenotypes 

based on signals and exclusion rules. Available only when phenotyping the MOTiFTM 

Opal® PD-a/PD-L1 Lung and Melanoma Panel kits. 

Score: Score cells based on intensity thresholds. 

• Scoring: Scores the segmented nuclei, cytoplasm, and/or membrane to count the 

percent positive of a specific component above a specified threshold. See Chapter 5. 

Scoring IHC or IF for details. 

Export: Save the table data and imagery 

• Export: Required for all projects. Specifies the export settings for images and data 

tables after processing is complete. See Chapter 18. Exporting the Data for details. 

3.4. SPECTRAL LIBRARY WINDOW 

Use the Spectral Library window to view graphs of the emission spectral curve for each stain 

selected for unmixing. Viewing the spectral library can help when troubleshooting 

unexpected unmixing results. Ideally, the spectra should be easily distinguishable in each of 

the imaging bands. Typically, one filter is used for each stain. If the Spectral Library uses 

multiple filters, one graph displays for each filter. The figure below shows a spectral library with 

DAPI, CY3, and CY5 with good separation in each graph. The Spectral Library window updates 

dynamically if the Image Preparation Settings are changed. 

To open this window, click View under the Spectral Library pane in the Prepare Images step 

after selecting a spectral library. (See Figure 3.5.) 
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FIGURE 3.5. Spectral Library with multiple filters. 

Chart: The spectral library display can contain multiple graphs; one graph for each imaging 

band. Each graph displays the spectral segments within an imaging band. If there is only one 

data point in each band, all of the spectral segments display in one graph. Brightfield images 

only have one imaging band, so only one graph displays. After loading a library, select the 

check boxes for the spectra you want to use for unmixing in the Prepare Images step. The 

Spectral Library window automatically updates to show only the selected spectra. Hovering 

over the line in a spectral curve displays the name, wavelength (x value), and signal strength (y 

value) of the nearest data point. By default, the chart opens with Unmix Units and Scale to Max 

(equal scales) selected. 

• X Axis: Spectral wavelength of light in nanometers. 

• Y Axis: The units selected in the Units drop-down list. 

Units drop-down list: Specifies the units on the Y Axis on the graphs. Only the units valid for 

the spectral library are available. For example, if a spectral library does not contain Raw units, 

the Raw option is not available. 

• Raw Counts: Pixel intensity in unit counts. Typical Fluorescence values are from 0 to 

4095. Typical Brightfield values range from 0 to 255. 

• Unmix Units: Displays the signal used for unmixing. Can show artifacts that are not 

visible in other views. Usually the best unit for evaluating a spectral library. 



USER GUIDE | inForm 

 

AKOYABIO.COM 31  

• Normalized for Exposure: Signal is displayed in counts/second. Used to compare signal 

strength across bands. (Fluorescence libraries only). 

• OD: Optical Density units (Brightfield libraries only) 

Display drop-down list: Specifies the Y Axis scaling option for the graphs. 

• Scale to Max (equal scales): All graphs are scaled to the same value, which is the 

maximum signal value in all of the bands. 

• Scale to Max (varying scales): Each graph is scaled individually to the maximum signal 

unit for that graph. (This option is not available when there is only one imaging band, 

when the library is for a brightfield image, or when the units are OD.) 

• Normalized: Each graph is scaled individually on the Y Axis to 1. Additionally, the signals 

are scaled so each spectrum has a maximum of 1. (This option is not available when 

units are Unmix Units.) 

Save Chart Button: Opens the Save Chart window to specify the location, name, and file 

format for saving a graphic of the graphs displayed in the Spectral Library window. The chart 

can be saved as a .bmp, .gif, .png, .tif or .jpg and saved to a computer or network location. The 

graphic file includes the legend. 

Legend: Displays the color for each stain in the chart. The colors are selected when the 

Spectral Library is created and cannot be changed in this view. 

3.5. STAIN STORE MANAGEMENT 

inForm has a set of factory-supplied synthetic fluorophores to choose from, as well as the 

capability to store new measured stains and fluorophores from your slides. All stains and 

fluorophores, synthetic or measured, can be grouped together under names of your own 

choosing. 

The Stain Store Manager allows you to: 

• Create and organize Groups of Stains and Fluorophores. 

• Designate which types of Stains and Fluorophores Your Lab Uses. 

• Manage Your Own Measured Spectra. 



USER GUIDE | inForm 

 

AKOYABIO.COM 32  

• Manage Your Synthetic Spectra. 

Go to the top menu bar of inForm and choose: Tools > Stain Store Manager. (See Figure 3.6.) 

 

 
FIGURE 3.6. The home screen for the Stain Store Manager allows you to manage your stains 
and fluorophores from an intuitive interface, selecting only the stains and fluorophores that 

you use and allowing you to group them yourself, eliminating clutter and saving valuable time. 

3.5.1. Managing Groups 

To make finding the right stain or fluorophore easier, you can arrange them into Groups by 

clicking on Manage Groups.  By default, there are Groups named Favorites, Synthetic, and 

Measured present. These default Groups cannot be deleted, but they can be hidden by 

making them inactive. You can create new Groups using the New button, as well as Rename 

and Delete Groups. Only checked Groups appear in the Select Fluors list. (See Figure 3.7.) 
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FIGURE 3.7. Manage Groups lets you arrange your stains and fluorophores into convenient 
Groups. 

3.5.2. Choosing Stains and Fluors 

Click Choose Which Types of Stains and Fluors Your Lab Uses to select from among a list of 

common stains and fluorophores grouped into families. (See Figure 3.8. and Figure 3.9.) For 

example, if you only use CY3 and CY5, you can uncheck CY3.5 and CY5.5 from the list in the 

Cyanine family. Only checked stains and fluorophores will appear in the Select Fluors list. This 

eliminates clutter and can save you time identifying the choosing the right stains and fluors 

for your particular experiment. 

When the “Other (User Specified)” family name is selected, clicking on the New button lets you 

add a new custom stain or fluorophore. Only custom stains and fluorophores can be deleted. 

NOTE: You cannot add new Synthetic Spectra; however, you can add new measured 

spectra using the New button in the Choose Stains and Fluors window. 
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FIGURE 3.8. Stains and fluorophores are arranged by Family or can be seen all at once. 

 

FIGURE 3.9. Adding a new stain or fluorophore can be done from within the Choose Stains 
and Fluors window. 

See Chapter 21. Building Libraries for details on how you can measure and extract the signal 

and then save it to the Stain Store. 

3.5.3. Managing Your Measured Spectra 

Clicking on Manage Your Measured Spectra lets you see a list of all of the stains and 

fluorophores that you have acquired and measured. (See Figure 3.10.) Only checked stains and 

fluorophores appear in the Stains & Fluors list. Highlighting a particular stain or fluorophore 

displays the following characteristics on the right side of the window: 



USER GUIDE | inForm 

 

AKOYABIO.COM 35  

• Name of the stain or fluorophore. 

• Groups you have assigned to the spectrum. 

• Creation Date of the spectrum. 

• Location of the Source file (.im3). 

• Notes that you can include for your own reference. 

 

FIGURE 3.10. Manage Measured Spectra lets you select the spectra that you have measured. 

You can: 

• Assign one or more measured spectra to a group or groups. (See Figure 3.11.) 

You can assign spectra to existing groups, or you can create a new group if 

needed.  Each spectrum can belong to multiple groups. 

 

FIGURE 3.11. Assigning a new group. 

• Delete a measured spectrum. 
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• Locate the original source file from which you took your measurement if it is present 

on your local system. 

• Import spectra from other inForm algorithms, projects, and Stain Store export files. To 

import measured spectra, click Import. Browse to the file containing the appropriate 

spectra. You can import from algorithms, projects, and .SSE files previously exported. 

After opening the file, you can preview and select the spectra for import. Selected 

spectra are added to the Stain Store and are available to your projects. 

• Export spectral data files. 

To export, click Export, and then select one or more measured spectra. You can save an 

.SSE file that contains the spectra to a location of your choice. This can be very useful if 

you have done work on a single inForm workstation to develop ideal spectra for your 

experiment and then want to deploy the same spectra to multiple inForm 

workstations. 

NOTE: You cannot export synthetic spectra. 

3.5.4. Managing Synthetic Spectra 

Click Manage Your Synthetic Spectra to view a list of all the synthetic spectra that are available 

for your imaging system. (See Figure 3.12.) 

 

FIGURE 3.12. Choose which Synthetic Spectra will be displayed to choose for a spectral library 
in the Prepare Images step. 
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Check boxes in the Active column let you select which Synthetic Spectra in the Fluor column 

will be displayed for use in the Prepare Images step. You can click Assign Groups to assign a 

particular Fluor (or a group of Fluors by highlighting more than one) to a new or existing 

Group. (See Figure 3.13.) Each Fluor can be a member of more than one Group. If you would 

like to see the filters available to create the Synthetic Spectra, click Show Filter. 

 

FIGURE 3.13. Assigning a Fluor to a new or existing Group is easy. You can specify the name of 
a Group and assign stains and fluorophores to multiple groups. 
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FIGURE 3.14. The list of filters available to generate Synthetic Spectra. 

NOTE: Typically, to build up a ‘library’ of spectra (precise colors that are really unique 

multispectral profiles of your stains), you capture images from single-stained slides. To 

help get you started, Akoya Biosciences includes some commonly used and 

characterized fluorescence spectra, referred to as ‘synthetic’ stains because they were 

not captured and characterized on your particular Mantra™ or PhenoImager system. 

However, because of the variability of stains and the staining process in brightfield IHC, 

there are no synthetic spectra provided for brightfield microscopy. 
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CHAPTER 4. COMMON IMAGE ANALYSIS TASKS 

Use inForm to create automated image analysis routines to accurately extract data from 

Akoya images (QPTIFF, im3), or conventional RGB images (TIF, BMP, or PNG). (While it is also 

possible to process compressed JPG images, this is not recommended. These can contain 

compression artifacts that could adversely affect segmentation performance.) 

Some common inForm image analysis tasks: 

• inForm uses an AI-powered feature-based recognition algorithm to automatically 

identify and segment tissue types using training regions drawn by the user. 

• inForm performs pixel-based analysis to quantitatively obtain component data. inForm 

can set thresholds (pixel-based) for all component signals and quantitate the 

thresholded component signals. 

• inForm performs colocalization, which locates areas where components are 

simultaneously expressing on a pixel level. 

• inForm identifies cells and finds nuclei, membrane, and cytoplasm, quantitates the 

component signal within those cell compartments and calculates consistent scoring 

judgments based on that quantitation. 

• inForm identifies non-cellular objects and can provide quantitative statistics. 

Features can be combined to perform more advanced analysis, such as computing the double 

positivity of cells within a cancer region or computing the colocalization of a multi-stained 

tissue sample. 

1. Open a new project. (See Chapter 5. Working with Projects and Algorithms.) Follow the 

steps at the top of the window to process the images. 

2. Open the appropriate images. 

3. Optionally, to use processing regions, draw the necessary regions. (See Chapter 7. 

Drawing Processing Regions.) 

4. Prepare the images for unmixing. (See Chapter 8. Preparing Images.) 
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5. If you are segmenting tissue, then see either Chapter 9. Manual Tissue Segmentation 

or Chapter 10. Trainable Tissue Segmentation; otherwise, continue to Step 6. 

6. Refer to the following sections for the remaining project steps: 

a. Threshold 

b. Colocalization 

c. Segmenting Cells 

d. Scoring ICH or IF 

e. Counting Objects 

7. After you have processed the images, see Chapter 17. Displaying the Extracted Data. 
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CHAPTER 5. WORKING WITH PROJECTS AND 
ALGORITHMS 

Section Page 

5.1. Creating an inForm Project 41 

5.2. Saving an inForm Project 46 

5.3. Editing the Step Settings for a Saved inForm Project 47 

5.4. Creating and Saving an Algorithm 48 

 

An inForm project includes the images in the project, the algorithm to process the images, 

and any processing regions, training regions, manual tissue regions, and spectral regions. An 

algorithm includes all the steps used in processing an image: image preparation, image 

analysis, and export. The topics in this section describe how to create and save projects, how to 

reconfigure the project steps and how to edit the settings for project steps, and how to open, 

edit, and save an algorithm. 

5.1. CREATING AN INFORM PROJECT 

Each time inForm starts, a new project is created automatically. A new project contains only 

the Prepare Images step and the Export step. To create a project with additional steps, you 

can Create a New inForm Project or Reconfigure a Saved inForm Project.  

5.1.1. Create a New inForm Project 

The steps that are available when you are creating a new project are determined by the 

software configuration used to create the project. See Chapter 2.2. Software Configurations for 

information on the features available for each software configuration. 

To create a new inForm project: 

1. Select File > New > Project.  

The New Project window opens. Prepare Images and Export are automatically 

included the project. (See Figure 5.1.) 
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NOTE: If an unsaved project is already open, then inForm prompts you to save the 

current project before the New Project window opens. If you choose No, all unsaved 

settings are lost.  

 

FIGURE 5.1. New Project window. 

2. In the New Project text field, enter the name for your new project. 

3. Optionally, to segment tissue, do one or both of the following steps; otherwise, click 

Skip This Step, and then continue to Step 4. 

a. To manually mark tissue categories on the images, select Manual Tissue 

Segmentation. 

b. To train the Tissue Segmenter to automatically identify areas as specific tissue 

categories, select Trainable Tissue Segmentation. 

4. Optionally, to find specific features, do any or all of the following steps; otherwise, click 

Skip This Step, and then continue to Step 5. 

a. To identify cellular features such as the nucleus, cytoplasm, and membrane for 

each cell using an adaptive thresholding algorithm, select Adaptive Cell 

Segmentation. 
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b. To identify cellular features such as the nucleus, cytoplasm, and membrane for 

each cell, select Cell Segmentation. 

c. To identify objects of interest, select Object Segmentation. 

d. To identify areas on the images where selected components are colocated, select 

Colocalization. 

e. To identify the areas on the images where the strength of a component at each 

pixel exceeds a specific threshold, select Threshold. 

5. If Cell Segmentation was selected, then do one or both of the following steps; 

otherwise, continue to Step 6. 

a. To assign phenotypes to each cell, select Phenotyping. 

b. To calculate score statistics for the cells, select Scoring. 

6. Click Create. 

The new project is created with the selected steps. 

7. To add the necessary images to the project, see Opening Images. 

8. After you have configured the necessary steps and added the images, see Chapter 5.2 

Saving an inForm Project. 

NOTE: If you must make adjustments to the step settings after you have saved the 

project, see Chapter 5.3. Editing the Step Settings for a Saved inForm Project. 

5.1.2. Reconfigure a Saved inForm Project 

You can add or remove steps from a saved inForm project. inForm retains as many settings as 

possible, depending on which steps you add or remove from the project. For example, if you 

created a project without tissue segmentation and then later decide to include manual tissue 

segmentation, you can modify the project to add Manual Tissue Segmentation.  
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When you reconfigure a saved inForm project, any settings that are not affected by the 

changes are retained, but you might need to adjust other settings that are affected by the 

changes. You typically make these changes at the time that you are reconfiguring the project, 

but if necessary, you can make these changes after you save the project.  

To reconfigure a saved inForm project: 

1. If the saved project is already loaded, then continue to Step 3; otherwise, Select File > 

Open > Project. 

The Open Project dialog box opens. 

2. Navigate to the project that you are editing, and then click Open.  

The project is loaded and the project images are displayed in Galley mode. (See Figure 

5.2.) The View Editor and the Available Images window close if either one was open in 

the previous project. 

 

FIGURE 5.2. Galley mode for an inForm project. 

3. Select Tools > Configure Project, or click Configure. 

The Configure Project window opens. The window displays the same options as the 

New Project window. (See Figure 5.3.) The loaded project determines the options that 

are selected when the window opens. 
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FIGURE 5.3. Configure Project window. 

4. Add or remove project steps as appropriate. 

NOTE: Changing some steps might require you to reprocess the images for later 

steps in the project.  

5. Click Configure. 

inForm reconfigures the open project. 

6. Confirm that the new settings are as expected for each step in the project or adjust 

them as necessary. 

7. Save the project. See Chapter 5.2. Saving an inForm Project. 

NOTE: If you must make adjustments to the step settings after you have 

reconfigured and saved the project, see Chapter 5.3. Editing the Step Settings for a 

Saved inForm Project. 
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5.2. SAVING AN INFORM PROJECT 

A saved inForm project is comprised of the following items: the images, any created 

composite views, the algorithm for the processing of the images, and any processing regions, 

training regions, or manual tissue regions. 

NOTE: The following procedure describes how to save a complete inForm project, 

including the analyzed images. To save only the algorithm that was used for processing 

the images, and not the images themselves, see Chapter 5.4. Creating and Saving an 

Algorithm. 

To save an inForm project: 

1. Select File > Save > Project. 

The Save Project dialog box opens. (See Figure 5.4.) 

 

FIGURE 5.4. Save Project dialog box. 

The Save as type is set to Project Files (*.ifr) and you cannot change this. If you are 

saving a new project, then the File name is set to the default value of New Project. ifr; 

otherwise, if you are saving a reconfigured project, then the File name is set to the 

name of the project. 

2. Select the location within the Data File structure to save the project. (See Figure 5.5.) In 

the File name field: 
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a. If you are saving a new project, enter the project name. 

b. If you are saving a reconfigured project, leave the name as-is, or enter a different 

name. 

3. Click Save. 

The Save Project dialog box closes. The inForm project file is saved in the specified 

location. A folder named <Project Name>Training Images is created in the folder in 

which the project file was saved. Local copies of all the project images are saved in this 

Training Images folder for all projects other than Digital Slide projects.  

NOTE: Local copies of project images are not stored for Digital Slide projects. If you 

change the location of the data for a Digital Slide project, then inForm prompts you to 

find the slide data. When transferring data, please make sure that the study folder and 

its contents are moved as a unit. 

 

FIGURE 5.5. Data file structure. 

5.3. EDITING THE STEP SETTINGS FOR A SAVED INFORM PROJECT 

After you create and save a new inForm project, or reconfigure and save an existing inForm 

project, you might later need to edit the settings for one or more of the project steps. When 

you open a saved inForm project for editing the settings, the project opens in Galley mode 

and is locked, which prevents you from making any unintentional changes to the project. To 

edit the step settings, you must unlock the project by placing it in Single mode.  



USER GUIDE | inForm 

 

AKOYABIO.COM 48  

To edit the step settings for a saved inForm project: 

1. Select File > Open > Project. 

The Open Project dialog box opens. 

2. Navigate to the project that you are editing, and then click Open.  

The project is loaded and the project images are displayed in Galley mode as shown in 

Figure 5.3 above. The View Editor and the Available Images window close if either one 

was open in the previous project. 

3. Click Single. 

5.4. CREATING AND SAVING AN ALGORITHM 

An algorithm includes all the steps used in processing an image: image preparation, image 

analysis, and export, but not the images themselves. (Remember, to save the images and all 

the image processing steps, you must save a project. See Saving an inForm Project.). An 

algorithm provides you the means of reusing project settings to process compatible images or 

sets of images without re-selecting the settings for each new project. You can load an 

algorithm into inForm and then open images for processing, or you can load the images first, 

and then apply the algorithm. You can use an algorithm to process one image at a time, or 

you can use an algorithm in Chapter 19. Batch Processing to automatically process multiple 

images at the same time using the same analysis settings.  

NOTE: If a project is opened for use in Batch Processing, then the algorithm for the 

project is used to process all the project images. 

To create an algorithm without images opened first: 

1. Select File > Open > Algorithm.  

The Open Algorithm dialog box opens. 

2. Navigate to the appropriate algorithm, and then click Open. 

The Open Algorithm dialog box closes. 

3. Open the appropriate images. 
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4. To prepare the images, click Prepare Image or Prepare All. 

5. To review or change the settings in each algorithm step, click Advance to advance 

through each step, or click each Step button that is displayed at the top of the inForm 

window. 

6. After you satisfied the algorithm development is complete, save the algorithm. See 

Chapter 5.4.1. To Save an Algorithm. 

To create an algorithm with images opened first: 

1. Select File > Open > Algorithm.  

A Data Will be Lost dialog box opens, warning you that loading an algorithm will result 

in all images being reset to their initial state. 

2. Click Yes to close the dialog box and discard all training regions, tissue regions, cell 

regions, object regions, thresholds, and component images.  

The Open Algorithm dialog box opens. 

3. Navigate to the appropriate algorithm, and then click Open. 

The Open Algorithm dialog box closes. 

4. To prepare the images, click Prepare Image or Prepare All. 

5. To review or change the settings in each algorithm step, click Advance to advance 

through each step, or click each Step button that is displayed at the top of the inForm 

window. 

6. After you satisfied the algorithm development is complete, save the algorithm. See 

Chapter 5.4.1. To Save an Algorithm. 

5.4.1. To Save the Algorithm 

You can save an algorithm either in an unprotected format, which means that the algorithm is 

editable, or you can save the algorithm in a locked format, which means that the algorithm is 

not editable. 
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1. Do one of the following: 

a. To save the algorithm in an unprotected format, click File > Save > Algorithm. 

The Save Algorithm dialog box opens. 

b. To save the algorithm in a locked format, click File > Save > Locked Algorithm. 

The Save Locked Algorithm dialog box opens. 

2. Navigate to the location for saving the algorithm. 

3. Enter the name for the algorithm, and then click Save. 

The dialog box closes. inForm remains open. 
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CHAPTER 6. OPENING IMAGES 

Section Page 

6.1. Adding Images to an inForm Project 51 

6.2. Adding or Removing Images from a Project Processing Set or Training 
Set 55 

6.3. Viewing Images and their Information in a Project 57 

6.4. Removing Images from a Project 59 

 

This chapter describes how to add images to an inForm project and the viewing options that 

are available for the images after you have added them to the project. It also details how to 

add and remove images from a project and add and remove images from the Processing set 

and the Training set. The number of images that you can open and view in an inForm project 

depends not only on the sizes of the images (width and height in pixels), but also on your 

operating system. 

6.1. ADDING IMAGES TO AN INFORM PROJECT 

When you add images to a project, you can include the images in the Processing set (the 

images that the algorithm processes), in the Training set if you are training a Tissue 

Segmenter, or both. You can add the images to a project using the Open command that is 

available from the File menu, or you can add images using the Available Images window that 

is available from the Tools menu.  

6.1.1. Add Images to inForm Project from File Menu 

1. Ensure that the appropriate project is open in inForm (File > Open > Project), or you 

can open inForm, which results in the automatic creation of a new project.  

2. Select File > Open > Image. 

The Select Image dialog box opens. (See Figure 6.1.) By default, the types of image files 

that you can select is set to All Image Files.  
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FIGURE 6.1. Select Image dialog box. 

3. Leave the image file type set to its default value of all image files, or optionally, select a 

different file type. (See Figure 6.2.) 

Available types are: 

a. Multi-Spectral Files (*.im3). 

b. Akoya Digital Slide (*.qptiff). 

c. Images Files (which are common image file types such as *.TIF, *.TIFF, *.BMP, *.JPG, 

*.JPEG, and *.PNG for RGB or monochrome images). 

d. Akoya Tiff Extract files (*.qpexport). 

 

FIGURE 6.2. Available image types. 

4. Navigate to the location of the image files that you are adding to the project, and then 

select one or more image files. Note the following caveats when you are selecting 

image files to add to a project: 

a. The images that you select must all be the same file type (.qptiff, .im3, RGB, or 

monochrome). 
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b. If the images are Akoya Digital Slide images, then inForm loads all stamp 

annotations that are designated for inForm projects. 

5. Click Open. 

The Select Image dialog box closes.  

a. If none of the selected images exceed 16 megapixels (32-bit systems) or 

110 megapixels (64-bit systems), then all the selected images are added to the 

project. By default, the images are also automatically included in the Processing 

set. 

b. If one or more images exceed 16 megapixels (32-bit systems) or 110 megapixels (64-

bit systems), then the Change Resolution dialog box opens. (See Chapter 6.1.2.1. 

Adjust Image Resolution.) 

6.1.2. Add Images to inForm Project using Available Images Window 

The Available Images window displays a list of all the images that have been added to the 

currently opened project. The window also indicates for each image whether the image is part 

of the Processing set, the Training set, or both. The window also displays a Load Image option, 

which you can use to load additional images into the currently opened project. If you use the 

Load Image option to load additional images into a project, note the following caveats: 

• The newly loaded images must be compatible with the Prepare Images settings in the 

current project. 

• The newly loaded images must be the same file type (.qptiff, .im3, RGB, or 

monochrome) as the images that are already included in the project. 

1. Ensure that the appropriate project is open in inForm (File > Open > Project), or you 

can open inForm, which results in the automatic creation of a new project.  

2. Select Tools > Image List Editor. 

The Available Images window opens. (See Figure 6.3.) 
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FIGURE 6.3. Available Images window. 

3. Click Load Image. 

The Select Image dialog box opens. The types of image files that you can select for 

inclusion in the open project is set to that of the images that are already included in 

the project, for example, Multi-Spectral Files (*.im3).  

4. Navigate to the location of the image files that you are adding to the project, and then 

select one or more image files. 

5. Click Open. 

The Select Image dialog box closes.  

a. If none of the selected images exceed 16 megapixels (32-bit systems) or 

110 megapixels (64-bit systems), then all the selected images are added to the 

project. By default, the images are also automatically included in the Processing 

set. 

b. If one or more images exceed 16 megapixels (32-bit systems) or 110 megapixels (64-

bit systems), then the Change Resolution dialog box opens. Continue to Adjust 

Image Resolution. 
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6.1.2.1. Adjust Image Resolution 

When you are adding images to a project, if one or more images exceed 16 megapixels (32-bit 

systems) or 110 megapixels (64-bit systems), then the Change Resolution dialog box opens 

with the message that an image is too large to load and prompts you to select an image 

resolution factor to lower the resolution for the image. The dialog box also displays the 

number of images of a similar size that can be opened and added to the project at the same 

time. (See Figure 6.4.) 

 

FIGURE 6.4. Change Resolution dialog box. 

Select the appropriate image resolution factor, and then click OK.  

The Change Resolution dialog box closes. All the images are added to the project. By default, 

the images are also automatically included in the Processing set. 

6.2. ADDING OR REMOVING IMAGES FROM PROJECT PROCESSING SET OR 
TRAINING SET 

By default, when you add an image to a project, it is automatically added to the Processing 

set. If you are training the Tissue Segmenter as part of an inForm project, then you can also 

add an image to the Training set. You always have the option of removing a project image 

from the Processing set, and if applicable, the Training set as well. 

1. Ensure that the appropriate project is open in inForm (File > Open > Project), or you 

can open inForm, which results in the automatic creation of a new project.  
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2. Select Tools > Image List Editor. 

The Available Images window opens. (See Figure 6.5.) 

 

FIGURE 6.5. Available Images window. 

3. Select Tools > Image List Editor. 

The Available Images window opens. The window displays a list of all the images that 

have been added to the currently opened project. The window also indicates for each 

image whether the image is part of the Processing set, the Training set, or both.  

4. Do any of the following: 

a. To remove an image from the project Processing set, clear the Process Set check 

box for the image. 

b. To add an image to the project Processing set, select the Process Set check box for 

the image. 

c. To add an image to the project Training set, select the Training check box for the 

image. 
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d. To remove an image from the project Training set, clear the Training check box for 

the image. 

5. Close the Available Images window. 

6.3. VIEWING IMAGES AND THEIR INFORMATION IN A PROJECT 

After you add images to a project, you have multiple options for viewing the images 

themselves as well as information about the images. You view images in a project in the 

Images Display area of the inForm window. You can view images in Gallery mode and you can 

view images in Single mode, and you can also view an image as a Cube image. 

6.3.1. Gallery mode 

By default, when you first open a project, all the images in the project are displayed in Gallery 

mode, which is a display of all the images in the project in the Image Display area. The full 

name for each image is displayed directly beneath the image. The Gallery mode is useful for 

comparing all the images in a project at the same time and for quickly locating a specific 

image. You can always place the image in a project in Gallery mode by clicking the Gallery 

icon that is displayed below and just to the left of the Image Display area. (See Figure 6.6.) 

 

FIGURE 6.6. Image Display in Gallery mode. 
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The following options are available in Gallery mode: 

• To scroll the view of all the images that are displayed, use the vertical scroll bar that is 

displayed at the far right of the Image Display area. 

• To increase or decrease the size of all the images that are displayed at the same time, 

use the Image Size slider that is displayed at the top of the Image Display area. Move 

the slider to the left to decrease the image size and increase the number of images 

that you can view at the same time in the Image Display area without having to use 

the vertical scroll bar. Move the slider to the right to increase the image size and reduce 

the number of images that you can view at the same time in the Image Display area. 

You must then use the vertical scroll bar to view all the images. 

NOTE: When you display the project images in Gallery mode, you cannot edit the Step 

settings for the project. 

6.3.2. Single Mode 

As the name implies, you use Single mode to display one project image at a time in the Image 

Display area. To place the project images in Single mode, click the Single mode icon that is 

displayed below and just to the left of the Image Display area. You use Single mode to zoom in 

on an individual project image, draw regions on an individual project image, or edit the project 

algorithm settings. (See Figure 6.7.) 

 

FIGURE 6.7. Image Display in Single mode. 
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When the project images are displayed in Single mode, thumbnails of all the images are 

displayed directly beneath the Image Display area. The following options are available in 

Single mode: 

• To scroll through the display of all the project images one at a time, use the Forward 

and Back navigation arrows that are displayed for the thumbnails.  

• To view a specific image in the Image Display area, click the thumbnail for the image. 

• To view the name of an image, as well as other information (Processing Set or Training 

Set), hold your mouse pointer over the thumbnail for the image. 

6.3.3. Image Information Dialog Box 

You can view the information for an image whether in Gallery mode or Single mode.  

• In Gallery mode, select the image, and then on the Tools menu, click Show Image Info. 

• In Single mode, click the image thumbnail, and then on the Tools menu, click Show 

Image Info. 

The Image Info dialog box opens and displays detailed information about the image such as 

the full image name, the image size, the image resolution, exposure times, instrument 

response data, and so on. The specific information that is displayed depends on how the 

image was acquired. 

6.4. REMOVING IMAGES FROM A PROJECT 

You have three options for removing images from an inForm project. 

• In Single mode: 

o Click the thumbnail of the image that you are removing to display the image in 

the Image Display area. 

o Right-click the image in the Image Display area, and then on the Image context 

menu that opens, click Remove from Project. 

• In Galley mode: 
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o Right-click the image that you are removing, and then on the context menu 

that opens, click Remove from Project. 

• In the Available Images window: 

o Right-click the image that you are removing, and then on the context menu 

that opens, click Remove from Project. 
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CHAPTER 7. DRAWING PROCESSING REGIONS 

A processing region encloses an area of an image that is processed using the steps in the 

project or algorithm. You manually draw one or processing regions on an image with the 

project in Single mode. inForm ignores any areas that fall outside the processing regions on 

an image and does not include these outside regions in any calculations or statistics. You 

cannot use processing regions in Batch Processing (See Chapter 19. Batch Processing.). 

To draw processing regions on a project image: 

1. Ensure that the opened project is in Single mode. 

2. Click the image thumbnail. 

3. Optionally, use the Zoom in icon and/or the Pan icon to bring the preferred image 

image region into clearer focus. 

4. Click the Draw Processing Region icon, and then click and drag your mouse pointer 

around (encircle) the appropriate image area, making sure to release the mouse 

button to connect the starting point and ending point of the process region. (See 

Figure 7.1.) 

An ID number is automatically assigned to the processing region, and is displayed in 

the middle of the region, with “1” being assigned to the first processing region drawn 

on the image, and incremented sequentially thereafter for each subsequent 

processing region drawn on the image. 

5. Repeat Step 2 through Step 4 for each image in the project. 

NOTE: If you draw processing regions on one or more images in a project, and then save 

the project, the processing regions remain intact. (The images are saved with the 

processing regions.) 
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FIGURE 7.1. Image with processing regions drawn on it. 

To delete processing regions from a project image: 

1. Ensure that the project is opened in Single mode. 

2. Click the image thumbnail. 

3. To delete one or more processing regions from the image, you have two options: 

a. Use the Delete Regions button. 

i. Click the Delete Regions button. 

The mouse pointer changes to a set of cross-hairs. 

ii. Click on each processing region that you are deleting from the image. 

b. Right-click each processing region that you are deleting, and then on the Region 

context menu that opens, click Delete Processing Region.  

As you delete one or more processing regions from an image, any remaining processing 

regions that have a higher ID number than the deleted regions are automatically 

renumbered. 
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CHAPTER 8. PREPARING IMAGES 
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8.6. Completing the Prepare Images Step 78 

 

The first processing step in an algorithm is the Prepare Images step. This section describes 

how to prepare the images for segmentation or analysis by selecting the image format, 

choosing a spectral library, selecting the component units, and then completing additional 

image preparation steps. 

8.1. SELECTING THE IMAGE FORMAT 

The Image Preparation Settings panel displays the Image Format, Sample Format, and 

Change Resolution options. (See Figure 8.1.) 

 

FIGURE 8.1. Image Preparation Settings panel. 

8.1.1. Image Format 

Before you can begin an analysis, inForm must know the type of images in the project. 

Available image types are Digital Slide (.qptiff), Digital Slide Extract (.qpexport), Multispectral 

Field (.im3), RGB, or Monochrome. 
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If you open a new project and then immediately add new images to the project, inForm 

automatically selects the correct image format. If you open TIFF, BMP, JPG, or PNG images, 

inForm recognizes the images as either RGB images or Monochrome images. 

Additionally, all images that you add to the project must be acquired at the same resolution. If 

you use HT, imagery that is acquired at a resolution of 0.5um/pixel (20x) is fundamentally 

different than the imagery that is acquired at 0.5um/pixel (20x binned from 40x) and you 

cannot process these images within the same project. 

8.1.2. Sample Format 

All images in the project must be the same sample format. For any RGB images, you must 

select the correct Sample Format (Brightfield or Fluorescence). Monochrome images do not 

use a sample format. For all other image formats, inForm automatically detects the sample 

format. Images taken with PhenoImager HT and Mantra can vary in their filter order. 

If preferred, you can select the image format and the sample format before adding images. In 

this case, only those images that match the selected image format and sample format can be 

opened. 

HT can create digital slides in three different formats: a Standard 8-bit format, an Extended 

Range format, and an Unmixed format. All images within a project must be the same format. 

8.1.3. Change Resolution 

Select Change Resolution to change the resolution of all images in the project. You can lower 

the image resolution to increase the speed of training and tissue segmentation. If the set of 

images is so large that all of the images cannot be held in memory, then prior to unmixing, 

lower the image resolution. 

8.2. CHOOSING A SPECTRAL LIBRARY 

inForm uses a process called spectral unmixing to decompose the image into its various 

components. For a simple example, a color image can be unmixed into its red, green, and blue 

components. An image can also be unmixed into its stain components such as Hematoxylin 

and DAB for brightfield images, which describe the contribution of each stain to the overall 
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signal. The contributions of each stain are based on a spectral library that shows the 

characteristic color distribution of light that is associated with the stain. For example, a 

fluorescence sample could consist of stain components such as DAPI and FITC. The spectral 

library can additionally include the color distribution that is associated with tissue 

autofluorescence. 

• For Multispectral Fluorescent Digital Slides in Unmixed format, the data is already 

unmixed, and there is no need (or option) to select spectral libraries in inForm. 

• For Multispectral Fluorescent Digital Slides in Standard or Extended format, the 

spectral library can be synthetic, or it can be extracted from singly stained samples. 

• For other Fluorescent Digital Slides, a spectral library is not used. 

• For Brightfield Digital Slides, a spectral library can be extracted from singly stained 

samples. 

• For Multispectral Field .im3 images acquired with HT or Mantra, inForm can extract the 

spectrum from singly stained samples.  In addition, a synthetic spectral library can be 

used for fluorescence imagery. 

• For RGB images, you can use the default RGB spectral library that is included with 

inForm. 

• For Monochrome Images, spectral libraries are not used. 

• For Brightfield PKI TIFF Extracts, the default RGB spectral library that is included with 

inForm can be used if preferred.  Spectral libraries are not used for fluorescent PKI TIFF 

Extracts. 

8.2.1. Selecting an InForm Library 

If you have previously created spectra by Building Libraries (see Chapter 21. Building Libraries), 

you can select those spectra for use with your images. You must have an image loaded to 

select inForm libraries. 

1. Select inForm as the Spectral Library Source. (See Figure 8.2.) 
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FIGURE 8.2. Selecting inForm as the Spectral Library Source to choose spectra that were 

created in inForm. 

2. Choose the spectra that represent the stains or fluorophores in your sample.  

(See Figure 8.3.) 

 

FIGURE 8.3. Available stains can be selected for preparing images. 

Note the following: 

• While choosing your stains or fluorophores, you can narrow your choices by selecting 

one or more Groups. Selecting All shows all the spectra that are compatible with your 

imagery. 

• If you must re-select your stains or your fluorophores, click Select Stains/Fluors. 

• If this is a fluorescence sample, you have the option to select autofluorescence by 

drawing on an unstained portion of tissue with the Autofluorescence Picker.  
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• You can sort your spectra by name, creation date, and selection by clicking the column 

headers. 

• You can preview the spectral shape for the highlighted stain or fluor, as well as your 

selected spectra, in the spectral chart. The details of the highlighted stain or fluor, 

including the acquisition date, groups, and notes, are shown below the listing.  Clicking 

on a stain or fluor in the legend highlights the stain and show its details. 

• Clicking Locate Original Image opens the folder that contains the source image for the 

stain or fluorophore, if available. 

8.2.2. Selecting a Synthetic Spectral Library 

If you have a fluorescence image that was acquired with HT or Mantra, you can use synthetic 

libraries within inForm. Akoya Biosciences includes some commonly used and characterized 

fluorescence spectra, referred to as “synthetic” stains because they were not captured and 

characterized on your particular system. 

1. Select inForm as the Spectral Library Source.   

2. Select the Synthetic Group to limit your spectra to synthetic only. (See Figure 8.4.) 

 

FIGURE 8.4. Selecting the Synthetic Group displays only synthetic fluors. 
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3. Choose the spectra that represent the fluorophores in your sample, and then click OK. 

NOTE: If this is a fluorescence sample, you have the option to select autofluorescence by 

drawing on an unstained portion of tissue with the Autofluorescence Picker. 

  

Note the following: 

• To view the selected Spectral Library, click View, and then see Viewing a Spectral 

Library. 

• For fluorescent images, see Remove Haze for details about removing the background 

haze before unmixing.  

If this is a fluorescence sample, you have the option to select autofluorescence by 

drawing on an unstained portion of tissue with the Autofluorescence Picker.  

 

• In the Spectra for Unmixing pane, select the components that you are unmixing. (See 

Chapter 8.2.3. Choosing Spectra for Unmixing.) 

8.2.2.1. Editing Markers 

You can add the names of your markers to the spectra that are listed in the Spectra for 

Unmixing pane in the Manual Analysis tab. (See Figure 8.5.) 

 

FIGURE 8.5. Spectra for Unmixing pane. 

https://akoyabio.sharepoint.com/wiki/spaces/MAR/pages/2698018840/Chapter+8%3A+Preparing+Images
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1. Click Edit Markers and Colors… 

The Edit Markers and Colors dialog box opens. You use the available options to enter 

the marker names and change the colors that are associated with your spectra. (See 

Figure 8.6.) 

 

FIGURE 8.6. Edit Markers and Colors dialog box. 

2. Enter your maker names, and optionally, select the default colors that are to be used 

for spectral unmixing.  

For example, if you know that CD4 is your marker for FITC, then in the text field that is 

displayed to the right of FITC, enter CD4. The fluorophore name is placed in 

parentheses next to the marker name in Spectra for Unmixing list. 

8.2.2.2. Converting to Optical Density 

If your goal is to segment cells and measure stain "intensity" (optical density), then you must 

convert brightfield multispectral and RGB images of IHC-stained samples to optical density. 

Brightfield multispectral images that are acquired with Mantra or HT are already converted to 

optical density and therefore conversion is not required as part of Prepare Images. Brightfield 

multispectral images that were acquired with earlier programs were not converted to optical 

density, and therefore require conversion as part of Prepare Images. 

Selecting a Reference White for Optical Density Conversion 

1. Select Convert to Optical Density. (See Figure 8.7.) 
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2. If the white areas on the image are small, then zoom in on a white area. 

3. Click the White Picker button. 

Your mouse cursor changes to a white box. 

4. Move the cursor over a white region on an image, and then click. 

”White Selected” is displayed under Convert to Optical Density. 

 

FIGURE 8.7. Selecting a Reference White for Optical Density. 

NOTE: If the image appears very light after you have selected the White Reference, then 

you might have clicked an area that was not completely white. You should clear 

Convert to Optical Density to reset the image to its original state, and then repeat this 

procedure.  

8.2.3. Choosing Spectra for Unmixing 

The Spectra for Unmixing list is populated from the selected spectra or library. Check the 

stains that you are using to unmix. If you have more than one spectral example from the same 

stain (for example, multiple DAB spectra) in your list, then you can use only one for unmixing. 

For Brightfield RGB images, if you do not load a library, then the spectra for unmixing are set 

to the default values of Blue, Green, and Red. 

NOTE: If you select Scale Views Based on Selected Images in the View Editor (see 

Chapter 3.1. View Editor) and then you make changes to the selected Spectra for 

Unmixing, the image scaling is reset to the default value of Scale Views Equally for All 

Images in the Project. 

8.2.3.1. Removing the Haze Spectrum 

In fluorescence images, image contrast and unmixing accuracy can sometimes be improved if 

the general haze, or background, in the image, which has a characteristic spectra, is 

subtracted from the images first. When creating the spectral library for the images, create the 
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background or “haze” spectrum, then add this spectrum to the spectral library. When the 

spectral library is loaded, you can select the haze spectrum and remove it from the images. 

To remove the haze spectrum:  

1. Select Remove Haze. 

The Haze spectrum is created. 

2. On the Haze Spectrum drop-down list, select Haze. (See Figure 8.8.) 

Haze is removed numerically (without scaling or other changes in value), wavelength-

by-wavelength, from every pixel of the image, which alters the spectral shape of the 

remaining signals and their overall intensities. The magnitude of these changes 

depends on the intensity of the spectral signal that is being subtracted. Typically, when 

background spectra are small compared to the signals, you can still use the spectral 

library entries that are derived from unsubtracted data sets, but you should validate 

the use of these entries if you require quantitative results. 

3. Click the Prepare Images button. 

Your settings are applied and the composite view is displayed. 

 

 

FIGURE 8.8. Removing the Haze spectrum. 

8.3. VIEWING AND SAVING A SPECTRAL LIBRARY 

The Spectral Library window displays graphs of the spectral segments in each imaging band 

in a spectral library. Only one graph displays for brightfield images or for fluorescent images 

with only one data point in each imaging band. 

To view the spectral library: 
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1. Open the spectral library. 

2. In the Spectra for Unmixing drop-down list, select the spectra that you are using to 

unmix the images. 

3. Click View. 

The Spectral Library window opens. 

4. Select the units in which to display the graphs. See the Spectral Library window for a 

complete description of the graph display. 

NOTE: If the selected units are not compatible with the selected spectra, then the 

message “ “ is displayed instead of the spectral graphs. 

5. Select the Display options for the Spectral Library chart. 

6. To save an image of the chart with the currently selected Display option, click Save. 

7. Enter the name for the image file, select an image format, and then click Save. 

8. To close the Spectral Library window, click the Close  button in the upper right 

corner of the window. 

8.4. EXPORTING AN UNMIXING LIBRARY 

One important workflow involves exporting an unmixing library from inForm for use by HT so 

it can acquire whole-slide scans in unmixed format. This is only supported for Multispectral 

Fluorescent Digital Whole Slide datasets. 

To do this, load a representative whole-slide scan in Standard or Extended format. It should 

have the same bands as the scans you would like HT to acquire in Unmixed format. The 

exposure times need not be the same, as these are set separately in the HT software. Marker 

names can be provided now, but they can be overridden in HT so the same library can be used 

for samples targeting a variety of markers. What is vital is that the dye channels and bands be 

the same, and the autofluorescence be representative of the samples you wish to scan in HT. 
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Choose the spectra, which can either be synthetic or measured; and select an 

autofluorescence signal. Then, go to the menu item Export | Unmixing Spectra, and you will be 

prompted to save an unmixing library based on your currently selected spectra and marker 

names (if provided).  

8.5. COMPONENT UNITS 

The components that are produced by unmixing are calculated using the settings that you 

select in the Select Reported Units and Weighting drop-down lists. The Reported Units can be: 

Raw counts, counts Normalized for Exposure, or OD (optical density) units. The Weighting can 

be Total, Mean, or Peak. (See Figure 8.9.) 

 

FIGURE 8.9. Reported Units and Weighting options. 

8.5.1. Brightfield images versus Fluorescence images 

Because of their inherent differences, brightfield images and fluorescence images use 

different measures schemes. 

• For brightfield images, darker pixels indicate a higher expression of the biomarker. 

• For fluorescence images, brighter pixels indicate a higher expression of a biomarker or 

a reporter protein. 

Consequently, you use optical density for brightfield images and fluorescence counts, either 

raw or normalized, for fluorescent images. 

8.5.2. Select Reported Units 

Monochrome (black and white) images and RGB color images produce signals in counts. For 

multi-spectral images that are not converted to Optical Density, component signal counts are 

either Raw or Normalized for Exposure. 
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• Raw reports the measured signal that is associated with a given component, such as 

DAPI or FITC. 

• Normalized for Exposure reports the number of counts that are in the image, after 

accounting for all the following camera settings that are in use: Gain, Bit Depth, Well 

Depth, and Exposure Time. When Normalized for Exposure is the selected Reported 

Units, you can compare images that were taken using different camera settings or 

exposures, with the assurance that the signal levels indicate the actual brightness at 

the sample, regardless of the instrument settings. 

• Counts that are Normalized for Exposure are calculated according to the following 

formula: 

(Counts x Relative Well Depth)/(2Bit Depth x Exposure Time x Gain x Binning Area) 

where: 

o Relative Well Depth is the well depth for the camera sensor relative to nominal 

Akoya sensor at the chosen gain setting. 

o Bit Depth is the bit depth of the imagery, which is typically 8-bit (256 levels of 

gray) or 12-bit exposure time in seconds. 

o Gain the gain setting of the camera. 

o Binning Area is 1 for 1 x 1, 4 for 2 x 2, etc. 

NOTE: If you are using Mean weighting, then generally, the values are small, and it 

might be difficult to develop an intuition about what is normal. Select Total weighting 

to produce larger values. 

For brightfield images that are converted to Optical Density, inForm produces unmixed 

component signals in OD (Optical Density) units, where Optical Density indicates the amount 

of absorbing material that is present at a given location and is calculated according to the 

following equation: 

Optical Density = -log10 (pixel value / white reference pixel value). 



USER GUIDE | inForm 

 

AKOYABIO.COM 75  

NOTE: If you select Scale Views Based on Selected Images in the View Editor and then 

you make changes to the Reported Units, the image scaling is reset to the default value 

of Scale Views Equally for All Images in the Project. 

8.5.3. Weighting 

Weighting specifies whether to use the Mean, Peak, or Total signal to calculate the displayed 

units. 

• Total: Total weighting is the sum of all signals of the selected component across all 

wavelengths. Total weighting is available for all images except images that are 

converted to Optical Density. Total weighting is the default value for fluorescence 

images. 

• Mean: Mean weighting is the average of all signals of the selected component across 

all wavelengths. Mean weighting is available for all units except monochrome image 

counts. Total weighting is the equivalent of the settings in versions of inForm prior to 

V2.0.2.  

o For RGB color images, inForm reports the average signal across the three color 

planes (red, green, and blue). A pure blue pixel with 240 counts would have a 

component strength of 80 (= 240 counts / 3 planes). 

o For multispectral images, the signal is averaged across all wavelengths 

measured. For example, a DAB signal of OD = 0.60 in the blue, OD = 0.20 in the 

green, and OD of 0.10 in the red would report a signal of 0.30 OD units (= [0.60 + 

0.20 + 0.10] summed OD / 3 planes). 

• Peak: Peak is the peak signal of the selected component across all wavelengths. Peak 

weighting is available for images converted to Optical Density and for fluorescent 

multispectral images. Peak weighting is the default value for brightfield images. 

The simplified example below explains the differences among the three different weighting 

options. The example uses two fluors, Fluor A and Fluor B, and eight wavelengths (420, 460, 

500, 540, 620, 660, and 700 nm). The example also ignores noise and other sources of error. 

The spectral library is shown below in Figure 8.10. 
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FIGURE 8.10. Spectral Library. 

The signal at the image pixel where the pixel expresses one part Fluor A and 3 parts Fluor B is 

shown below in Figure 8.11. 

 

FIGURE 8.11. Signal at image pixel. 

Unmixing recovers the original spectra scaled according to the measured expression at the 

pixel as shown in Figure 8.12.  
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FIGURE 8.12. Original spectra, scaled. 

The challenge for the unmixed component image is to represent the unmixed spectrum 

using a single value. The three weighting options correspond to three possibilities for how to 

do this. 

• Peak weighting represents the spectrum as the signal level at the brightest 

wavelength of the spectrum. In the example, this gives component values of Fluor A = 

0.5739 and Fluor B = 1.5216. 

• Mean weighting represents the spectrum as the average signal across wavelengths. In 

the example, this gives component values of Fluor A = 0.3189 and Fluor B = 0.9689. 

• Total weighting represents the spectrum as the sum of the signals at all wavelengths. 

In the example, this gives component values of Fluor A = 2.551 and Fluor B = 7.7514, 

where the Total weighting is the Mean weighting multiplied by the number of 

wavelengths, which is 8 in this example. 

The scaled spectra annotated with the weighting values is shown below in Figure 8.13.  



USER GUIDE | inForm 

 

AKOYABIO.COM 78  

 

FIGURE 8.13. Scaled spectra. 

8.6. COMPLETING THE PREPARE IMAGES STEP 

After you have specified all the image preparation settings, you process the images using one 

of the four options detailed below. 

• To apply the selected settings to the currently selected image, click Prepare Image. 

• To apply the selected settings to all images that are open in the project, click Prepare 

All. 

• To apply the selected settings to all images that are open in the project and then 

display the next step in the project, click Advance. 

• To process all images in the project using the current settings, click the next step in the 

project in the Step Bar that is displayed at the top of the inForm window. (See Chapter 

3. Understanding the inForm Work Area.) The settings panel for the next step in the 

project is displayed. 
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CHAPTER 9. MANUAL TISSUE SEGMENTATION 

Section Page 

9.1. Adding Tissue Categories 79 

9.2. Drawing and Deleting Tissue Category Regions 81 

9.3. Editing Tissue Category Regions 82 

 

This topics in this chapter describe how to manually draw tissue categories on a project image. 

Tissue categories divide the image into specific areas that correspond to specific types of 

tissue (for example, cancer, necrosis, stroma, and so on) or occasionally other structures of 

interest. The Manual Classification step, which is available in inForm Basic Analysis or higher, 

provides the options that you can use to draw the appropriate tissue categories over areas of 

each tissue type on project images. You can then use these tissue categories to generate data 

or you can use them during the Cell Segmentation step, the Scoring step, or the Object 

Counting step. 

NOTE: For you to manually create tissue categories, you must have included the 

Segment Tissue step with Manual Tissue Segmentation selected at the time you created 

the project, or you might need to reconfigure your project. See Chapter 5.1. Creating an 

inForm Project. If your project algorithm includes a Manual Classification step, then you 

cannot use this algorithm in Batch Processing. 

9.1. ADDING TISSUE CATEGORIES 

To manually add tissue categories: 

1. If not already, then open the appropriate inForm project. 

2. On the Step bar, click the Manual Classification step icon. 

The Manual Analysis tab opens. The Tissue Segmentation panel opens on the tab. (See 

Figure 9.1.) 
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FIGURE 9.1. Tissue Segmentation panel. 

3. Click New. 

A placeholder with the default name of Category 1 is created for a new manual tissue 

segmentation category, and a default color is assigned to the category. (See Figure 9.2.) 

 

FIGURE 9.2. Tissue Segmentation panel with default category. 

4. Change the default name of Category 1 to your preferred category name, and 

optionally, on the Color drop-down list, select a different color for the category. 

5. Repeat Step 3 and Step 4 to create all the necessary tissue categories for the project. 

By default, every time you create a new tissue category, the Draw option is cleared for 

the previous category and selected for the new tissue category.  

NOTE: If you add a tissue category in error, then to remove it, select the category, 

and then click Remove. To remove all categories in a single step, click Clear. 
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6. Continue to Drawing and Deleting Tissue Category Regions. 

9.2. DRAWING AND DELETING TISSUE CATEGORY REGIONS 

After creating all the necessary tissue category regions, the next step is to draw the regions of 

these tissue categories on all of the project images that contain one or more of the tissue 

types. A single region on a project image can belong to only one tissue category type, for 

example, either tumor or benign, but not both. 

To draw tissue category regions on a project image: 

1. Ensure that the opened project is in Single mode. 

2. Click the image image thumbnail. 

3. Click the Draw button for the appropriate tissue category, and then click and drag your 

mouse pointer around (encircle) the appropriate groups of cells, making sure to release 

the mouse button to connect the starting point and ending point of the tissue 

category region. For example, if you are drawing the region for a Tumor tissue 

category, then draw the regions around groups of tumor cells. 

Note the following caveats as you manually draw these tissue category regions: 

a. If one region intersects another region in the same tissue category, then the two 

regions are merged into one region. 

b. If new intersects a region in a different tissue category, the area becomes part of 

the new tissue category. 

c. As you draw the tissue category regions, a gray mask covers the unselected parts of 

the image. This may can make it difficult for you to see the image clearly enough to 

draw additional tissue categories. To temporarily hide the existing tissue categories 

and the gray mask, click the Show/Hide Tissue Segmentation Map button.   

 



USER GUIDE | inForm 

 

AKOYABIO.COM 82  

After you draw the next tissue category on the image, the tissue segmentation 

map is again displayed on the image. 

4. After you have drawn all the necessary tissue category regions, you can do either of the 

following: 

a. Edit the tissue category regions. (See Chapter 9.3. Editing Tissue Category Regions.) 

b. Continue with the next processing step in the project by clicking Advance or the 

(next step) button on the Step bar. 

To delete tissue category regions from a project image: 

1. Ensure that the project is opened in Single mode. 

2. Click the image thumbnail. 

3. To delete one or more tissue category regions from the image, you have two options: 

a. Use the Delete Regions button. 

i. Click the Delete Regions button. 

The mouse pointer changes to a set of crosshairs. 

ii. Click on each tissue category region that you are deleting from the image. 

b. Right-click each tissue category region that you are deleting, and then on the 

Region context menu that opens, click Delete Region. 

9.3. EDITING TISSUE CATEGORY REGIONS 

After you draw tissue category regions on a project image, you can edit the regions. You can 

add areas to the region, you can remove areas from a region, or you can remove individual 

pixels from a region. 

To add an area to a tissue category region: 
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1. To refine the image and make is easier for you to add areas to the tissue category 

region, do any or all of the following: 

a. Zoom in or zoom out on the image to your preferred magnification. 

b. Use the Tissue Segmentation Map button to hide the tissue masks. 

c. If Processing Regions have been defined on the image, then use the Process 

Regions button to show or hide the process regions mask. 

2. Click the option button that is next to the tissue category to which you are adding an 

area, and then click and drag your mouse pointer around (encircle) the area that you 

are including, making sure to release the mouse button to connect the starting point 

and ending point of the area. Defined tissue classification areas can be intersecting. 

The outline area is assigned to the specific tissue category. 

To remove an area from a tissue category region: 

1. Click the Select Regions to Unclassify button.  

 

2. Click-and-drag your mouse pointer around (encircle) the area that you are removing, 

making sure to release the mouse button to connect the starting point and ending 

point of the area. 

The outline area is removed from the tissue category region. 

To remove individual pixels from a tissue category region: 

1. Zoom in on the image until the individual pixels become visible. 

2. Click the Select Pixels to Unclassify button. 

3. Remove one or more pixels from the region. 
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a. To remove a single pixel from a region, click it. 

b. To remove multiple pixels from the region, click and drag your mouse pointer 

around (encircle) the pixels that you are removing, making sure to release the 

mouse button to connect the starting point and ending point of the area. 
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CHAPTER 10. TRAINABLE TISSUE SEGMENTATION 

Section Page 

10.1. Adding Tissue Categories 85 

10.2. Drawing Tissue Segmentation Training Regions 88 

10.3. Selecting Training Components 88 

10.4. Adding Images to Training Set 92 

10.5. Editing Masks and Re-Training 93 

10.6. Completing Automated Tissue Segmentation Step 95 

Tissue categories divide the image into specific areas that correspond to specific types of 

tissue (for example, cancer, necrosis, stroma, and so on) or occasionally other structures of 

interest. The Segment Tissue Step, which is available only in inForm Tissue Finder, provides the 

options that you can use to draw the training regions around representative areas of tissue on 

images, and then the train the segmenter to automatically locate similar tissue regions in 

project images.  

The topics in this chapter describe how to automatically classify tissue using the tissue 

segmenter. You learn how to set up the tissue segmenter, how to add tissue categories and 

draw training regions on images in the training set, how to train the tissue segmenter, how to 

segment images, and then ultimately, how to fine tune the segmenter based on your initial 

results. 

NOTE: For you to carry out trainable tissue segmentation, you must have included the 

Segment Tissue step with Trainable Tissue Segmentation selected at the time you 

created the project, or you might need to reconfigure your project. See Chapter 5.1.1. 

Creating a Project or Chapter 5.1.2. Reconfiguring a Saved inForm Project.  

10.1. ADDING TISSUE CATEGORIES 

1. If not already, then open the appropriate inForm project.
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2. On the Step bar, click the Segment Tissue step icon.

The Manual Analysis tab opens. The Tissue Segmentation Training panel opens on the

tab. (See Figure 10.1.)

FIGURE 10.1. Tissue Segmentation Training panel. 

3. Click New.

A placeholder with the default name of Category 1 is created for a new tissue

segmentation training category, and a default color is assigned to the category. (See

Figure 10.2.)
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FIGURE 10.2. Tissue Segmentation Training panel with default category. 

4. Change the default name of Category 1 to your preferred category name, and 

optionally, on the Color drop-down list, select a different color for the category. 

5. Repeat Step 3 and Step 4 to create all the necessary tissue categories for the project. 

By default, every time you create a new tissue category, the Draw option is cleared for 

the previous category and selected for the new tissue category.  

NOTE: If you add a tissue category in error, then to remove it, select the category, 

and then click Remove. To remove all categories in a single step, click Clear. 

6. Continue to Drawing the Tissue Segmentation Training Regions. 
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10.2. DRAWING TISSUE SEGMENTATION TRAINING REGIONS 

A training region teaches the tissue segmenter which cells should be included in a specific 

tissue category. When you are drawing a tissue segmentation training region, you must know 

what cells or other structures to look for and you must also be able to visually recognize 

structures that are characteristic of a tissue category. A training region must train on the full 

range of appearances of the tissue category. For example, if there are tumor cells present in 

any image that are negative (cells that are not stained), then you must be sure to include both 

the positive (stained) cells and the negative cells in the training region. 

To draw tissue segmentation training regions on each image in a project: 

1. Ensure that the opened project is in Single mode. 

2. Click the image thumbnail. 

3. In the Tissue Categories pane, click the Draw button for a tissue category. 

4. Click and drag your mouse pointer around (encircle) the appropriate groups of cells, 

making sure to release the mouse button to connect the starting point and ending 

point of the selected tissue category region. For example, if you are drawing the region 

for a Tumor tissue category, then draw the regions around groups of tumor cells. 

NOTE: Be sure to capture visual anomalies such as areas slightly out of focus, 

folds, bubbles, and so on. Also capture stroma regions that have differing 

qualities of shape or orientation. 

5. Repeat Step 3 through Step 4 for each tissue category. 

6. After you have drawn all the tissue segmentation training regions on all the project 

images, continue to the next section. 

10.3. SELECTING TRAINING COMPONENTS 

You select the training components for tissue segmentation in the Components for Training 

pane. (See Figure 10.3.) 
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FIGURE 10.3. Components for Training pane. 

10.3.1. Training Components Considerations 

When you select the training components for the tissue segments, components that provide 

distinguishing pattern information that is independent of signals to be quantified are 

preferred. For example, because a counterstain such as DAPI or Hematoxylin reveals the 

structure of the tissue and is less likely to produce a segmenter biased by the presence of the 

molecular marker you are trying to quantify, you should first try the counterstain component 

plane for training. For example, if measuring the positivity of cells that were stained with Alexa 

Fluor in a sample stained with both DAB and Alexa Fluor, you would not want the segmenter 

to be dependent on the Alexa stain because that would bias the outcome. 

Conversely, sometimes in brightfield applications where the presence of an IHC stain such as 

DAB blocks the staining of the counterstain, using both the counterstain and the IHC stain 

component planes for training yields a more robust tissue segmenter, even for the negative 

cases. In these cases where the target label is included in the training, it is important to 

include abundant negative cases in the training set. Generally, you should also avoid using 

components that provide information that is unrelated to the preferred segmentation. 

10.3.2. Pattern Scale 

Pattern scale refers to the spatial extent of patterns that are measured to support machine 

learning and image analysis. The recommended approach is to start with the default Large 
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pattern scale. After you have drawn training regions and trained a tissue segmenter, if 

segmentation accuracy for the training regions is low (<85%), then increasing Pattern Scale 

might improve accuracy. However, the pattern scale must be compatible with the size of the 

training regions.  

If you select a pattern scale (for example, Maximum) that is too large for the drawn training 

regions, then a gray mask is displayed on training regions that are too small after training and 

these training regions are not used to train the tissue segmenter. You should use as large a 

pattern scale as is compatible with the training regions that you draw. If most of the training 

regions have gray masks over them after training, then reduce the pattern scale (for example, 

from Large to Medium), and then retrain. For instance, if you are analyzing tumors in tissue 

sections in a 20x magnification image, then the architecture is fundamentally on a large scale 

and you probably should select Large. For items that have inherently fine scale structures, 

select Small or Medium. An understanding of the different scales can be learned by seeing 

what size training regions are masked with gray after training. 

1. Select the components for training. 

2. Select the pattern scale.  

3. Click Train Tissue Segmenter. 

NOTE: The training process may take some time, so be patient. 

After the training is completed, the percent accuracy of the new tissue segmenter is 

displayed. If, for example, the segmenter was 99% accurate, this would mean that if you 

applied the new segmenter to all the images that were used in training the segmenter, 

the segmenter would classify the pixels in the training regions with 99% accuracy. 

(Fewer than 1% of the pixels in all the drawn regions would be misclassified.) 

4. Because inForm continues to try to improve the accuracy, click Stop to stop training 

when an acceptable level of accuracy is reached or the accuracy has stabilized.  

In general, segmenters should be at least 80% accurate. If the accuracy reaches 100%, a 

Done button is displayed.  

5. Click Done to close the Algorithm Training dialog box. 
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10.3.3. Recent Trainings 

The Recent Trainings drop-down lists records a history of segmenters that were trained using 

the current segmentation settings. For example, the first time you train, the training is named 

“Attempt 1,” the second training is named “Attempt 2,” and so on. To re-classify the images 

using a previous segmenter, select the appropriate training attempt (the segmenter) on this 

drop-down list. If you change any settings, then the history of segmenters is cleared. 

10.3.4. Segmentation Resolution 

The Segmentation Resolution determines the resolution of the tissue category segmentation. 

There is a trade-off between resolution and segmentation speed, with an approximately 4x 

increase in segmentation speed for every step in the resolution reduction.  

• To segment the images more quickly, select Coarse.  

Although the edges of the segmented regions appear pixelated, the segmenter still 

accurately differentiates structures well, for example, tumor from stroma.  

• If the segmented regions require smoother edges, such as images for use in 

publications, select Fine.  

NOTE: Segmenting with Fine resolution takes longer than with Coarse resolution. Also, if 

you selected a small Pattern Scale, then the Resolution must be set to Medium or finer. 

10.3.5. Segmenting the Tissue in the Training Images 

After you have trained the segmenter, you then can segment the tissue in the current image 

or all the images in the training set. To test the tissue segmenter, you can segment just the 

current image first, and then you can make any preferred adjustments to the training 

parameters and retrain the segmenter. To see the Tissue Category mask on all images, click 

Segment All. When you are ready, advance to the next step in the project. 

10.3.6. Fine Tuning the Segmenter 

Observe the training regions following the segmenter training. As mentioned above, if the 

software grays out any region, this indicates that the region is too small for the selected 

Pattern Scale and the region not used to train the tissue segmenter. You can ignore this if 
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segmentation performance is adequate, delete the region and redraw a larger one, or try 

selecting a smaller pattern scale. 

The Trim Edges option "erodes" a tissue segmentation by removing the specified number of 

pixels from the periphery of the selected tissue category, making it smaller. This option is 

useful if the tissue segmenter tends to include pixels that extend beyond the edges of objects 

or tissue categories of interest (for example, tumor or vessels). For example, if you notice 

cancer regions that are extending into non-cancerous areas, then select Trim Edges option, 

select the cancer tissue category, and then enter the number of pixels that are to be trimmed 

from the borders of the cancer regions. 

The Minimum Segment Size option is an adjustable parameter, in pixels, that removes 

segments that have fewer pixels than this specified value. The tissue segment that is most 

abundant around the segment that was removed replaces the removed segment. 

If Discard if Touching Image Border is selected, then the tissue regions that touch the edge of 

the image or process region are discarded. If Discard if Touching Image Border is not selected, 

then all tissue regions are included. 

10.4. ADDING IMAGES TO TRAINING SET 

When you select images for the training set, Akoya recommends that you start with one 

image per distinct appearance. The training set should represent the range of staining levels 

and tissue architectures that you want to train the tissue segmenter to identify. Whenever you 

draw a training region on an image (see Chapter 10.2. Drawing Tissue Segmentation Training 

Regions), inForm automatically adds the image to the training set. You can also add or remove 

images from the training set manually. 

To add images to the training set: 

1. Click the Image List Editor button. 

 

The Available Images window opens. 
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2. For each image that you are adding to the training set, select Training Set. 

3. Close the Available Images window. 

4. Optionally, to see which project images are in the Processing set and which images are 

in the Training set, or both, click the Single mode button. 

When you switch the project view to Single mode, icons that are displayed on an 

image thumbnail indicate the sets to which an image belongs. If an image is in the 

Processing set, then a small blue square is displayed on the image thumbnail. If an 

image is in the Training set, then a small green square is displayed. (See Figure 10.4.) 

 

FIGURE 10.4. Processing set and Training set indicators. 

5. To add training regions to selected images in the training set, see Chapter 10.2. 

Drawing Tissue Segmentation Training Regions. 

10.5. EDITING MASKS AND RE-TRAINING 

After reviewing the segmented images, you might discover that some structures were not 

segmented correctly, or that the segmenter might have selected some unwanted regions. 

The Tissue Segmentation masks should accurately cover their respective tissue categories. To 

correct the tissue masks, you have two options. You can:  

• Edit the mask manually. If the experiment or study involves few enough images, then 

you can manually edit the Tissue Segmentation mask. Manual editing does not change 

the tissue segmenter but if the images are re-segmented, then the changes to the 

Tissue Segmentation masks are lost. 
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• Re-train the tissue segmenter to detect the preferred regions. If some areas of the 

image were not classified as the preferred tissue type, then you can re-draw the 

training regions around the areas that were incorrectly classified and re-train the Tissue 

Segmenter. 

To manually edit the tissue segmentation mask: 

1. Click the Edit Tissue Segmentation button on the toolbar. 

2. On the drop-down list, select the tissue segmentation mask that you are editing.  

(See Figure 10.5.) 

3. Draw around the areas on the image that you are including in the selected Tissue 

Segmentation mask.  

 

FIGURE 10.5. Editing Tissue Segmentation Masks. 

4. To continue processing the images using the edited Tissue Segmentation masks, 

advance to the next step without re-segmenting the images. 

5. If the project contains a cell segmentation step and cell segmentation was carried out 

before you edited the mask, (see Chapter 13. Segmenting Cells), then in the Cell 

Segmentation editor, click the Segment Images button to re-segment the cells in the 

edited tissue segmentations. 

To re-train the tissue segmenter: 

1. In the Tissue Segmentation Training panel, select Draw for the tissue category for 

which you are drawing additional training regions. 

2. Draw the training regions around the areas that were incorrectly classified. 
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3. Re-train the tissue segmenter and then re-segment the image. 

4. Verify that the appropriate regions are now correctly classified in the preferred tissue 

segmentation mask. 

5. To see the tissue segmentation on all images, segment all the images.  

NOTE: Re-segmenting an image after re-training the tissue segmenter deletes any 

manual edits that were made to the tissue segmentation mask. 

10.6. COMPLETING AUTOMATED TISSUE SEGMENTATION STEP 

After you have selected all your preferred settings in the Tissue Segmentation Training panel 

and you have trained the Tissue Segmenter, process the images using any of the methods 

below and then advance to the next step in the project. 

1. Process the images using one of the following methods: 

a. To segment the currently selected image, click the Segment Image button. 

b. To segment all the images that are opened in the project, click the Segment All 

button. 

2. Click Advance. 

The next step in the project is displayed. 

3. Click the next step in the project in the Step Bar (see Chapter 3. Understanding the inForm 

Work Area) at the top of the inForm window.  

The settings panel for the next step displays. The tissue is segmented the next time images 

are processed. 
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CHAPTER 11. THRESHOLD 

Use the Threshold step to set threshold values for any of the unmixed components in an 

image and then to view the regions on the image that are above the threshold. Statistics are 

calculated for the thresholded regions and are displayed in the Quant Data table. 

To set the thresholds and calculate the threshold statistics for the images: 

1. Click the Threshold button in the Step bar. 

 

2. In the Components to Threshold list, select each of the image components for which 

you are creating a threshold map. 

3. You have two options for specifying the preliminary values for the Threshold max and 

the Threshold: 

a. To automatically calculate a preliminary value for the Threshold Max and then 

choose a preliminary Threshold value, click Auto.  

The Threshold Max is set to the value of the brightest pixel in the component. The 

slider range is set to (0 - Threshold Max). The threshold is set to an optimal value, 

based on the component values. 

b. To manually set the values for the Threshold Max and the Threshold value, use the 

slider option, enter the preferred values, or click the Up/Down arrows. 
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CHAPTER 12. COLOCALIZATION 

Colocalization is a pixel-based analysis that is used to find overlapping components in images 

based on thresholds that are set for each component. Colocalization is designed for analyzing 

and quantifying molecular markers. Colocalization can be used to determine the amounts of 

colocalization of multiple markers and the results can be displayed both visually and 

statistically. 

1. On the project Step bar, click the Colocalization button. 

 

The Colocalization Settings pane opens. (See Figure 12.1.) 

 

FIGURE 12.1. Colocalization Settings pane. 

2. For Markers for Colocalization, select the markers for which to view overlap 

(colocalization) and positivity percentages. 

3. For Denominator (Counterstain), select the markers that you are using as the 

counterstains. To see colocalization of markers throughout the entire image, and not 

just within a particular counterstain, select All Image Pixels. 
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For each component that you selected in the Markers or Denominator, a Threshold 

settings area displays below the Denominator options. A default color is displayed for 

each marker and counterstain.  

4. Use any of the following options to adjust the values for Threshold Max and Threshold 

for each component: 

a. To automatically calculate a preliminary value for the Threshold Max and then 

choose a preliminary Threshold value, click Auto.  

The Threshold Max is set to the value of the brightest pixel in the component. The 

slider range is set to (0 - Threshold Max). The threshold is set to an optimal value, 

based on the component values. 

b. To manually set the values for the Threshold Max and the Threshold value, use the 

slider option, enter the preferred values, or click the Up/Down arrows. 

5. Optionally, to change the default color for a marker or counterstain, click the default 

color that is displayed, and then select a different color.  

6. To view the threshold for each component: 

a. De-select Visible for all the components except for the component that you are 

adjusting. 

b. De-select Visible for Colocalization. 

c. Adjust the threshold value for the component until all the appropriate areas are 

marked as Positive. 

d. If there are small areas that are marked as Positive that should not be included, or if 

smaller regions should be marked as Positive and are not, click More, and then 

adjust the value for Minimum Connected Pixels as appropriate. 
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CHAPTER 13. SEGMENTING CELLS 

Section Page 

13.1. Adaptive Cell Segmentation 99 

13.2. Cell Segmentation 109 

The Segment Cells step is available in inForm Cell Analysis and inForm Tissue Finder. 

inForm contains two approaches for segmenting cells:  

• Adaptive Cell Segmentation uses an adaptive thresholding algorithm to identify

nuclear pixels and can use both nuclear and membrane signals to guide nuclear

splitting. It performs best on fluorescence imagery, especially imagery that contains

membrane staining. (See Chapter 13.1. Adaptive Cell Segmentation.)

• Cell Segmentation uses classical segmentation methods to locate the nuclear,

cytoplasmic and membrane compartments. It may outperform the Adaptive Cell

Segmentation on brightfield imagery. (See Chapter 13.2. Cell Segmentation.)

NOTE: Cells are an assembly of associated cellular components (nucleus, cytoplasm, 

and membrane). If you are segmenting tissue, some cells might straddle two 

segmented tissue regions. If a cell is not entirely contained within a single region, then 

the “containing region” is undefined, and the Region ID in the Data tables is #N/A. (See 

Chapter 17. Displaying the Extracted Data.) 

13.1. ADAPTIVE CELL SEGMENTATION 

Adaptive Cell Segmentation uses algorithms that account for variations in staining and 

background levels within and across images to identify cellular compartments from multiple 

image planes. These features provide improved segmentation performance when images 

contain mixtures of cell types with very different nuclear morphologies. 

Adaptive cell segmentation consists of following steps. We recommend that you optimize the 

settings at each step before moving on to the next one. 
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1. Select cellular compartments and image planes to aid segmentation. (See Chapter 

13.1.1. Selecting Segmentation Components.) 

2. Detect nuclear pixels using image planes associated with one or more nuclear stains. 

(See Chapter 13.1.1. Selecting Segmentation Components.) 

3. Split clusters of detected nuclear pixels into individual nuclei using: 

a. Image planes associated with nuclear stains (splits occur at valleys between nuclear 

signals). (See Chapter 13.1.2.1. Splitting Nuclear Clusters Using Nuclear Component 

Images.) 

b. (Optional). Image planes associated with assisting cytoplasmic or membrane stains 

(splits occur at ridges of positive membrane or cytoplasmic signal). (See Chapter 

13.1.2.2. Splitting Nuclear Clusters Using Membrane or Cytoplasm Component 

Images.) 

4. Refine nuclear shapes. (See Chapter 13.1.3. Refining Nuclear Shapes.) 

5. (Optional) Define cytoplasm and membrane around all nuclei. (See Chapter 13.1.4. 

Defining Cytoplasm and Chapter 13.1.5. Defining Membrane.) 

13.1.1. Selecting Segmentation Components and Detecting Nuclear Pixels 

1. Choose which cellular compartments to segment: Nuclei, Cytoplasm, and/or 

Membrane. (See Figure 13.1.) 

 

FIGURE 13.1. Segment options. 

NOTE: Adaptive Cell Segmentation can detect cells only with nuclear signal, so 

you cannot clear Nuclei. Although you can select Cytoplasm, and/or Membrane, 

we recommend that you wait to add Cytoplasm and/or Membrane options until 

you have optimized Nuclei detection and splitting settings. This reduces visual 
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clutter in the image. Adding those two options later does not alter any 

parameter adjustments to Nuclei settings. 

2. To add the image components that are to be used for segmentation, click Add, and 

then select the image component name on the drop-down list. (See Figure 13.2.) 

 

FIGURE 13.2. Adaptive Cell Segmentation components. 

When adding the image components, choose your strongest, most abundant nuclear 

component first. You can repeat this step to include additional nuclear, cytoplasmic, 

and/or membrane components if they will aid segmentation. Add only those 

components that show strong, specific staining. Adding components with weak or 

non-specific signal can lead to undesired segmentation results. All image components 

can still be analyzed within the segmented cell compartments even if those 

components are not configured to aid in segmentation here. 

NOTE: Priority is given to nuclear splitting lines that are attributed to image 

components higher up in the list of components. As a result, we recommend you 

add your strongest and most specifically stained components first in this list. 

3. Click the “…” button to open a Component Configuration dialog box and then configure 

each component. (The options on the dialog box change depending on the location 

where the component is located.)  

a. Select the compartment where the component is located. 

b. For nuclear components, use the Typical Intensity slider to adjust the threshold 

used to detect nuclear pixels.  

c. If a component belongs to the cytoplasm or membrane, select Use this signal to 

assist in nuclear splitting. When using this signal to assist in nuclear splitting is 
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selected, signals in the associated image plane are used to generate potential split 

lines within clusters of nuclei. We recommend selecting this option only for image 

components that have strong, specific signals. See dialog box examples below in 

Figure 13.3. 

 

FIGURE 13.3. Component Configuration dialog box examples. 

NOTE: For the Component Figuration dialog box on the left, the threshold is adaptive 

and is measured relative to nearby background. Increase this value if too much 

background is being detected as nuclear. Lower this value if faint nuclei are being 

missed. At this point, do not focus on whether nuclei are correctly split from each other. 

(Splitting is addressed in subsequent steps). Focus only on whether the correct pixels 

are being detected as nuclear. 

NOTE: All nuclear component planes are used to assist nuclear splitting even when 

cytoplasmic or membrane components have been selected. We recommend you do not 

select this option until after you first optimize nuclear splitting for nuclear component 

planes. You might also want to assess the changes to the segmentation results after 

each signal is individually selected so the added value of each component is more 

obvious. 

After at least one image component has been configured, a live preview region appears in the 

current image. This preview provides live feedback as you adjust settings such as the Typical 

Intensity. You can click-and-drag the region to preview other areas in the image. You can click-

and-drag the image outside the preview region to drag the entire image. (See Figure 13.4.) 
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FIGURE 13.4. Live Preview with Hide Preview option. 

13.1.2. Splitting Nuclear Clusters into Individual Nuclei 

Clusters of nuclear pixels are split into individual nuclei in one of two ways: 

• From nuclear components.  

• From image planes from assisting membrane and cytoplasm components.  

13.1.2.1. Splitting Nuclear Clusters Using Nuclear Component Images 

You use the options that are available in the Nuclear Component Splitting panel to adjust the 

splitting parameters that are used for image planes that are associated with the nuclear 

components. The settings in this panel are applied to all nuclear components. (See Figure 13.5.) 

 

FIGURE 13.5. Nuclear Component Splitting panel. 

1. Click the “…” button to open the Nuclear Splitting Settings dialog box. (See Figure 13.6.) 
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FIGURE 13.6. Nuclear Splitting Settings. 

2. Configure the splitting sensitivity, making sure to select the option that best describes 

the staining quality of all the selected nuclear planes. (You might need to experiment 

to verify your selection.) 

3. Adjust the splitting threshold, either by using the slider bar, manually enter the value, 

or using the Up/Down arrows. 

4. Click OK to close the dialog box and return to the Nuclear Component Splitting pane. 

5. Set the value for the Minimum Nuclear Size (in number of pixels). 

Splitting lines that generate nuclei smaller than this size are ignored. Any isolated 

nuclei that are smaller than this value are discarded. 

NOTE: You can position your cursor over segmented compartments in the image 

to display characteristics of the compartment, including nuclear size. This might 

help you choose an appropriate value for Minimum Nuclear Size. 

13.1.2.2. Splitting Nuclear Clusters Using Membrane or Cytoplasm Component 
Images 

You use the options that are available in the Assisting Component Setting panel to adjust the 

parameters for cytoplasmic images, membrane images, or both. This pane is visible only if you 

selected at least one assisting component. The settings in this panel are applied to all 
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cytoplasmic components and membrane components that were selected with the Use this 

signal to assist in nuclear splitting option. (See Figure 13.7.) 

 

 

FIGURE 13.7. Assisting Component Splitting panel. 

1. Click the “…” button to open the Assisting Component Splitting Settings dialog box. 

(See Figure 13.8.) 

 

FIGURE 13.8. Assisting Component Splitting Settings dialog box. 

2. Configure the splitting sensitivity, making sure to select the option that best describes 

the staining quality of the assisting membrane and cytoplasmic planes. (You might 

need to experiment to verify your selection.) 

3. Adjust the splitting threshold, either by using the slider bar, manually enter the value, 

or using the Up/Down arrows. 

4. Click OK to close the dialog box and return to the Nuclear Component Splitting panel. 

5. Set the value for the Minimum Nuclear Size (in number of pixels). 

The system ignores splitting lines that generate nuclei smaller than the indicated size. 
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If you are more confident in the splitting lines that the assisting components 

generated than the nuclear components generated, or, if the cells that have 

membrane signals tend to be smaller than those that do not, you can want to set this 

value to be smaller than the Minimum Nuclear Size that you specified in the Nuclear 

Component Splitting panel. 

NOTE: You can position your cursor over segmented compartments in the image 

to display characteristics of the compartment, including nuclear size. This might 

help you choose an appropriate value for Minimum Nuclear Size. 

13.1.3. Refining Nuclear Shapes 

After you have optimized the settings for detection of nuclei and the splitting of nuclei, 

optionally, you can use the settings in the Other Settings panel to further refine your results. 

(See Figure 13.9.) 

 

FIGURE 13.9. Other Settings panel. 

You can adjust the value for one or both settings: 

• If you find that some nuclei contain empty “holes,” then increase the value for the Fill 

Holes Smaller Than setting until all these empty holes are filled. 

• If you find that the detected membrane shapes are more jagged or angular than you 

prefer, then select Refine cells after segmentation to compact the cells into rounder 

shapes. 

NOTE: The following sections, 13.1.4 Defining Cytoplasm and 13.1.5 Defining Membrane, 

are presented as two independent topics with independent settings panes; however, if 

you selected both cytoplasm and membrane, then a single combined settings panel, 

Membrane and Cytoplasm Settings, is displayed. (See Figure 13.10.) You can set the 

values in this combined settings panel just as you would in the independent panes that 

are discussed in these sections. 
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FIGURE 13.10. Membrane and Cytoplasm Settings panel. 

13.1.4. Defining Cytoplasm 

You use the option that is available in the Cytoplasm Settings panel to segment cytoplasm. 

(See Figure 13.11.) 

 

FIGURE 13.11. Cytoplasm Settings panel. 

To define the distance, in pixels, from the boundary of each cell’s nucleus to the outer 

boundary of its cytoplasm, adjust the value for Cytoplasm Thickness. For each cell, all pixels 

that are between the nuclear boundary and the cytoplasm outer boundary are defined as 

cytoplasm. You should adjust this distance based on the visual inspection of the results, so that 

cytoplasm segmentation approximately matches the average size of the cells. 

NOTE: Cytoplasm segmentation does not account for any signals that are from 

cytoplasm component images. 

13.1.5. Defining Membrane 

You use the options that are available in the Membrane Settings panel to segment 

membrane. (See Figure 13.12.) 

 

FIGURE 13.12. Membrane Settings panel. 
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1. To define the distance, in pixels, from the boundary of each cell’s nucleus to search for 

membrane signals, adjust the value for the Membrane Search Distance. 

Tip: By setting the value for the Membrane Search Distance to be larger than the value 

for Cytoplasm Thickness, the algorithm can not only search a large distance for true 

positive membrane signals, but also collapse to a smaller cell size if no positive signals 

are found. For this added flexibility, you might want to include cytoplasm 

segmentation even if you are not directly interested in the cytoplasm compartment. 

a. If positive signals are detected between the nucleus boundary and the Membrane 

Search Distance, then membrane is drawn where the positive signal is detected. 

b. If no positive signal is detected between the nucleus boundary and the Membrane 

Search Distance, then the membrane is drawn at the nearest of three different stop 

points: 

• Membrane Search Distance. 

• A neighboring membrane. 

• Cytoplasm Thickness (if cytoplasm segmentation was selected). 

NOTE: If the membrane is drawn at positive membrane signals that are 

found at a distance between the Cytoplasm Thickness and the Membrane 

Search Distance, then the resulting cytoplasm spans the entire area 

between the nucleus and the membrane, even if this results in a 

cytoplasm that is thicker than the selected Cytoplasm Thickness value. 

2. Click the “…” button to open the Membrane Settings dialog box. (See Figure 13.13.) 

 

FIGURE 13.13. Membrane Settings dialog box. 
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3. Configure the sensitivity of the membrane signal detection, making sure to select the 

option that best describes the staining quality of the configured membrane 

components. (You might need to experiment to verify your selection.) 

4. Adjust the membrane detection threshold, either by using the slider bar, manually 

enter the value, or using the Up/Down arrows. Lower values result in the detection of 

weaker signals. 

NOTE: These settings are applied to all components that are configured as 

“membrane.” 

5. Click OK to close the dialog box and return to the Membrane Settings pane. 

13.2. CELL SEGMENTATION 

You use the options that are available in the Cell Segmentation Settings panel to set the 

parameters for segmenting cells into their respective categories so that you can extract the 

cellular data and analyze the data on per-cell basis. (See Figure 13.14.) 

 

FIGURE 13.14. Cell Segmentation Settings panel. 

To segment cells: 

1. Select the cell components to segment: Nuclei, Cytoplasm, and Membrane. (Cytoplasm 

and Membrane are available for selection only after Nuclei is selected.) 

2. To discard any cell that has a cell component that touches the edge of the image, or if 

applicable, a process region, or tissue region, select Discard Touching an Edge. 
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Only the cells that are contained entirely within the image, a process region (if 

applicable), and the selected tissue category (if applicable) are included in the 

segmentation map. If you do not select this option, then the cells are clipped at the 

edge of the image or region. If a cell is clipped at the edge of a process region or tissue 

category region, then the size of the nucleus or cytoplasm inside the region might be 

smaller than the specified Minimum Size. 

3. Do one or more of the following, as appropriate: 

a. If you selected Nuclei, then open the Nuclei tab and select the parameters. Use the 

Preview window to determine the optimal parameters for segmentation. See 

Segmenting Nuclei for a description of the available parameters. 

b. If you selected Cytoplasm, then open the Cytoplasm tab and select the parameters. 

Use the Preview window to determine the optimal parameters for segmentation. 

See Segmenting Cytoplasm for descriptions of the parameters. 

c. If you selected Membrane, then open the Membrane tab and select the 

parameters. Use the Preview window to determine the optimal parameters for 

segmentation. See Segmenting Membrane for a description of the parameters. 

4. To segment the current image using the selected parameters, click the Segment 

Image button. 

5. Review the segmentation of the current image, and then do one of the following:  

a. If you are satisfied with the results, then click the Segment All button to segment all 

the project images. 

b. If you are not satisfied with your results, then iteratively repeat Step 3 through Step 

5 until you are satisfied with the results, then click the Segment All button. 

13.2.1. Segmenting Nuclei 

1. In the Compartments to Segment pane, select Nuclei.  
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2. Optionally, if you intend to find cytoplasm and membrane, then you can select 

Cytoplasm and Membrane also. 

3. Open the Nuclei tab, and then select the values for the following options: 

a. Tissue Category: The option to select a specific Tissue Category or all Tissue 

Categories in which to find the cell nuclei is displayed for segmenting nuclei only if 

tissue has been segmented, either manually or automatically. Examples of tissue 

categories that might of be interest when segmenting nuclei are tumor regions in 

oncology samples or islet cells in pancreatic samples. Cells that are outside the 

chosen category are ignored. 

b. Approach: Select one of two options: 

i. Pixel-Based (Threshold): As the name implies, this approach is purely pixel-

based. Select this approach when there is a reliable nuclear counterstain, and 

nuclear pixels can be found by applying a simple threshold. You can also use 

the pixel-based for other image analysis needs that can be satisfied with a 

simple threshold, such as detecting all pixels within a tissue category that stain 

positive for an IHC stain. 

ii. Object-Based: Select the object-based approach if the nuclear counterstain 

does not provide consistent and specific staining of nuclear objects, and more 

advanced morphometry-based approaches are required to detect nuclei. 

4. Specify the signal scaling settings for the selected segmenting approach. (See Figure 

13.15.) 

 

FIGURE 13.15. Signal Scaling Settings for Segmentation. 

a. Auto Scale: If you select Auto Scale, then before inForm carries nuclei segmentation 

it automatically scales each nuclear counterstain component plane on an 
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individual basis. Auto Scale is a good starting point for nuclei segmentation and it is 

useful if nuclear counterstain signals vary widely. Also, Auto Scale is sufficient for 

fluorescence applications. 

b. Fixed Scale: If you require better nuclear segmentation performance and 

counterstain signals are consistent and reliable then select Fixed Scale. (Counts is 

the unit for Fixed Scale signal scaling.) If you select Fixed Scale, you must manually 

enter a scaling value. To determine the value that you should enter, use the View 

Component Data tool and then move your mouse pointer over the brightest nuclei 

in the image to the see the signal levels of the component that is being used for 

nuclear segmentation. Every object that is in a nuclear segmentation, which is 

indicated by a green region, should be nuclei. 

i. If the nuclear segmentations are smaller than the nuclei, or if no nuclear 

segmentations occur when the segmenter is finished, then reduce the value for 

the maximum OD or Counts. 

ii. If the nuclear segmentation is too sensitive and it is finding many objects that 

weakly stained and are not nuclei, then increase the scale until the unwanted 

regions are not detected. 

5. Optionally, to further add to what you consider to be nuclear pixels, in the Components 

for Nuclear Segmentation pane, select other components in the underlying signal. See 

Chapter 13.2.1.1. Selecting Additional Components in the Underlying Signal. 

6. In the Size Range pane, set the value (in pixels) for the minimum size for the 

segmented nuclei. (See Figure 13.16.) 

 

FIGURE 13.16. Size Range pane for nuclear segmentation. 

Note the following when you set the value for Minimum Size: 
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a. If too many small, unwanted structures, and not nuclei are found during 

segmentation, try increasing the value for the minimum size. Any nuclei that have 

fewer pixels than this number are not segmented, and no associated data is 

collected. 

b. If a nucleus is clipped at the edge of a Process region or Tissue Category region, 

then the original size of the nucleus is used to determine if the nucleus meets the 

minimum size threshold. The clipped size is reported in the tables. For images that 

are taken at 20x magnification, 100 pixels is a good initial value for the Minimum 

Size. 

7. If applicable, set the value (in pixels) for the maximum size for the segmented nuclei. 

Note the following when you set the value for Maximum Size: 

a. A value for maximum size sets an upper limit on nuclear segmentations (in 

number of pixels). Nuclear segmentations that are larger than this value are 

ignored. Setting a value for the nuclei maximum size can useful for ignoring large 

clusters of nuclei, or if there are other objects in the classified region of interest that 

are not nuclei. 

b. If you intend to select the Refine Splitting clean-up discussed in the next step (Step 

8), then you must set a value for the maximum size. 

8. If your initial segmentation results are not as expected or satisfactory, then optionally, 

you can specify values for specific “Clean-up” parameters. (See Figure 13.17.) 

 

FIGURE 13.17. Clean-up parameters for nuclei segmentation. 

a. Fill Holes: A common effect in tissue sections is to have some of the nuclei in the 

image segmented with “holes” in them. To counter this effect and have all holes of 
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all sizes in all nuclei automatically filled, select Fill Holes. To limit the filling of nuclei 

holes to only those holes that are smaller than a specified size, select Max. Hole Size, 

and then enter the value for the maximum hole size in pixels. Nuclei with holes that 

are larger than this value are not filled. 

b. Refine Splitting: Select Refine Splitting to have nuclei that are touching each other 

split into separate nuclei instead of being detected as one large nucleus. Be aware, 

however, that if you select Refine Splitting, cell segmentation can take considerably 

longer than without Refine Splitting selected. 

c. Roundness: Minimum Circularity: To find only nuclei of a defined roundness, 

select Roundness: Minimum Circularity, and then enter a value. The allowed values 

are decimal values that fall within the range of 0-1, inclusive, where a value of 0 

returns any shape, and the maximum value of 1 restricts selections to the most 

round objects that are found in the image.  

13.2.1.1. Selecting Additional Components in the Underlying Signal 

Optionally, when segmenting nuclei, you can further add to what you consider to be nuclear 

pixels and select other components in the underlying signal. (See Figure 13.18.) 

 

FIGURE 13.18. Components for Nuclear Segmentation pane. 

1. At a minimum, select an individual component as the Primary signal, and then enter a 

minimum signal value for the component.  

2. Optionally, select up to two additional components, one as the Secondary component 

and one as the Tertiary component, and then enter a minimum signal value for each 

component. 
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Note the following when you are specifying the signal value for each additional 

component: 

a. In Auto Scale mode, the signal range for or each component is 0 to 1. If you selected 

Fixed Scale, then the range for each component is from 0 to 2 for OD images, 0 to 

255 for 8-bit images, and 0 to the Fixed Scale value for all other images. Also, if you 

switch between Auto Scale and Fixed Scale, then the values are reset to zero. 

b. Only pixels that are above the minimum signal value are counted as nuclei. Adding 

secondary and tertiary components is primarily useful in brightfield IHC 

applications where nuclear IHC stains are dark or segmentation on the logical 

intersection of the Hematoxylin and nuclear IHC signals is more effective. This 

approach does not work if the dark IHC stains reside outside the nucleus. 

c. After you have selected at least one component, and the selected segmentation 

settings are valid, a live preview is displayed in the current image. This preview 

provides live feedback as you adjust settings. Optionally, you can:  

i. Click-and-drag the region to preview other areas in the image.  

ii. Click-and-drag the image outside the preview region to drag the entire image. 

iii. Click Hide Preview to hide the preview. Click Show Preview to show the preview 

again. (See Figure 13.19.) 

 

FIGURE 13.19. Live Preview image. 
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13.2.2. Segmenting Cytoplasm 

Because inForm searches for cytoplasm only where nuclei have been found, you must 

segment the nuclei in addition to segmenting cytoplasm. 

1. In the Compartments to Segment pane, confirm that Nuclei is selected, and then 

select Cytoplasm.  

2. Open the Cytoplasm tab (see Figure 13.20), and then select the values for the following 

options: 

 

FIGURE 13.20. Cell Segmentation Settings panel, Cytoplasm tab. 

a. Inner distance to nucleus (pixels): The Inner distance to nucleus is the distance, in 

pixels, that is from the edge of nuclear segmentations to the inner edge of the 

cytoplasm annular regions that are drawn around nuclei. This buffer distance 

should be large enough to ensure that imperfections in the nuclear segmentation 

do not lead to signal from nuclei inadvertently becoming part of cytoplasm signals. 

b. Outer distance to nucleus (pixels): The Outer distance to nucleus is the distance, in 

pixels, that is from the edge of the nuclear segmentation to the outer boundary of 

cytoplasm segmentation. This distance should be adjusted based on visual 

inspection of the results so that cytoplasm segmentation approximately matches 

the average size of cells. This distance can be set large enough to include 

membrane signals if preferred. 

c. Minimum Size (pixels): The Minimum Size is the minimum cytoplasm sample size, 

in pixels. If cytoplasm segmentations for detected nuclei have fewer pixels than this 

number, then these cells are excluded from the analysis. This situation is common 

in cases where cells are tightly packed together without much space between 

nuclei for cytoplasm areas to be segmented. If the cytoplasm is clipped at the edge 

of a Process region or Tissue Category region, then the original size of the 
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cytoplasm is used to determine if it meets the minimum size threshold. The clipped 

size is reported in the tables. 

3. Optionally, when segmenting cytoplasm, you can further add to what you consider to 

be “valid” cytoplasm and select other components in the underlying signal. You have 

three options: 

a. At a minimum, select an individual component as the First signal, and then enter a 

minimum signal value for the component, and then optionally, you can select up to 

three additional components (Second, Third, and Fourth), and then enter a 

minimum signal value for each component. 

b. Select Every Component, and then enter a signal value. 

c. Select Any Component, and then enter a signal value. (See Figure 13.21.) 

 

FIGURE 13.21. Other cytoplasm signal components. 

Only those pixels that fall within the given signal range are counted as cytoplasm, where the 

signal range varies based on the image type. 
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13.2.3. Segmenting Membrane 

Because inForm searches for cytoplasm only where nuclei have been found, you must 

segment the nuclei in addition to segmenting membrane. 

1. In the Compartments to Segment pane, confirm that Nuclei is selected, and then 

select Membrane.  

2. Open the Membrane tab. (See Figure 3.22.) 

 

FIGURE 13.22. Cell Segmentation Settings panel, Membrane tab. 

3. Select the First component signal for membrane segmentation. 

4. Optionally, select up to three additional component signals for membrane 

segmentation: Second, Third, and Fourth. 

5. For each component, do the following to set the Full Scale: 

a. Select an image that is typical of all the images that are to be analyzed. 

b. Click Auto to find the brightest pixels in the image for each of the selected 

components. 

The brightest value for each component is displayed in the associated Full Scale 

field. The units can be Counts or OD. 
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In the Maximum Cell Size pane, specify the value for Distance to Membrane (pixels), 

where the Distance to Membrane value specifies the maximum size of the cells, 

defined here as the distance, in pixels, from the edge of the nucleus to the outer edge 

of the membrane. 

The value that you specify here limits how far from the nucleus the algorithm is 

permitted to go when segmenting the cell membrane. A value of 12 for images taken 

at 20x magnification is usually a good starting value. If the algorithm is finding a 

membrane that is too large, then try reducing the value. Conversely, if the algorithm is 

finding a membrane too small, then try increasing the value. 
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CHAPTER 14. PHENOTYPING CELLS 

Section Page 

14.1. Adding, Deleting, or Renaming Phenotyping Schema 120 

14.2. Adding and Deleting Phenotype Classifiers 122 

14.3. Training a Phenotype Classifier 124 

 

NOTE: Before you can phenotype cells, you must have first carried out accurate cell 

segmentation.  

After you have carried out cell segmentation, you can proceed with phenotyping of the cells in 

an image. Just like the Tissue Segmentation feature, inForm’s phenotyping feature is 

trainable.  

14.1. ADDING, DELETING, OR RENAMING A PHENOTYPING SCHEMA 

1. Open a project in inForm. 

2. Configure the project to include the Phenotyping step.  

Carry out accurate cell segmentation. 

3. Advance to the Phenotyping step. 

The Phenotyping Settings panel opens on the Manual Analysis tab. inForm creates an 

Unnamed Phenotyping Schema on the Phenotyping Schema drop-down list with a 

Standard Associated View. Two default phenotypes are also created within the 

phenotyping schema: “a” with a default color of Red and “b” with a default color of 

Green. (See Figure 14.1.) 
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FIGURE 14.1. Default Phenotyping Schema placeholder. 

4. On the Phenotyping Schema drop-down list, select Edit. (See Figure 14.2.) 

 

FIGURE 14.2. Phenotyping Schema for an inForm project with two Phenotyping classifiers and 
the Edit button. 

The Edit Phenotype Schema dialog box opens. The first time that this dialog box opens, the 

dialog box displays only the Unnamed Phenotyping Schema. (See Figure 14.3.) Going forward, 

it displays the all the Phenotyping Schemas that have been added for the project. You use the 

options in this dialog box to add, delete, or rename a phenotyping schema. 
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FIGURE 14.3. Edit Phenotype Schemas dialog box. 

5. Do any of the following options:

a. To add your first phenotyping schema to a project, select the unnamed

phenotyping schema, and then click Rename. Enter the new name for the

phenotyping schema, and then click OK. (You can also use the Rename option to

rename any existing Phenotyping Schemas, not just the default Unnamed

schema.)

b. To add more phenotyping schemas to a project, click Add. Enter the name for the

new phenotyping schema, and then click OK.*

c. To delete a phenotyping schema, select the schema that you are deleting in the

Phenotyping Schema pane, and then click Delete. Click OK to confirm the deletion.

NOTE: You cannot click Phenotype All to apply a trained classifier to all images in a 

project unless you have first trained classifiers for all existing Phenotyping Schemas. As 

a result, we recommend that you successfully train the classifiers for you first schema 

before you add more schemas. See Chapter 14.3. Training a Phenotyping Classifier. 

14.2. ADDING AND DELETING PHENOTYPE CLASSIFIERS 

You can add multiple classifiers to a Phenotyping Schema, you can delete individual classifiers 

from a phenotyping schema, and you can delete all classifiers from a Phenotyping Schema in 
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a single step. You carry out these actions in the Phenotyping Settings panel on the Manual 

Analysis tab. 

To add a classifier to a Phenotyping Schema: 

1. On the Phenotyping Schemas drop-down list, select the schema to which you are 

adding the classifiers. 

2. Click Add. 

The Create New Phenotypes dialog box opens. 

3. Enter the name for the new phenotype, and then select its color. 

4. Click OK. 

The Create New Phenotype dialog box closes. The newly added phenotype and its 

color are displayed in the Phenotypes pane. (See Figure 14.4.) 

 

FIGURE 14.4. Phenotyping step in a project. A new phenotype is being added to a 
Phenotyping Schema named CK. The new phenotype is named Other and has been assigned 

the color gray. 

After you have added a Phenotyping Schema, note the following: 

When you select a Phenotyping Schema, an Associated view is automatically selected for the 

schema. You can select an available Composite View from the Associated View drop-down list. 
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If you switch to a different view, then inForm alerts you. You can click Show It to quickly return 

to the Associated view. (See Figure 14.5.) 

FIGURE 14.5. Switching to a view other than the Associated View for a Phenotyping schema. 

NOTE: Only those channels that are included in the Associated View are used to train 

the classifiers for a Phenotyping Schema. See Chapter 14.3. Training a Phenotyping 

Classifier. 

To delete a classifier from a Phenotyping Schema: 

1. On the Phenotyping Schemas drop-down list, select the schema from which you are

deleting the classifier.

2. Click the Select option that is displayed to the right of the classifier that you are

deleting.

3. Click Remove.

To delete all classifiers from a Phenotyping Schema: 

1. On the Phenotyping Schemas drop-down list, select the schema from which you are

deleting all the classifier.

2. Click Clear.

14.3. TRAINING A PHENOTYPING CLASSIFIER 

When you are carrying out the Phenotyping step in an inForm project, you can train multiple 

classifiers. Each classifier is described by a Phenotyping Schema, which includes a list of 

possible phenotypes and an Associated View. You can analyze a maximum of 50 channels in 

inForm.  
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Note the following caveats when you are training a phenotyping classifier: 

• You can choose cells across multiple images if, for example, you cannot find many cells 

of a particular phenotype in one image. Ideally, you should choose images from the 

same tissue or from tissue sections that you are confident have been stained and then 

segmented identically or very similarly. 

• If you decide to Add, Remove or Clear phenotypes after you have already started 

training a classifier, then you must start training again. 

• The first time you train a classifier, the training step might take longer than subsequent 

steps because the features that inForm has been trained to recognize are cached in 

memory for use in training steps subsequent steps. 

• You might find that turning off the visualization of the nuclei allows you to better select 

the cell phenotypes that you recognize. 

• You can also toggle back and forth between the different viewing modes to help 

identify a cell phenotype. 

• To improve phenotyping accuracy, Akoya Biosciences recommends assigning multiple 

classifiers when you are phenotyping cells that are identifiable as “double positive” or 

“triple positive,” such as CD3+/CD8+/PD-1+. 

To train a phenotyping classifier: 

1. Open the inForm project. 

2. Ensure initially that the project is in Single mode. 

3. Select the training image. 

4. Ensure that the correct Phenotyping Schema is displayed on the Phenotyping Schema 

drop-down list in the Phenotyping Settings panel. 

5. Click the Edit Phenotypes button. 
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The phenotypes are now available to assign to the cells in the image. 

6. Click a cell in the image to open a drop-down list of all the available phenotypes for the 

selected Phenotyping Schema, and then select the phenotype for the cell. (See Figure 

14.5.) 

NOTE: You need to identify at least 5 cells in each phenotype. For optimal results, Akoya 

Biosciences recommends choosing 25 or more cells of each phenotype. You might start 

with a small number of cells, and then add mis-classified cells to the training set by 

correcting their phenotypes. 

 

FIGURE 14.5. Selecting a phenotype for given cell. 

7. Repeat Step 6 for as many cells in the image as is appropriate. 

8. After you are finished with selecting the training cells for a given Phenotyping Schema, 

click Train Classifier. 

After the classification process is complete, the following information is available for the 

training image: 
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a. A Training table opens at the bottom of the Phenotyping Settings panel. The table 

lists each phenotype that you selected for training purposes, the number of cells of 

each phenotype that you selected for training purposes, and the total number of 

cells that you have selected for training purposes. 

b. You can hold your mouse pointer over any particular cell in the training image to 

open a tooltip that displays the phenotype that inForm assigned to the cell as well 

as the confidence level in the classification. An entry is displayed for each 

Phenotyping Schema with a trained classifier.  

NOTE: You can also view the phenotype and confidence data for each cell in 

the training image in the Cell Segmentation Data table. (See Figure 14.6.) 

 

FIGURE 14.6. Viewing the training data for a classifier. 

c. You can view the parameters for classification in the inForm log file. (To access the 

log file, on the inForm main menu, click Help > View Log.) inForm logs the 

parameters after training and you can view these parameters in the Log file that is 

date-stamped with the training date. The log shows the normalized non-zero 

coefficients that were used in the linear classifier for each phenotype. Normalized 

coefficients are scaled by the standard deviation of the associated feature, which 

results in all the coefficients being put on the same scale and allows for the 

comparison of the relative importance of features. A confidence level, in percent, is 

reported for each phenotype with 25 or more training examples. See Appendix C. 

Phenotype Classification by Multinomial Logistic Regression for a detailed 
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description of the phenotyping algorithm and the parameters that are contained in 

the log file. 

14.3.1. Editing the Training Results 

You can correct errors in classification and you can remove cells from a training set. You can 

also add correctly classified cells to a training set. After you make any edits to a completed 

training set, the Training table display is automatically updated to reflect the new training 

information. 

To correct errors in classification: 

1. Ensure that the correct training image is opened in Single mode in the Image Display 

area. 

2. Click the Edit Phenotypes button. 

3. In the training image, click the mis-classified cell, and then on the drop-down list that 

opens, select the correct phenotype for the cell. inForm then re-classifies the cell at a 

100% confidence for the selected phenotype and adds the cell to the training set. 

To remove classified cells from a training set: 

1. Ensure that the correct training image is opened in Single mode in the Image Display 

area. 

2. Click the Edit Phenotypes button. 

3. In the training image, click the appropriate cell, and then on the drop-down list that 

opens, select Remove from training. (See Figure 14.7.) 
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FIGURE 14.7. Reclassifying the phenotype for a training cell. 

To add correctly classified cells to a training set: 

1. Ensure that the correct training image is opened in Single mode in the Image Display 

area. 

2. Click the Edit Phenotypes button. 

3. In the training image, click the appropriate cell (a cell that was not used to train the 

classifier), and then on the drop-down list that opens, select the correct phenotype for 

the cell. 
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CHAPTER 15. SCORING IHC OR IF 

Section Page 

15.1. Scoring Types 132 

 

After segmenting nuclei, cytoplasm, and membrane, the detected cell compartments are 

quantified. The options in the Score IHC or IF Settings panel provide functionality similar to 

that which is done manually or visually when users assess chromogenic 

immunohistochemical stain levels. The Score IHC or IF settings specify the component 

thresholds and “score” the images. A Histogram scoring type is used to assess the intensity of 

each label. Five histogram scoring types are available. When you score images, the results are 

displayed at the bottom of the Score IHC or IF Settings panel. (See Figure 15.1.) 

 

FIGURE 15.1. Score IHC or IF Settings panel example. 

The table below describes the options that are available in the Score IHC or IF Settings panel, 

regardless of the selected Scoring Type. Other panel options that are displayed depend on the 

selected Scoring Type and are defined in the Scoring Type section.  

  



USER GUIDE | inForm 

 

AKOYABIO.COM 131  

TABLE 15.1 Options available in Score IHC or IF Settings panel 

Option Description 

Tissue Category 

This option is displayed only if tissue has been segmented and only those 
tissue categories in which cells have been segmented are available. 
Select the tissue category to use for scoring. Cells that are outside the 
chosen tissue category are ignored.  

Scoring Type 
A Histogram scoring type that is used to assess the intensity of each label. 
Five histogram scoring types are available. See Scoring Types for a 
description of the Histogram scoring types.  

Compartment 

Select the compartment to score. You can select Nuclei, Cytoplasm, or 
Membrane. Optionally, you can score the nuclei, and then score the 
cytoplasm and the membrane together, or score the cytoplasm and the 
membrane separately. The scoring data results from the binning of a 
histogram of all pixels within the selected compartment. 

Marker Settings: Some Scoring Types have only a single marker while others have multiple 
markers. Regardless, all markers have the same three options detailed below. 

Component Select the component to use for calculating the scoring data. 

Threshold Max 

Click Auto to calculate the value for the Threshold Max for the selected 
component. The Threshold Max specifies the maximum value allowed for 
the Threshold Slider. If necessary, use the slider to adjust the value 
(increase or decrease). For OD converted images, the maximum possible 
value is 3.0. 

Positivity 
Threshold 

The Positivity Threshold specifies the threshold values for the Scoring 
Type. You can drag the slider, manually enter a value in the Positivity 
Threshold field, or click the Up/Down arrows to set the values. See Scoring 
Types for a description of each threshold. 

Score Results (Percent) 

Show Score 
Colors 

If you select Show Score Colors, then the score colors are shown on the 
image and around the Negativity/Positivity values. For an example with 
the negativity value is outlined in blue and positivity value is outlined in 
red, see Figure 15.1. 

Change Color 
Click Change Color to open the Change Color dialog box, and then select 
the colors for each Histogram bin or restore the default colors for the 
bins. 

Histogram 
Score results 

Different score results are displayed depending on the selected Scoring 
Type. 
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15.1. SCORING TYPES 

Five histogram scoring types are available for scoring IHC or IF images: Positivity, Double 

Positivity (2x2 bin), D 0-3 + (4-bin), Ten-bin, and Fifty-bin. 

15.1.1. Positivity 

The Positivity Scoring Type divides the spectrally unmixed nuclear signals, cytoplasm signals, 

or membrane signals into two bins, negative and positive, with a single threshold. The data is 

provided in percentages. If you decrease the Positivity Threshold, then the percent positivity 

increases. The Histogram Score results that are displayed at the bottom of the IHC and IF 

Settings panel show the negativity and positivity percentages of the cell nuclei, cytoplasm, or 

membrane. (See Figure 15.2.) 

 

FIGURE 15.2. Score IHC or IF Settings panel, Positivity Scoring Type. 

15.1.2. Double Positivity (2 x 2 bin) 

Select the Double Positivity (2 x 2) bin to classify cells, according to co-expression, into four 

classes: double negative, single positive for one marker, single positive for another marker, or 

double positive. (See Figure 15.3.) 
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FIGURE 15.3. Score IHC or IF Settings panel, Double Positivity (2 x 2 bin) Scoring Type. 

Double Positivity contains the same options as Positivity as well as the addition of Second 

Marker settings. Just as you did with the First Marker settings, you must select the 

Compartment, Component, Threshold Max, and Positivity Threshold settings for the Second 

Marker. 

• For the First Marker, the Single Positive 1 color indicates the positive regions. The 

Double Negative color indicates the negative regions. 

• For the Second Marker, the Single Positive 2 color indicates the positive regions. The 

Double Negative color indicates the negative regions. 

• The Double Positive color indicates the double positive (First Marker + Second Marker) 

regions. 
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15.1.3. D 0-3 + (4-bin) 

The 0-3 + (4-bin) Scoring Type divides the spectrally unmixed signals in nuclei, membrane, or 

cytoplasm into four bins. Select this Scoring Type to calculate H scores with nuclear stains. 

 

FIGURE 15.4. Score IHC or IF Settings panel, 0-3 + (4-bin) Scoring Type. 

• 0/1+ Threshold: Cellular objects that fall below the 0/1 threshold are placed in the 0 bin. 

• 1+/2+ Threshold: Cellular objects that are above the 0/1+ threshold but fall below the 

1+/2+ threshold are placed in the 1+ bin. 

• 2+/3+ Threshold: Cellular objects that are above the 1+/2+ threshold but fall below the 

2+/3+ threshold are placed in the 2+ bin. Cellular objects that are above the 2+/3+ bin 

are placed in the 3+ bin. 

The Histogram Score results show the percentage positivity of the cell nuclei, membrane, or 

cytoplasm within each bin. The H-score is calculated using the percentages that are found in 

each bin. The H-Score ranges from a value of 0 to 300. (See Figure 15.4.) 
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15.1.4. Ten-bin 

The Ten-bin Scoring Type divides the data into ten bins for more quantitative work. The 10th 

Bin Nominal Level slider specifies the lower threshold for the ninth bin lower. The other eight 

thresholds are equally spaced between zero and the ninth threshold. The Histogram Score 

results boxes display the percentages of pixels that fall into each bin as determined by the 

position of the 10h Bin Nominal Lever slider. (See Figure. 15.5.) 

 

FIGURE 15.5. Score IHC or IF Settings panel, Ten-bin Scoring Type. 

15.1.5. Fifty-bin 

The Fifty-bin Scoring Type divides the signals into 50 equal bins. The 50th Bin Nominal Level 

slider specifies the lower threshold for the 50th bin. The remaining thresholds are equally 

spaced between 0 and the 50th bin threshold. For the Histogram Score results, display, the 50 

values are summed into 10 values, with each value being the sum of 5 bins. The actual values 

for all 50 individual bins are displayed in the Score table. (See Figure 15.6.) 
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FIGURE 15.6. Score IHC or IF Settings panel, Fifty-bin Scoring Type. 
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CHAPTER 16. COUNTING OBJECTS 

The Count Object function locates individual, irregularly shaped objects within an image field 

or, if the tissue has been segmented, within a selected tissue category. 

To count objects: 

1. On the Step bar, click the Counting Objects button. 

 

The Object Counting Settings panel opens on the Manual Analysis tab. The Tissue 

Category option is displayed in the panel only if the tissue has been manually or 

automatically segmented. (See Figure 16.1.) 

 

FIGURE 16.1. Object Counting Settings panel. 
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2. Optionally, to exclude any objects that are touching the edge of the image, process 

region, or tissue region, select Discard Object If Touching an Edge. 

3. If the tissue has been segmented, then select the category of tissue in which to find the 

objects. (Objects that are found outside the selected tissue category are ignored.) 

4. Select the approach to use to identify objects: Object-Based or Pixel-Based (Threshold). 

a. Select Object-Based if the stain does not provide consistent and specific staining of 

objects, and more advanced morphometry-based approaches are required. 

b. Select Pixel-Based (Threshold) if the stain is reliable or consistent and object pixels 

can be found by applying a simple threshold. (As the name implies, this approach is 

purely pixel-based.) 

5. Select the signal scaling method. 

a. Auto Scale: The Auto Scale method automatically scales each component plane 

individually before carrying out segmentation. 

b. Fixed Scale: The Fixed Scale method provides for better segmentation performance 

if the stain signals are reliable and consistent. 

6. On the Primary component drop-down list, select the primary component for object 

segmentation. 

7. Adjust the value Minimum Signal value for the primary component as appropriate. 

8. Optionally, do any or all of the following: 

a. Select Secondary and Tertiary components, and then set the appropriate minimum 

signal values. 

b. To exclude objects that are smaller than a specified number of pixels, increase the 

value for the Minimum Size (pixels) option. (The default value is one.) 
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c. By default, Fill Holes is selected, which results in all holes in all objects being 

automatically filled, regardless of the size of the hole. To limit the size of holes in 

objects that are automatically filled, leave Fill Holes selected and then select Max. 

Hole Size (pixels) and specify the size of the largest holes that are to be filled. If you 

clear Fill Holes, then no holes of any size in object are filled. 

d. To detect objects that touch other objects as individual objects, instead of as one 

single object, select Refine Splitting.  

NOTE: This option is enabled only if Max. Hole Size (pixels) is selected and a 

legitimate value provided. 

e. To exclude objects based on the roundness of the object, select Roundness, and 

then specify the value for Minimum Circularity. The allowed value ranges from 0-1, 

inclusive, with 0 returning any object shape and the maximum value of 1 restricting 

object selection to only the most round objects identified. 

9. After processing is complete, use the View Editor to view the resulting Count data 

table. You can also advance to the Export step and export the Count data table. 
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CHAPTER 17. DISPLAYING EXTRACTED DATA 

Section Page 

17.1. Viewing the Color Image 141 

17.2. Viewing the Component Image 142 

17.3. Viewing the Composite Image 146 

17.4. Viewing Data Tables 149 

17.5. Viewing the Tissue Segmentation Table 149 

17.6. Viewing the Cell Segmentation Table 151 

17.7. Viewing the Score Data Table 155 

17.8. Viewing the Colocalization Data Table 157 

17.9. Viewing the Count Data Table 159 

17.10. Viewing the Quant Data Table 161 

17.11. Image Options 163 

17.12. Component Stats 167 

17.13. TMA Core Info 167 

17.14. Slide Info 168 

17.15. Position Stats 168 

17.16. Shape Stats 169 

After you analyze your project images, you can use the options in the View Editor to 

customize the view of the images and extracted data. (See Chapter 3.1. View Editor.) The 

options that are available in the View Editor do not change the underlying images, they only 

change how the images are displayed.  

NOTE: This chapter discusses all the options that are available in the Data Displayed 

list. The options that are available to you depend on the software configuration that is 

installed and which steps you included in your project. 
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17.1. VIEWING THE COLOR IMAGE 

Selected option: Color Image. (See Figure 17.1.)  

  

FIGURE 17.1. View Editor with Color Image options. 
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TABLE 17.1. Rendering Options for Color Image and descriptions 

Option Description 

Rendering Options 

Brightness Manually enter a value to change the brightness of the image. Use the 
Brightness Percentage slider to change (lighten or darken) the image.  

Contrast 
Manually enter a value to change the contract between the light and 
dark portions of the image. Use the Contrast Percentage slider to 
change (increase or decrease) the contrast. 

Use Enhanced 
Contrast 

Select this option to artificially increase the vividness of the image. 

Use Equal RGB 
Color Weighting 

Applicable only for fluorescence images. Select to distribute the 
wavelength range equally among the red, green, and blue components. 
If this option is not selected, then image is displayed at is it looks to the 
human eye. 

Reset to Default Click to reset the image Rendering Options to their default values. 

Image Options: See Chapter 17.11. Image Options. 

 

17.2. VIEWING THE COMPONENT IMAGE 

Selected option: Component: < >, where < > is a specific component such as Her2: Fast Red. 

(See Figure 17.2.) 
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FIGURE 17.2. View Editor with Component Image options. 

TABLE 17.2. Rendering Options for Component Image and descriptions 

Option Description 

Rendering Options 

Show As:  

Brightfield 

Select to display the component as if it were conventionally stained 
along with a counterstain. Stains are displayed as DAB, 
autofluorescence is displayed as eosin, and DAPI is displayed as 
hematoxylin. This option is available when inForm can identify a 
hematoxylin or DAPI counterstain. If no counterstain is apparent, then 
inForm displays the component signal only 

Fluorescence Select to display only the component signal on a black background. 

Component Color: Applicable when a component is shown without its counterstain. Select 
an option to display the color for the component. 

Black and White  
Select to show the component as a white signal against a black 
background. 
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Option Description 

Color 
Select to show the component in color. This color is calculated from the 
spectral shape of the component, which is the color you would see 
when viewed through a microscope. 

Scaling 

Scale Views for 
Each Image 
Individually 

Select to show each image scaled individually. Dim images are 
brightened to show the components. The relative brightness of 
components cannot be compared between images. 

Scale Views for All 
Images in the 
Project 

Select to show the brightness of components for each image all scaled 
relative to each other. Bright components appear bright and dim 
components appear dim. All images are rescaled relative to all images 
in the project whenever images are removed from or added to the 
project. 

Scale Views 
Based on 
Selected Images 

Select to show the brightness of components for each image based on 
the brightness range of the selected images. Bright components 
appear bright and dim components appear dim. The first time the 
option is selected, all current images in the project are selected. The 
scaling limits remain the same even if images are added to or removed 
from the project.  
 
NOTE: If this option is selected and changes are made to the 
selected Spectra for Unmixing or to the Reported Units in the 
Prepare Images step, then the image scaling is reset to the default 
value of Scale Views Equally for All Images in the Project. 

Reset Click open the Scaling Image Selection Window to change the images. 
See Scaling Based on Selected Images for the suggested workflow. 

Adjust 

Brightness 
Manually enter a value to change the brightness of the image. Use the 
Brightness Percentage slider to change (lighten or darken) the image.  

Contrast 
Manually enter a value to change the contract between the light and 
dark portions of the image. Use the Contrast Percentage slider to 
change (increase or decrease) the contrast. 

Reset to Default Click to reset the image Rendering Options to their default values. 

Image Options See Image Options. 

Scaling Based on Selected Images 

You should use images with bright signals in each component, such as positive controls or 

positively expressing images, to scale all the images that are in a project. When Scale Views 
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Equally for All Images or Scale Views Based on Selected Images is selected, then the scaling 

limits are saved with the algorithm and the project. If the algorithm or project is used in Batch 

mode, then all images that are process in the batch job use the same saved scaling limits. 

1. Load only the images of the positive controls. 

2. Process the images as preferred. 

3. Open the View Editor, and then select any component in the Data Displayed drop-

down list. 

4. Select Scale Views Based on Selected Images. 

The scaling limits are set based on the positive control images that are open in the 

project. 

5. Save the algorithm and/or the project. 

6. Load the algorithm or project in the Batch tab to use the batch processing settings. 

7. If the positive controls change, then open the project, and then on the View Editor, 

click Reset.  

8. To set the new scaling limits, select the new positive controls in the Scaling Image 

Selection Window. 

Scaling Image Selection Window 

Use the Scaling Image Selection Window to select the images that are to be used to scale the 

brightness of all images in the project. (See Figure 17.3.) The images that are brightest in at 

least one component are at the top of the list and are selected by default. Images must be 

unmixed to be used for the scaling calculations. If an image is not unmixed, it is displayed at 

the bottom of the list and Select for Scaling is not selected. 
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FIGURE 17.3. Scaling Image Selection window. 

• Select for Scaling: The scaling limits are calculated using all selected images. These 

scaling limits are saved and used when processing images in Batch mode. 

• The Thumbnails and Image Names identify the project images. The Image Name also 

identifies the brightest image for each component. 

• Cancel: Click to close the Scaling Image Selection window without re-calculating any 

image scaling limits. The original limits remain unchanged. 

• Done: Click to re-calculate the image scaling limits using the selected images, and 

then closes the Scaling Image Selection window. 

17.3. VIEWING THE COMPOSITE IMAGE 

Selected option: Composite. (See Figure 17.4.) 
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FIGURE 17.4. View Editor with Composite Image options. 

 

TABLE 17.3. Rendering Options for Composite Image and descriptions 

Option Description 

Rendering Options 

Show As:  

Brightfield 

Select to display the composite image as if it were conventionally 
stained along with a counterstain. Stains are displayed as DAB, 
autofluorescence is displayed as eosin, and DAPI is displayed as 
hematoxylin. This option is available when inForm can identify a 
hematoxylin or DAPI counterstain. If no counterstain is apparent, then 
inForm displays the component signal only 

Fluorescence 
Select to display only the composite image signal on a black 
background. 
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Option Description 

Scaling 

Scale Views for 
Each Image 
Individually 

Select to show each image scaled individually. Dim images are 
brightened to show the components. The relative brightness of 
components cannot be compared between images. 

Scale Views for All 
Images in the 
Project 

Select to show the brightness of components for each image all scaled 
relative to each other. Bright components appear bright and dim 
components appear dim. All images are rescaled relative to all images 
in the project whenever images are removed from or added to the 
project. 

Scale Views 
Based on 
Selected Images 

Select to show the brightness of components for each image based on 
the brightness range of the selected images. Bright components 
appear bright and dim components appear dim. The first time the 
option is selected, all current images in the project are selected. The 
scaling limits remain the same even if images are added to or removed 
from the project.  
 
NOTE: If this option is selected and changes are made to the 
selected Spectra for Unmixing or to the Reported Units in the 
Prepare Images step, then the image scaling is reset to the default 
value of Scale Views Equally for All Images in the Project. 

Reset Click open the Scaling Image Selection Window to change the images. 
See Scaling Based on Selected Images for the suggested workflow. 

Component Display: The following options are displayed for all selected components.  

Display Intensity: 

True 
Select to display each component in the composite image at the 
original intensity. For example, if Component A is dimmer than 
Component B, then are displayed this way in the composite. 

Adjustable 
Select to display each component in the composite image at the 
intensity that selected on the associated Intensity slider. (The Intensity 
slider for is displayed only when Adjustable is selected.) 

Display Color: 

True Color Select to display each selected component in the calculated color from 
the spectral shape of the component. 

False Color 

Select to display each component in the False color that is shown in the 
Color field for the component. (You can click the Color field for a 
component and open a drop-down list of colors and pick a different 
color.) The False Color field is displayed for a components only when 
False Color is selected. 
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Option Description 

Reset to Default Click to reset the image Rendering Options to their default values. 

Image Options See Image Options. 

 

17.4. VIEWING DATA TABLES 

The project steps determine the data tables that are available for viewing. To view a data table, 

select the table in the Data Displayed drop-down list. Note the following caveats about 

viewing a data table: 

• If you change the selections in the View Editor, then the data that is displayed in the 

selected data table is immediately updated to reflect the selections.  

• To sort the data in the data table, click a column header. The arrow that is displayed in 

the column header indicates the sort order of the data: Up indicates that the table data 

is sorted in ascending order based on the data in the selected column while Down 

indicates that the table data is sorted in descending order based on the data in the 

selected column. 

• Summary rows are always displayed at the top of the table and remain displayed at the 

top of the table even if you change the sort order of the data. 

17.5. VIEWING THE TISSUE SEGMENTATION DATA TABLE 

Selected option: Tissue Segmentation Data. (See Figure 17.5.) 
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FIGURE 17.5. View Editor with Tissue Segmentation Data options. 

The Tissue Segmentation Data Table is available when an algorithm contains a manual tissue 

segmentation or trainable tissue segmentation step. The data table provides information on 

the manually or automatically segmented tissue regions. 

NOTE: During image analysis, segmented tissue categories are assigned ID numbers. 

These numbers are used in the data tables to identify the tissue category for statistics 

such as area (pixels), area (percent), and so on. 

 

TABLE 17.4. Rendering Options for Tissue Segmentation Data Table and descriptions 

Option Description 

Table Contents 

Components  

• All Components 
• < > Individual 

components such 
as DAPI 

Select All components or individual components for which to 
display the component statistics. Each selected component creates 
one column for each component statistic that is selected. If there is 
no data for component, then the component is not displayed in the 
list of available components. 
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Option Description 

Tissue Categories  

• All Categories 
• < > Individual 

categories such as 
Tumor 

Select All categories or individual categories for which to display the 
data. An entry row is created for each Region ID that is in the tissue 
category. 

Component Stats 
Select the values to display for each component signal. See Chapter 
17.6. Component Stats for a description of each option. 

Position Stats Select which values to display for each segmented object. See 
Chapter 17.9. Position Stats a description of each option. 

TMA Core Info 
Select the options to include in the data table. See Chapter 17.7. 
TMA Core Info for a description of each option. 

Shape Stats Select the options to include in the data table. See Chapter 17.10. 
Shape Stats for a description of each option. 

Coordinate Units 

Select the unit of measure for the data table statistics: microns or 
pixels. 
 
NOTE: This option is available only for images taken with 
Mantra or PhenoImager HT. 

 

17.6. VIEWING THE CELL SEGMENTATION DATA TABLE 

Selected option: Cell Segmentation Data. (See Figure 17.6.) 
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FIGURE 17.6. View Editor with Cell Segmentation Data options. 

The Cell Segmentation Data Table is available when an algorithm contains a cell 

segmentation step. The data table displays statistics for only those cell compartments that 

have been segmented (nuclei, cytoplasm, membrane). For example, if cytoplasm is not 

segmented, then the Cytoplasm column is not included in the table. The Cell Segmentation 

Data table always displays the following data columns, regardless of any other options that are 

selected: 

• Cell ID: Displays a unique ID number for each cell, based on the location of the nuclei 

and if tissue has been segmented within each tissue category. 

• Total Cells: The total number of cells that were scored in the image. 

• Tissue Category Area (Pixels): If tissue has been segmented, either automatically or 

manually, then this column displays the area of the selected tissue category, measured 

in the number of pixels. If the project did not have a tissue segmenting step, then this 

column displays the total number of pixels that are in the whole image. 

• Cell Density (per megapixel):  
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o If tissue has been segmented, either automatically or manually, then this 

column displays the cell density for each tissue category, defined as: 

(The number of cells in the tissue category area) / (the number of pixels in the 

tissue category area / 1,000,000) 

o If the project did not have a tissue segmenting step, then this column displays 

the cell density for the entire image, defined as: 

(Total Cells) / (the number of pixels in the image / 1,000,000) 

• Phenotype and Confidence: If the algorithm contains a Phenotyping Cells step, then 

cell phenotypes and confidence levels are automatically added to the table. If the 

project had more than one Phenotyping Schema, then there is a Phenotype and 

Confidence column for each schema where the schema name is appended to the end 

of the column name. 

TABLE 17.5. Rendering Options for Cell Segmentation Data Table and descriptions 

Option Description 

Table Contents 

Components  

• All Components 
• < > Individual 

components such 
as DAPI 

Select All components or individual components for which to 
display the component statistics. Each selected component creates 
one column for each component statistic that is selected. If there is 
no data for component, then the component is not displayed in the 
list of available components. 

Tissue Categories  

• All Categories 
• < > Individual 

categories such 
as Tumor 

Select All categories or individual tissue categories for which to 
display data. If selected this option is selected, then a Tissue 
Category column is displayed in the Cell Segmentation table to 
specify the Tissue Category for each cell. If there is only one Tissue 
Category defined or if there is no Segment Tissue step in the project, 
then this option is not displayed. 
 
NOTE: Rarely, the tissue segmentation step does not classify 
small areas of tissue. Cells that are found within these 
unclassified areas are not reported in the data table. 
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Option Description 

Component Stats 

Select the values to display for each component signal. Each 
selection adds one column for each segmented cell component 
and one column for the entire cell. See Entire Cell Statistics for 
information about calculating the statistics for the entire cell. See 
Chapter 17.12. Component Stats for a description of each option. 

Position Stats 
Select which values to display for each segmented object. See 
Chapter 17.9. Position Stats a description of each option. 

TMA Core Info Select the options to include in the data table. See Chapter 17.7. TMA 
Core Info for a description of each option. 

Shape Stats 
Select the options to include in the data table. See Chapter 17.10. 
Shape Stats for a description of each option. 

Coordinate Units 

Select the unit of measure for the data table statistics: microns or 
pixels. 
 
NOTE: This option is available only for image that was taken 
with Mantra or PhenoImager HT. 

Entire Cell Statistics 

Statistics are calculated according to the following parameters: 

• Statistics are calculated using the segmented compartments. For example, if 

cytoplasm is not segmented, then the statistics do not include the cytoplasm 

compartment in the calculation. 

• Statistics are calculated over the entire pixel area of the cell. For example, the Min stat 

looks at all the pixels across all the available compartments in the cell. 

When calculating the mean, averaging across all pixels is equivalent to taking the weighted 

average of the compartment means, where the weight is the pixel area of the compartment. 

This can be verified in Excel: computing, where: 

Cell Mean = [(Nucleus Area * Nucleus Mean) + (Cytoplasm Area * Cytoplasm Mean) + 

(Membrane Area * Membrane Mean)]/Cell Area results in the same number as the reported 

Cell Mean. 
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17.7. VIEWING THE SCORE DATA TABLE 

Selected option: Score Data. (See Figure 17.7.) 

 

FIGURE 17.7. View Editor with Score Data options. 

The Score Data Table is available when an algorithm contains a Score step. The selected 

scoring type determines the data that is available for inclusion in the table. The Score Data 

table always displays the following data columns, regardless of any other options that are 

selected: 

• Tissue Category: If tissue has been segmented, either automatically or manually, then 

this column displays the tissue category that was used for scoring. If the project did not 

have a tissue segmenting step, then this column is blank. 

• Tissue Category Area (Percent): If tissue has been segmented, either automatically or 

manually, then this column displays the area of the selected tissue category. If the 

project did not have a tissue segmenting step, then this column displays 100% (the 

whole image). 

• Number of Cells: The number of cells that were scored in the image. 

• (First) Cell Compartment: The cell compartment that was used in scoring. 



USER GUIDE | inForm 

 

AKOYABIO.COM 156  

• (First) Stain Compartment: The stain that was used to create the threshold for 

scoring. 

For other data table contents and a description of each option, see Chapter 17.13. TMA Core 

Info. 

If Double Positivity (2 x 2) scoring is selected, then the Score Data table also displays the 

following data columns: 

• Second Cell Compartment: The secondary cell compartment that was used for 

scoring. 

• Second Stain Component: The secondary stain that was used to create the threshold 

for scoring. 

• Double Negative: The percent of cells that are negative (less than the threshold) for 

both components. 

• Single <Component1>: The percent of cells that are positive for component 1 and 

negative for component 2. 

• Single <Component2>: The percent of cells that are positive for component 2 and 

negative for component 1. 

• Double Positive: The percent of cells that are positive for both markers. 

• <Component1> Threshold: The threshold that was used for component 1. 

• <Component2> Threshold: The threshold that was used for component 2. 

If 0-3+ (4-bin) scoring is selected, then the Score Data table also displays the following data 

columns: 

• 0+: The percentage of cells whose component strength is less than the first threshold. 

• 1+: The percentage of cells whose component strength is greater than or equal to the 

0/1+ threshold and less than the 1/2+ threshold. 

• 2+: The percentage of cells whose component strength is greater than or equal to the 

1/2+ threshold and less than the 2/3+ threshold. 
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• 3+: The percentage of cells whose component strength is greater than or equal to the 

2/3+ threshold. 

• H-score: The calculated H-Score of the image. The H-Score is calculated using the 

percentages in each bin and ranges from 0 to 300. 

• Threshold 0/1+: Click Auto to set this value to 1/4 of the Threshold max. You can change 

this value. 

• Threshold 1+/2+: Click Auto to set this value to 1/2 of the Threshold max. You can 

change this value. 

• Threshold 2+/3+: Click Auto to set this value to 3/4 of the Threshold max. You can 

change this value. 

If 10-bin or 50 bin scoring is selected, then the Score Data table also displays the following data 

column: 

• Bin X (where X ranges from 1-10 or 1-50 per scoring type): These columns show the 

percent of scored values that fall in each scoring bin. You set the lower threshold for 

the last bin. The last bin is the percent of cells whose component strength is greater 

than the threshold that you set. The thresholds for the remaining bins are spaced 

evenly from 0. For example, the 49th bin has a lower limit of (48 * threshold) / 49. 

17.8. VIEWING THE COLOCALIZATION DATA TABLE 

Selected option: Colocalization Data. (See Figure 17.8.) 
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FIGURE 17.8. View Editor with Colocalization Data options. 

The Colocalization Data tables are available when an algorithm contains a Colocalization step.  

TABLE 17.6. Rendering Options for Colocalization Data Table and options 

Option Description 

Colocalization Table: Shows how much the numerator components are colocalized with 
the denominator. 

Percent Stats 
Shows the percent colocalization, where all colocalization pixels 
are positive within the selected denominator, and the percent 
positivity of each selected component in colocalization. 

Pixel Stats Shows the actual pixel count for the colocalization, component 
positivities, and selected denominator. 

In Channel Table: Shows the positivity of one component within another for all selected 
colocalization components. 

Percent Stats Shows the percentage of inter-component positivity. 

Pixel Stats Shows the pixel count of the component positivity. 

Quant Table: Shows the statistics for the whole image and the colocalization region. 

Components 



USER GUIDE | inForm 

 

AKOYABIO.COM 159  

Option Description 

• All Components 
• < > Individual 

components such as 
DAPI 

Select All components or individual components for which to 
display the component statistics. One column per numerator 
component is displayed. 

Component Stats Select the values to display for each component signal. See 
Chapter 17.12. Component Stats for a description of each option. 

Position Stats Select which values to display for each segmented object. See 
Chapter 17.9. Position Stats a description of each option. 

TMA Core Info Select the options to include in the data table. See Chapter 17.7. 
TMA Core Info for a description of each option. 

Shape Stats Select the options to include in the data table. See Chapter 17.10. 
Shape Stats for a description of each option. 

Coordinate Units 

Select the unit of measure for the data table statistics: microns 
or pixels. 
 
NOTE: This option is available only for image that was taken 
with Mantra or PhenoImager HT.  

 

17.9. VIEWING THE COUNT DATA TABLE 

Selected option: Count Data. (See Figure 17.9.) 
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FIGURE 17.9. View Editor with Count Data options. 

The Quant Data Table is available when an algorithm contains either a Threshold step or a 

Colocalization step. 

TABLE 17.7. Options for Count Data Table and descriptions 

Option Description 

Components  

• All Components 
• < > Individual 

components such 
as DAPI 

Select All components or individual components for which to 
display the component statistics. Each selected component creates 
one column for each component statistic that is selected. If there is 
no data for component, then the component is not displayed in the 
list of available components. 

Component Stats 

Select the values to display for each component signal. Each 
selection adds one column for each segmented cell component 
and one column for the entire cell. See Entire Cell Statistics for 
information about calculating the statistics for the entire cell. See 
Chapter 17.12. Component Stats for a description of each option. 
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Option Description 

Position Stats Select which values to display for each segmented object. See 
Chapter 17.9. Position Stats a description of each option. 

TMA Core Info Select the options to include in the data table. See Chapter 17.7. TMA 
Core Info for a description of each option. 

Shape Stats Select the options to include in the data table. See Chapter 17.16. 
Shape Stats for a description of each option. 

Coordinate Units 

Select the unit of measure for the data table statistics: microns or 
pixels. 
 
NOTE: This option is available only for image that was taken 
with Mantra or PhenoImager HT. 

 

17.10. VIEWING THE QUANT DATA TABLE 

The Quant Data Table is available when an algorithm contains a Threshold or Colocalization 

step. Select Quant Data in the Data Displayed list, then choose the desired options under 

Table Contents. Each option you select adds one or more data columns or rows to the table. 
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The following options are available for the Quant Data Table: 

• Components: Select all or individual components to display component statistics. 

Each selected component creates one column for each component stat selected. 

• Component Stats: Select the values to display for each component signal. See 

Component Stats for descriptions of each option. 

• TMA Core Info: Select the options to include in the data table. See TMA Core Info. 

• Position Stats: Select which values to display for each segmented object. See Position 

Stats. 

• Shape Stats: Select the options to include in the data table. See Shape Stats. 

• Coordinate Units: Select the unit of measure for your table statistics, microns, or pixels. 

This option is only available for imagery taken with Mantra, the legacy Vectra 3 system, 

and the PhenoImager HT. 
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17.11. IMAGE OPTIONS 

When you select an image on the Data Displayed drop-down list on the Image Editor, the 

following image options are available. (These same options are also displayed as buttons on 

the left side of the image display area.)  

TABLE 17.8. Image Options and descriptions 

Option Description 

Tissue 
Segmentation 
Map 

Select this option to display the Tissue Segmentation map on the 
image. This option is available only for projects that include a Manual 
Classification step or a Tissue Segmentation step. 

Nuclear 
Segmentation 
Map 

Select this option to display the Nuclear Segmentation map on the 
image. This option is available only for projects that include a Segment 
Cells step. 

Cytoplasm 
Segmentation 
Map 

Select this option to display the Cytoplasm Segmentation map on the 
image. This option is available only for projects that include a Segment 
Cells step. 

Membrane 
Segmentation 
Map 

Select this option to display the Membrane Segmentation map on the 
image. This option is available only for projects that include a Segment 
Cells step. 

Show Score 
Colors 

Select this option to display the Score Colors map on the image. This 
option is also accessible from the Score Settings panel, and it is available 
only for projects that include a Score IHC step or Score IF step. . 

Object 
Segmentation 
Map 

Select this option to display the Object Segmentation map on the 
image. This option is available only for projects that include a Count 
Objects step. 

Training Regions Select this option to display the Training regions on the image. This 
option is available only for projects that include a Segment Tissue step. 

Processing 
Regions Select this option to display the Processing regions on the image. 

Equalize Display 
Histogram 

Select to this option to map the pixels so that the image histogram has 
approximately the same number of pixels assigned to each tonal value 
of the histogram. This gives the best display of the whole dynamic range 
of dim and bright signals. If this option is not selected, then the lowest 
0.01% of the pixels are mapped to 0, the highest 0.01% are mapped to 
255, and the remaining pixels are linearly interpolated between those 
values, all of which prevents a few bright or saturated pixels from 
skewing the display. This option is accessible only from the Image 
Editor. 
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Shortcuts are also available for the image views (Color, Component, and Composite) as 

buttons on the image toolbar. (See Figure 17.10.) To toggle across the displays, click the 

buttons as appropriate. 

 

FIGURE 17.10. Image View shortcut buttons (from left to right, Color, Component and 
Composite). 

Simulated Brightfield Views (Pathology Views) 

When you are viewing fluorescence imagery, you use the Component button to display the 

image components in a simulated brightfield mode, which is referred to as Pathology Views. 

Pathology Views renders fluorescence images in a manner that is familiar to anyone who is 

trained in histopathology, displaying the images as simulated H&E images or as simulated 

DAB/Hematoxylin images. The image components are displayed as if you were looking at 

serial sections that are single-stained. However, the difference is that Pathology Views displays 

multiplexed stains on a single tissue section with high contrast and perfect registration. 

• Simulated DAB/Hematoxylin: Individual components are displayed as a simulated 

DAB stain with a simulated Hematoxylin counterstain (from the DAPI signal) against a 

white background. 

To toggle among the different image components: 

1. Click the Component button. 

A drop-down list of all the available image components opens. (See Figure 17.11.) 

2. Select the component that is to be displayed. 

The legend shows the currently selected component. 
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FIGURE 17.11. Component button. 

Tip: You can also use the Up and Down arrows on your keyboard to move through the 

image components. 

Composite Views 

Although you can open an image in inForm that contains up to 50 components, it can display 

only 10 channels at time. When you first open an image in inForm, it opens in the Standard 

View, which is the default composite view. This view shows the first 10 components that were 

designated in the scan protocol. You can use the Composite button to add new Composite 

views, editing existing Composite views, and select which components to display per 

Composite view. (See Figure 17.12.) After you have added or edited existing Composite views, 

you can then select any of these views for viewing the project images. You can save a view as 

part of a project or algorithm. 

 
FIGURE 17.12. Composite button. 

NOTE: inForm cannot open views that were created using the Phenochart software. To 

open such an image in inForm, you must use inForm to create a new image. 
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To use the Composite Editor: 

1. Click the Composite button, and then on the drop-down list that opens, click Edit. 

The Composite Views dialog box opens. (See Figure 17.13.) 

 

FIGURE 17.13. Composite Views dialog box. 

2. Do any of the following as appropriate for adding, editing, and maintaining your 

Composite views, including the Standard view: 

a. To change the name of a Composite view, select the view, and then click Rename. 

b. To change the components that are displayed for a view, select the view, and then 

select or clear the Available Components as appropriate.  

c. To change the color for a view component, select the view, select the component, 

and then click the current preset color to open a drop-down list from which you 

can select another preset color, or click Custom to create a custom color. 

d. To add a new Composite view, click Add, and then name the view and add the view 

components as prompted. You can add an unlimited number of Composite views. 

(See Figure 17.14.) 
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e. To change the order in which the views are displayed in the Composite views drop-

down list (the list that is displayed after you click the Composite button), select a 

view, and then click Up or Down as appropriate. 

f. To delete a view, select the view, and then click Remove. 

 
FIGURE 17.14. Example of available options from the Composite button after 

adding/renaming views. 

17.12. COMPONENTS STATS 

The following options are available for Component Stats: 

• Min: If this option is selected, then one column that contains the minimum value of the 

component in each region is displayed in a data table. For the Cell Segmentation data 

table, one column for each cell compartment that was segmented is displayed, and 

one column for the entire cell is displayed. 

• Mean: If this option is selected, then the mean of the component in the region is 

displayed in a data table. The Summary line displays the weighted mean value of the 

component across all regions, which is the average of the region means, weighted by 

region size. 

• Max: If this option is selected, then the maximum value of the component that is in the 

region is displayed in a data table. 

• Std Dev: If this option is selected, then the sum of the value of the component across 

all the pixels in the region is displayed in a data table. 

17.13. TMA CORE INFO 

The following option is available for TMA Core Info: 
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• Show Core ID:  If the image is of a core on a TMA slide that was scanned with an Akoya 

scanner, then the Sector, Row, Column and Field of the core are displayed. If there is no 

core information, then a zero (0) is displayed in each of these table columns. 

17.14. SLIDE INFO 

Exported data tables contain the Lab ID, the Slide ID, and the Field ID for the appropriate data 

formats. These fields are displayed in the image name rather than in the data tables in an 

inForm project. 

17.15. POSITION STATS 

The following options are available for Position Stats: 

• X Position and Y Position: If this option is selected, then the X and Y locations of the 

center of the bounding box for the region are displayed. 

• Process Region ID: If process regions are defined for the image and this option is 

selected, then the ID number of the process region that contains the tissue category is 

displayed in a data table. If an object spans multiple regions, then #N/A is displayed 

instead. 

• Distance from Process Region Edge (Pixels): If this option is selected, then the 

distance, in pixels, from the center of this region's bounding box to the nearest edge of 

the containing process region is displayed in a data table. If the distance cannot be 

determined, then #N/A is displayed instead. 

• Category Region ID: If tissue is segmented and this option is selected, then the 

Region ID of the tissue category that contains the segmented object is displayed in a 

data table. This option is available only in the Cell Segmentation and Count Data Tables 

and only if tissue has been segmented. 

• Distance from Tissue Category Edge (Pixels): If this option is selected, then the 

distance, in pixels, from the segmented object to the nearest edge of the tissue 

category is displayed in a data table. If the distance is reported as #N/A, then this 

indicates that the distance is unknown or indeterminate, for example if a cell is in a 
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tissue region that abuts the edge of the image. The cell might be closer to the edge of 

the image than to any other region in the image, so it cannot be determined whether 

the distance to an in-image point would be nearer than a point that lies beyond the 

edge of the image. This option is available only in the Cell Segmentation and Count 

Data Tables and only if tissue has been segmented. 

17.16. SHAPE STATS 

The following options are available for Shape Stats: 

• Area (pixels): If this option is selected, then the size, in pixels, of the region is displayed 

in a data table. 

• Area (percent): If this option is selected, then the region size as a percent of the total 

processed area is displayed in a data table. If there are no processing regions, then the 

total image area is displayed instead. Otherwise, the total area of the processing 

regions is displayed. 

• Compactness: If this option is selected, then the compactness of the region is 

displayed in a data table, where the Compactness is defined as the ratio of the area of 

the region to the area of a circle (the most compact shape) that has the same 

perimeter. A circle has a compactness of 1. Objects that are elongated or irregular are 

less compact, as are objects with irregular or reticulated edges. 

• Minor Axis: If this option is selected, then the smaller of the two axes of the minimum 

area bounding box that encloses the region is displayed in a data table. 

• Major Axis: If this option is selected, then the larger of the two axes of the minimum 

area bounding box that enclosed the region is displayed in a data table. 

• Axis Ratio: If this option is selected, then the ratio of the major axis/minor axis of the 

minimum area bounding box that encloses the region is displayed in a data table. 
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CHAPTER 18. EXPORTING DATA 

After analyzing the images, use the Export step to export images, component images, maps, 

and data tables. Images are exported in the format selected in the Export Settings step. Data 

tables are exported to tab-separated text files, which can be opened in Microsoft® Excel® and 

many other data analysis programs.  

1. Click the Export button to display the Export Settings panel. (See Figure 18.1.) 

2. Click the Browse button to select or create the desired Export Directory. 

3. Select the Image Output Format you want to export images to, either JPEG or TIFF. 

(Generally, TIFFs retain more resolution and are usually larger. JPEGs are compressed 

slightly and are often better for emailing and publishing on the web.) Outputs 

containing multiple image layers will be exported as TIFFs even if you select JPEG. The 

outputs that may contain multiple layers are labeled as “multi-image TIFF”. 

4. From the Images to Export list, select the images and maps to export. Images can be 

exported with or without the maps. Exporting the images with maps can be used with 

Review/Merge to view the segmentation for all images in a batch. 

a. The background for the Composite with Tissue Segmentation Map, Composite with 

Cell Segmentation Map, Composite with Scoring Map, and Composite with All 

Segmentation Maps images will be the most recently viewed Composite View.   

b. The Phenotype Map and Composite with Phenotype Map are color images with 

one dot representing each phenotyped cell. These images will have a separate layer 

for each Phenotype Schema. The Composite with Phenotype Map image will 

include the Associated View for each schema as a background image. (See 

Appendix F. Composite Image and Phenotype Map TIFF Specification.) 
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FIGURE 18.1. Export Settings. 

5. Select Pathology Views to export the components as a set of single stain + hematoxylin 

counterstain brightfield images. 

6. Select the Component Images (multi-image TIFF) option to save a multi-image TIFF 

file of component data for analysis using third party analysis software. The values in the 

Component images are in the units selected in the Prepare Images step. (See 

Appendix D. Akoya Biosciences TIFF File Specification.) 

7. The Tissue, Cell, and Object maps are exported in a single, multi-image TIFF file. If there 

were processing regions or regions of disinterest, a processing map is also included. 

Select Segmentation Maps to export one or more of these items. These images are 

designed to be used by image processing tools. (See Appendix E. Segmentation Map 

TIFF Specification.) 
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NOTE: In Adaptive Cell Segmentation, each membrane object is assigned to a specific 

cell, and its label will match the corresponding nuclear label.  In all other cell 

segmentation implementations, membrane is a shared boundary, and the image will 

only contain a binary map of membrane presence. 

8. Select the desired Tables to Export. The tables available for export depend on which 

steps are included in the algorithm or project. Data tables are exported to tab-

separated text files, which can be opened in Microsoft® Excel® and many other data 

analysis programs.  

9. In Table Fields to Export, select whether to export all available table data fields, or only 

the fields that are visible in the table view. To select which fields are visible in the table, 

use the View Editor. (See Chapter 17. Displaying the Extracted Data.) 

10. Select File Name Options: If files are already saved in the selected export directory, 

select how to name the new files. You can:  

a. Overwrite existing files if the new file names match.  

b. Rename the new exported files to preserve any existing files in the export directory.  

11. If you want to replicate the directory structure of the source images to the export 

directory, enter the number of directory levels to replicate in the Copy __ level(s) text 

box. For example, by entering "2" in this field, data in a "CancerStudy\Sample001" 

directory would be exported to the \<ExportDirectory>\CancerStudy\Sample001\ 

directory. This helps keep the exported images organized.  

12. Click Export for Selected or Export for All to export the data. 

A sample list of exported files is shown below in Figure 18.2. 
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FIGURE 18.2. Exported Data files. 
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CHAPTER 19. BATCH PROCESSING 

Batch Analysis processes a large number of images quickly and effectively, with just one click 

of the batch Run button. Before beginning batch analysis, create and test an algorithm or 

project on a set of images that is representative of the entire data set. Adjust the algorithm or 

project as necessary until the images are processed as desired and then save the algorithm or 

project.  

 

FIGURE 19.1. Batch Analysis tab. 

 
1. Click the Batch Analysis tab to configure the batch settings and select images for 

processing. You are prompted to save the open project. (See Figure 19.1.) Click Yes to 

save the open project or No to close without saving.  

2. Algorithms that contain the Manual Classification step are not compatible with batch 

processing. If the open project contains this step, the software will post a warning. 
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Open a project that does not contain steps that require user interaction, and then click 

the Batch tab. 

3. Select a Batch Algorithm or Project. When you first switch to the Batch panel, the 

Algorithm settings are copied from the active project. You can run a batch using these 

settings or click the Browse button to select an Algorithm (.ifp) or Project (.ifr) file that 

contains the desired settings. When loading a project, only the algorithm settings are 

used. The images from the project are not loaded or processed. 

4. If desired, select the Create separate directories for each item/image option to save the 

exported files in a separate folder for each of the images or slides in the data set. This is 

recommended for large batch processes that result in many data files and images. 

5. Select the desired export settings to export images, component images, maps, and 

data tables. Export settings are explained in detail in Chapter 18. Exporting the Data. 

6. Click the Add Images button to select images to process. Click the Add Slides button to 

select slides scanned by PhenoImager HT; inForm will process all acquired 

multispectral fields or inForm batch slide regions, depending on the algorithm 

selected. Annotations that have been ignored or deleted will not be processed. To load 

older slide imagery from a Mantra, legacy Vectra 3 system, PhenoImager HT, or Fusion, 

hold the control button down before clicking Add Slides. If you need to change the 

Data Directory you are looking at, select Change Browser Location… from the slide 

browser’s gear menu. 

7. If necessary, use the Remove Selected button to remove selected images or slides from 

the batch or use the Remove All button to remove all the images or slides from the 

batch. 

8. Click the Run button. inForm processes the items one at a time and exports the 

specified data. 

9. When the image processing is complete, click the Done button in the Batch Progress 

window.  
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CHAPTER 20. MERGING DATA 

Use the Review/Merge tab to combine the data of a completed batch run. Data tables from 

each field can be merged into a single file. For example, all Cell Segmentation data from a set 

of batched images can be merged into one Cell Segmentation data file. 

1. After running a batch, click the Review/Merge Tab.  

2. The Batch directory defaults to the directory of the current batch process, or the last 

directory used for batch processing. Click the Browse button to choose a different 

batch results directory. 

3. The data sets that can be merged display in the list. All data sets are selected by 

default.  

4. Review the list of data sets and select the data sets to be reviewed: 

a. Select or clear the check marks in the list to include or exclude specific data sets. 

b. Click the Include All button to select all data sets in the list. 

c. Click the Include None button to clear the check boxes for all data sets in the list. 

5. When a data set is selected in the list, thumbnails of the available exported images 

display at the bottom of the window. Click a thumbnail to view the image in the large 

image display area. 

6. Review the images and optionally reprocess the data: 

a. Use the left or right arrow buttons next to the Gallery thumbnails (or Merge hot 

keys listed towards the bottom left) to scroll through the images for each data set.  

b. If the imagery contains areas that you would like to exclude, you can draw regions 

of disinterest using the toolbar.   
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c. If you would like to limit the data to a specific area instead, you can draw 

processing regions.   

d. Once your regions are drawn, click Re-process to re-process the imagery using the 

new regions. 

7. Accept or reject each data set by clicking the Yes or No button, or by using the Merge 

hot keys. 

8. Review the images and optionally reprocess the data: When all data sets have been 

reviewed, click the Merge button. Type a file name prefix to identify the new files as the 

merged files. The merged data files are saved as tab separated text files in the batch 

directory with the specified file name prefix followed by the name of the data table. 

Data from any excluded data sets are included in the <prefix>_rejected_... files. 

The Review/Merge tab is shown below in Figure 20.1. 

 

FIGURE 20.1. Review/Merge tab. 
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CHAPTER 21. BUILDING LIBRARIES 

Section Page 

21.1. Singly Stained Tissue Sections 179 

21.2. Extracting a Stain or Fluorophore 180 

21.3. Extracting a Custom Stain or Fluorophore 181 

21.4. Extracting a Fluorophore with a Custom Filter 185 

21.5. Extracting a Stain from a Color Image 185 

21.6. Using Processing Regions 187 

 

IMPORTANT: This feature works with images taken with images taken with a Mantra, 

legacy Vectra 3 system, PhenoImager HT, or Fusion. It will not work with fluorescence 

Nuance images. 

There are 3 ways to extract the spectra from a stain or fluorophore using the Build Libraries 

tab: 

• Use a singly stained slide of a stain or fluorophore in the Stain Store. 

o Open a Digital Slide or Multispectral Field of a singly stained slide, extract and 

then select an existing stain or fluorophore in the Stain Store. 

• Use a singly stained slide of a new or custom stain or fluorophore. 

o Create a new stain or fluorophore in the Stain Store, open a Digital Slide or 

Multispectral Field of the singly stained slide, extract and then select the new 

stain or fluorophore in the Stain Store. 

• Use a color image of a stain in the Stain Store. 

o Open an RGB (color) image containing the new stain, convert the image to 

optical density (OD), extract and then select an existing stain in the Stain Store. 
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21.1. SINGLY STAINED TISSUE SECTIONS 

The most precise and repeatable way of obtaining quantitative fluorescence data from tissue 

with multiple fluorescence labels present is to measure and extract the signals from the 

individual labels in singly stained tissue sections and store them for later use. Having an 

unstained tissue section is also useful for obtaining the spectra of the autofluorescence to 

reduce or eliminate it from images of your stained tissue. 

This also applies to brightfield data obtained from slides with multiple brightfield stains 

applied to single tissue sections: ideally you will also want to have slides available that have 

only single brightfield stains applied to the tissue. Of course, the fluorescence technique itself 

allows for many more labels, especially using Akoya Bioscience’s method of reducing or 

removing the confounding autofluorescence signal from your slides.  

IMPORTANT: Akoya Biosciences imaging systems and software programs will give you 

optimal results when the tissue sections have been stained well, using protocols that 

give you consistent slides suitable for multilabel brightfield or fluorescence imaging. 

The best results from any imaging system come from good samples. Consider using 

high-quality, well-tested staining kits such as Akoya's Opal multiplex reagent kits for 

fluorescence and a protocol developed for multilabel staining and imaging. (See Figure 

21.1.) 

 

FIGURE 21.1. You should strive to utilize measured and extracted signals from singly stained 
slides that you can store for later use. Left-to-right: multiplexed IHC stained tissue section, 

DAB-only stained tissue section, hematoxylin-only stained tissue section, and Fast Red-only 
stained tissue section. 
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21.2. EXTRACTING A STAIN OR FLUOROPHORE 

Click the Build Libraries tab and then click the Browse button to load an image of a singly 

stained sample. 

NOTE: When loading Digital Slides with inForm Project annotations, only the first 

annotation will be loaded. 

Once the image opens, you can use the Spectral Curves tool  and move the cursor over the 

image to see the spectral curves on the right side of the window in real time. You can set the 

units of the chart. Choose the stain or fluorophore from the drop-down list and click the 

Extract button. Confirm that the image displayed (you can view the original Color image or the 

individual Component image) is accurate, then click the Save to Store button. 

An open DAPI image prior to stain extraction is shown below in Figure 21.2. 

 

FIGURE 21.2. An opened DAPI image before the stain has been extracted. 

Select the display color, add notes, and choose groups for your extracted stain or fluorophore 

before saving it. (See Figure 21.3.) 
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FIGURE 21.3. Clicking Extract allows you to extract and save a measured single stain to the 
Stain Store, which serves as your library of spectra for different stains and fluorophores. 

When a brightfield image is displayed and extracted, you will only see one spectral curve to 

the right of the image in the Build Libraries tab. However, when a fluorescence image is 

displayed, you will see as many spectral curves as you had epi-fluorescence filter sets in use at 

the time of the image acquisition. 

In brightfield, you may receive a message that more than one stain was detected in your 

particular specimen. This is common for DAB and has been seen in other IHC stains.  Confirm 

that your slide is singly stained (without a counterstain); if so, it's safe to proceed. 

To extract your next stain or fluorophore, click the Browse button to load a new image.  If 

you've left an extracted stain or fluorophore unsaved, the system will prompt you before 

loading your next singly stained sample. 

21.3. EXTRACTING A CUSTOM STAIN OR FLUOROPHORE 

If you want to extract and save the spectra for a stain or fluorophore that does not appear in 

the Stain Store (perhaps you are developing new stains or fluorophores), you can create a new 

custom stain or fluorophore in the Stain Store. 
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Go to Tools > Stain Store Manager and click Choose Which Types of Stains and Fluors Your Lab 

Uses. Select the Other (User Specified) line under Family Name, then click the New button and 

enter the Name of your new or custom stain or fluorophore. Choose whether the stain or 

fluorophore will be imaged in brightfield or fluorescence and if it is a nuclear counterstain. 

Click OK and close the Stain Store window. (See Figure 21.4.) 

 

 

FIGURE 21.4. If you have a new stain or fluorophore that does not appear in the Stain Store, 
you can create a new listing for one. 

Select the Build Libraries tab and click the Load Image Browse button. Select the image of 

your singly stained slide, then chose the name of your new/custom stain or fluorophore in the 

Stain/Fluor drop-down list. (See Figure 21.5.) 

For brightfield images, click the Extract button, confirm the results are accurate, then click the 

Save to Store button to save the extracted spectra to the Stain Store. 

For fluorescence images, when the image opens, move your cursor over the pure signal and 

observe the curves that appear to the right of the image. These display how much of the 

signal appears within each fluorescence emission band corresponding to each of your 

epifluorescence filters. 
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FIGURE 21.5. In the Build Libraries tab, you can select your new/custom stain or fluorophore in 
the Stain/Fluor drop-down menu. 

You will have as many curves as you have epi-fluorescence filters in use. The Akoya Biosciences 

Mantra system that was used to acquire the image in Figure 14.6 had 5 filters, and thus 5 

bands and 5 curves. From the drop-down menus, choose the Signal band where the fluor 

most strongly expresses and a Dark band where the fluor does not express at all. (See Figure 

21.6.) Then click the Extract button. 
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FIGURE 21.6. You can use the curves to the right of your image that display the spectra under 
your cursor to select the “Signal Band” where the majority of the signal of your new/custom 

fluorophore appears, and also the “Dark Band” where there is little or no signal. 

After the pure signal has been extracted, you will see a black-and-white image where the 

lighter pixels represent the signal of your new/custom stain or fluorophore. Confirm that the 

image displayed (you can view the original Color image or the black-and-white individual 

Component image) is accurate, then click the Save to Store button. (See Figure 21.7.) 

 

FIGURE 21.7. Once the spectra from your new/custom stain or fluorophore has been extracted, 
you can save it to the Stain Store. 
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21.4. EXTRACTING A FLUOROPHORE WITH A CUSTOM FILTER 

inForm has built-in settings for many manufacturers’ epifilter cubes. If you are using a custom 

filter, inForm requires more information before extraction. 

Click the Build Libraries tab and click the Load Image Browse button. Select the image of your 

singly stained sample. Then select the fluorophore you wish to extract. 

inForm will present two drop-down menus which have been prefilled with the names of the 

bands used in the image. Choose the Signal band where the fluor most strongly expresses and 

a Dark band where the fluor does not express at all. Note that your custom filter may not be 

needed in these selections. (See Figure 21.8.) 

When you have made your selections, click the Extract button. Confirm that the image 

displayed is accurate, and then click the Save to Store button. 

 

FIGURE 21.8. Dark Band drop-down list. 

21.5. EXTRACTING A STAIN FROM A COLOR IMAGE 

Occasionally you may have RGB images from another source that you wish to unmix using 

inForm. In this case you can extract the pure signal from a color (RGB) image of a singly-

stained sample. The image must be of high quality and not contain multiple labels. (See 

Figure 21.9.) 

Select the Build Libraries tab and click the Load Image Browse button. If you are loading an 

extremely large image, you may be asked to bin it to reduce the size. 
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Select the color image (.BMP, .JPG, .TIF, or .PNG file) of your singly stained slide and then 

choose the name of the stain in the Stain drop-down menu. 

 

FIGURE 21.9. When you open a color (RGB) image of a singly stained slide, you need to select a 
white area in order to help the software convert the image to optical density, which is 

necessary in order to properly quantify stain intensity. 

Using the Convert to OD tool, select the brightest white area in the image. inForm will convert 

the image to optical density, which is required to properly quantify stain intensity. 

Click the Extract button and when the black-and-white image of the extracted pure signal 

appears, confirm that the image displayed (you can view the original Color image or the black-

and-white individual Component image) is accurate and click the Save to Store button. (See 

Figure 21.10.) 
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FIGURE 21.10. You can extract a pure signal from a color (RGB) image after it is converted to 
optical density, but the resulting spectra will not be as detailed as the pure signal extracted 

using a multispectral .IM3 file. Note the lack of a smooth spectral curve representing the Fast 
Red stain. Instead of information from many wavelengths, an RGB image only contains 

information for three broadly overlapping regions in the visible wavelength range. 

21.6. USING PROCESSING REGIONS 

Sometimes you will get an error message when clicking the Extract button. If this occurs, you 

can help the inForm algorithm extract the pure signal by using the Process Regions tool  to 

select areas containing the pure signal for brightfield images and to select areas with both the 

primary signal and autofluorescence for fluorescence images. (See Figure 21.11.) 
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FIGURE 21.11. You may have a slide that contains small areas of your stain or fluorophore, and 
clicking the Extract button results in an error. Click the ROI button (diagonal pencil over a 
green circle) and select areas to assist the inForm extraction algorithm. You may need to 

select regions based on different criteria, depending on whether your image is a brightfield or 
a fluorescence one. 

For brightfield images, you might need to select several areas that mostly or only contain the 

signal that you are interested in, avoiding large empty white areas. For fluorescence images, 

do not try to select areas that just contain the signal that you are interested in. Select areas 

that contain both the signal and autofluorescence, perhaps minimizing but not completely 

avoiding areas with large voids or no signal. Do not hesitate to try selecting different areas: you 

can delete areas using the Delete button.  

You might also receive an error message if inForm detects the presence of more than one 

stain or fluorophore in the sample). Although Akoya Biosciences highly recommends using 

singly stained slides, perhaps you have a small amount of inadvertent contamination from 

other stains in your otherwise singly stained slides. Anan image containing a large amount of 

eosin and a much smaller amount of hematoxylin is illustrated in Figure 21.12. You can draw a 

region or regions around the tissue where just the eosin is present, ignoring the rest of the 

image. 
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FIGURE 21.12. In the Build Libraries tab, you can select regions within your specimen that 
contain reasonably pure spectra from a single stain. In this case pink eosin, avoiding areas 

where there are very small amounts of blue hematoxylin present. 

inForm will extract what it believes to be the pure spectra and display the spectral curves to 

the right of a black-and-white image. The black-and-white image represents the presence of 

the pure stain or fluorophore in your sample. You can toggle back and forth amongst the 

Color and Component views in order to check and verify proper selection using the View 

selector above the large displayed image. (See Figure 21.13.) 
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FIGURE 21.13. If there is enough of the pure spectra present for the stain or fluorophore that 
you chose from the drop-down menu, inForm will display the spectral curve that it has 

extracted and a black-and-white image representing the presence of that stain or fluorophore. 

Click the Extract button and when the black-and-white image of the extracted pure signal 

appears, confirm that the image displayed is accurate and click the Save to Store button. 
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APPENDIX A. CALCULATING FRACTIONAL TISSUE AREA 

Fractional tissue areas can be calculated from inForm data using an Excel® PivotTable. 

Examples of this type of calculation are: 

• Tumor load - tumor area / (tumor + stroma) 

• Lung fibrosis - fibrosis area / (normal lung + normal collagen + fibrosis) 

• Breast tissue lobular involution - acini area / (acini + inflammation + lobular stroma) 

It is also possible to calculate tissue fractions where the numerator and denominator are 

different tissue categories, such as: 

• Kappa/lambda ratio in lymphoid tissue - kappa tissue area / lambda tissue area 

This calculation can be performed per image or per slide with inForm (V2.0.1 or higher) 

and legacy Vectra systems. 

INITIAL SETUP 

These instructions assume that you already have an inForm algorithm capable of 

automatically segmenting the tissue categories of interest, and that you have processed 

several images using the algorithm and merged the tissue segmentation tables into a single 

table. 

To compute tissue fraction by slide, you must have a column in the data table for slide ID. 

inForm includes this column for images taken with a Mantra, legacy Vectra 3 system, 

PhenoImager HT, or Fusion. 

The instructions in this section are for Excel® 2010 and may need modification for other 

versions of Excel. 

CREATE A PIVOTTABLE TO COMPLETE FRACTIONAL TISSUE AREA 

To create the PivotTable: 
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1. Start Excel and open the data file. In the Open dialog, select Text Files in the file type 

dropdown list, then select the inForm data file. The file name should end with 

“tissue_seg_data_summary.txt”.  

2. In the Text Import Wizard, if you are using a file from inForm V1.4, change the value for 

Start import at row to 3. This skips the first two rows. For inForm V2.0 or higher, leave 

the value at 1. Click the Finish to open the file. 

3. In the Insert ribbon, click PivotTable. Leave the defaults: use the entire table and put 

the table on a new worksheet. Click OK to create the PivotTable. A new, empty 

PivotTable opens. On the right side, the PivotTable Field List shows all the fields in the 

source table. 

4. Select the check box next to the name of the field to summarize by, usually Sample 

Name or Slide ID. It could also be TMA row and column. The selected field is shown in 

the Row Labels box and as a column in the pivot table. 

5. In the PivotTable Field List, select the check box next to Tissue Category to add Tissue 

Category to the Row Labels list. 

6. Drag Tissue Category from Row Labels to Column Labels. 

7. Some tissue categories in the data may not be used in the tissue fraction calculation, 

for example a Background category. In this case, click the drop-down list next to 

Column Labels and de-select any categories that are not of interest. 

8. In the PivotTable Field List, select the check box next to Area (pixel) to add Area (pixel) 

to the Values box. 

9. You should now have a PivotTable that shows total pixel area for each tissue category 

of interest and a Grand Total. The table has one row for each Sample Name or Slide ID, 

depending on the selection for Row Labels. 
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10. To display pixel area as a percent, right-click Grand Total and select Value Field 

Settings. Select the tab Show Values As. In the drop-down list, select % of Row Total and 

click OK. 

You should now have a pivot table that displays the percent of total area for each tissue 

category. The values of interest can be read directly from the table. For example, a tumor 

category displays the tumor load. 

COMPUTE A RATIO 

The PivotTable does not easily display a ratio of two categories; it only shows each category as 

a fraction of the total. Additional ratios can be added as new computed columns outside the 

pivot table. Use explicit row/column identifiers in the formula, such as “D3”. Don’t use the 

GETPIVOTDATA () function that Excel® provides if you click target cells. For example: 

1. Click the cell in the first empty column in the first data row.  

2. Type the desired formula such as “=C5/B5” and press Enter. 

3. Select the entire range in the target column, starting with the cell just entered. 

4. Type CTRL+D to fill the column range with the desired formula. 

SAVING THE TABLE 

You can save the entire Excel® workbook and/or export the PivotTable data as a text file for 

further processing with other programs. If exporting the PivotTable, you may want to refine 

the table for cleaner output. Below are some suggestions. 

Remove the Grand Total Row at the Bottom 

1. Open PivotTable Options by clicking the Options button at the left of the PivotTable 

Tools > Options ribbon.  

2. In the Totals & Filters tab, deselect Show grand totals for columns. 
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Display Fractional Area 

To display the tissue fraction as a decimal fraction rather than as a percent, click the drop-

down list next to the field name in the Values box. Select Value Field Settings. In the dialog box 

click Number Format and set the desired formatting. 

SAVE AS TAB-SEPARATED VALUES 

To save the file as tab-separated text: 

1. In the File ribbon, choose Save As.  

2. Select Text (Tab delimited) in the Save as type drop-down list. To save as a CSV file, 

select CSV (Comma delimited). 

3. Type the desired file name, select the desired location, and click Save. 

4. Two warning messages display. First, the selected file type does not support workbooks 

that contain multiple sheets. Click the OK button. Then, “[FileName] may contain 

features that are not compatible with Text (Tab delimited).” Click the Yes button. 
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APPENDIX B. AUTO-PROCESSING DATA RECEIVED 
FROM MANTRA SNAP 

New for inForm version 2.1 is auto-processing of data from the Mantra Quantitative Pathology 

Imaging System. This allows you to capture (“snap”) images using the Mantra workstation with 

the Mantra Snap software program and have those images automatically processed in the 

inForm program that comes with the workstation. 

By default, each time you snap a picture using the Mantra instrument, the Mantra Snap 

program saves your image to the location that you selected for your Destination folder. But 

Mantra Snap can also be configured to automatically launch inForm and perform a pre-

arranged operation, such as tissue and cell segmentation and phenotyping, on each of your 

images—even while you continue to snap pictures. 

Chose the Launch inForm Analysis option in the Post Processing editing area and the inForm 

program will be launched, if it is not already running, after you snap a picture. If inForm is 

already running and an algorithm is loaded, the Mantra image will be processed by inForm 

using that algorithm. 

For example, you may be trying to develop a robust phenotyping algorithm on a set of slides 

or a slide with a tissue microarray on it. You can take pictures using the Mantra instrument 

and Mantra Snap. Taking the first image launches inForm, which you then use to develop an 

algorithm that you test by taking more images using Mantra Snap. You can make changes to 

the algorithm based on the results that inForm shows you, and then take more images with 

Mantra Snap, an iterative process. 

After you have a robust algorithm or if you simply wish to apply the algorithm to many images 

as you take them in Mantra Snap, you can select the Batch Process Using inForm option 

which will not bring up the actual inForm user interface but will run a specified algorithm 

(selected using the Browse… button) on each picture you snap in the background. (See Figure 

B.1.) 
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FIGURE B.1. A Mantra image was used to develop an inForm algorithm and then a second 
image taken on the Mantra workstation. Immediately after clicking the Snap button, the 

second image has automatically been opened in inForm and the open algorithm is being 
applied to the image. 
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APPENDIX C. PHENOTYPE CLASSIFICATION BY 
MULTINOMIAL LOGISTIC REGRESSION 

inForm uses a training set, image features and machine learning to classify cells into user-

defined phenotypes. The user provides the training set. Image features are derived from 

texture analysis and cell segmentation. The glmnet1 package from R2 creates the machine 

learning classifier. While the creation of the classifier is complex, the result is a relatively simple 

multinomial logistic regression classifier3 with softmax output. The classifier is applied to the 

features to assign phenotypes to cells. 

INTRODUCTION 

Phenotyping cells in an inForm image (or images) requires four steps: 

1. Create a training set by marking up the image(s). 

2. Create features from the image(s). 

3. Train a classifier using features of the training set. 

4. Apply the classifier to the full image(s). 

5. The first step is controlled by the user. In the second step, inForm uses features from 

the cell segmentation table and adds texture features similar to the ones used for 

tissue classification. In the third step, the training set features are passed to glmnet 

which uses lasso regularization with cross validation to select features and create a 

model. Finally, the model is applied to the full feature table to classify all cells. 

CREATE A TRAINING SET 

The user interacts with inForm to create a training set containing representative samples of 

each phenotype. This process is documented in Chapter 14. Phenotyping Cells. The training 

set must contain at least five examples from each phenotype. 
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CREATE FEATURES 

inForm creates features for each cell in an image. The features come from two sources: cell 

segmentation and component textures. 

Cell Segmentation Features 

The cell segmentation features consist of most of the columns in the full cell segmentation 

table. The columns that are omitted and the reasons for the omissions are: 

• Empty columns and columns containing only or predominantly a single value. 

• Percents - these duplicate the non-percent data. 

• Data specific to an image or the location of a cell within an image: 

o Path 

o Sample Name 

o Cell ID  

o Cell X Position  

o Cell Y Position 

o Category Region ID  

o Process Region ID  

o Distance from Process Region Edge  

o Lab ID  

o Slide ID  

o TMA Sector, Row, Column, Field 

• Tissue Category - this might be informative but it is removed because the classifier 

requires quantitative features. 

• Features which are exact linear combinations of other features; usually just Entire Cell 

Area. 

The number of cell segmentation features varies depending on how many components are in 

the image and how many cell compartments were segmented. Each compartment 

contributes five morphological features (area, compactness, minor axis length, major axis 

length, axis ratio) plus five features per component (minimum, mean, maximum, standard 

deviation, total). If more than one compartment is segmented, features will be created for 

Entire Cell as well. Thus, with ncompartment > 1 compartments and ncomponent components, the 

number of cell segmentation features will be approximately 



USER GUIDE | inForm 

 

AKOYABIO.COM 199  

(ncompartment + 1 ) * (5 + 5 * ncomponent ) - 1 

With three compartments and five components, this gives (3 + 1) * (5 + 5 * 5) - 1 or 119 cell 

segmentation features. 

Refer to the inForm manual for detailed descriptions of the cell segmentation features. 

Texture Features 

Texture features are created for each component of the image. The features are computed 

within a 16x16 pixel kernel placed at each possible location on a 4x4 grid across the image. The 

grid locations are assigned to cells by matching the center points of the kernels with the cell 

segmentation masks. The feature values for the kernels assigned to each cell are averaged to 

give a single value per cell for each feature. There are 10 texture features, so this process gives 

10 features per component for each cell. With three compartments and five components, 

there are 50 texture features and 119 cell segmentation features per cell, a total of 169 features. 

inForm uses three kinds of texture features: spatial frequency measurements, co-occurrence 

features and simple first- and second-order statistics. 

Spatial Frequency Features 

The spatial frequency features represent the relative intensity of four spatial frequency bands 

computed with a two-dimensional Fast Fourier Transform. The full range of frequencies is 

divided into four equal bands. The intensity within each band is summed and normalized by 

the total intensity of all frequencies. 

These make the FFT1, FFT2, FFT3 and FFT4 features. FFT1 represents the lowest frequency and 

FFT4 the highest. 

Co-Occurrence Features 

Grey-level co-occurence features4 are commonly used for texture classification. They were 

originally defined by Haralick et al. (1973)5. A detailed description of these features is beyond 

the scope of this document; please refer to the references. In the language of the references, 

the features used by inForm are Angular Second Moment (ASM), Entropy, Inverse Difference 
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Moment (Homogeneity) and Contrast. The texture features are spatially-invariant (computed 

in four directions) and use an offset distance of one. 

Simple Statistics 

The texture features include the mean and standard deviation of the component value in the 

kernel. To some extent these features duplicate the mean and standard deviation features in 

the cell segmentation table but they are computed differently and the values are not exactly 

the same. 

TRAIN A CLASSIFIER 

The preceding steps create a training set labeled with user-assigned phenotypes, and a 

feature vector for each cell in the training set. These are given to the cv.glmnet function in the 

glmnet package to create a multinomial logistic regression classifier. 

cv.glmnet uses lasso regularization6 to select from the available features. Lasso regularization 

sets some parameters of a regression model to zero, so it can be used for feature selection. The 

number of zero parameters is controlled by a meta-parameter λ whose value is chosen by ten-

fold cross-validation. The value of λ is chosen which minimizes the cross-validation error. 

 

The algorithm used to select features and create the classifier is complex (see Friedman et. al. 

(2010)) but the result is simple. For each of the Κ phenotypes in the training set, glmnet 

constructs a linear predictor fi(X) = X * βi  from the available features X. Each βi is a vector 

whose length is the number of features; lasso regularization forces many of the coefficients βij 

to be zero. For the ith phenotype, the probability that a cell with features X belongs to 

phenotype i is given by the softmax function: 

 

The phenotype for a cell is then taken to be the one with the highest probability, i.e., 

argmaxiP(i | X) The confidence reported by inForm is the probability of the winning 

phenotype, P(i | X), expressed as a percent. 
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Note that the confidence will always be between 1/Κ and 1. If all Κ phenotypes are nearly 

equally likely, the confidence will be slightly greater than 1/Κ. If only one phenotype is likely, it 

will have confidence near 1. 

APPLY THE CLASSIFIER 

Given the βi parameters for each fi(X) and a set of features, it is straightforward to compute the 

fi(X) and P(i | X) and select a phenotype. inForm uses the predict.cv.glmnet function of glmnet 

to perform this computation and return the selected phenotype and confidence. 

Cells in the training set may be misclassified by the glmnet model. For training set cells, the 

model classification is always overridden by the training set classification, and the confidence 

is set to exactly 1. 

 

1. Jerome Friedman, Trevor Hastie, Robert Tibshirani (2010). Regularization Paths for Generalized Linear Models via 
Coordinate Descent. Journal of Statistical Software, 33(1), 1-22. http://www.jstatsoft.org/v33/i01/. 

2. R Core Team (2014). R: A language and environment for statistical computing. R Foundation for Statistical 
Computing, Vienna, Austria. http://www.R-project.org/. 

3. http://en.wikipedia.org/wiki/Multinomial_logistic_regression. 

4. http://www.fp.ucalgary.ca/mhallbey/tutorial.htm. 

5. R. M. Haralick, K. Shanmugam, Its'Hak Dinstein (November 1973). Textural Features for Image Classification. In 
Systems, Man and Cybernetics, IEEE Transactions on, Vol. SMC-3, No. 6. (November 1973), pp. 610-621, 
doi:10.1109/tsmc.1973.4309314. 

6. Tibshirani, R. (1996). Regression shrinkage and selection via the lasso. J. Royal. Statist. Soc B., Vol.58, No. 1, 267-288. 
http://www-stat.stanford.edu/~tibs/lasso/lasso.pdf. 

 
  

http://www.jstatsoft.org/v33/i01/
http://www.r-project.org/
http://www.r-project.org/
http://en.wikipedia.org/wiki/Multinomial_logistic_regression
http://www.fp.ucalgary.ca/mhallbey/tutorial.htm
http://www-stat.stanford.edu/~tibs/lasso/lasso.pdf
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APPENDIX D. AKOYA BIOSCIENCES TIFF FILE 
SPECIFICATION 

BACKGROUND 

This describes a TIFF format that Akoya Biosciences uses for its tissue images. The imagery 

may be a simple RGB image, a set of components extracted from a field or region, or a whole-

slide scan. In the latter case, it may be a brightfield (BF) color RGB image or a multiband 

fluorescence (FL) image. 

The goal is to use the same syntax and metadata for all these kinds of images, and minimize 

the semantic distinctions where possible. Specifically, an extracted component represents 

signal attributed to a stain or fluorescent dye in a sample. The signal values incorporate image 

preprocessing such as normalization for exposure time and spectral unmixing when that 

technique is used. 

DATA FORMAT 

The files are TIFF or BigTIFF images, depending on image size, with multiple images per file. 

For images larger than about 2K x 2K pixels, tiled format is used, and the image is provided in 

several resolutions (pyramidal tiled images).  Tile size is 512 x 512 pixels. Images smaller than 2K 

x 2K are stored in strips rather than in tiles. 

The highest resolution (baseline) image(s) appear first in the file. For each resolution there are 

N baseline images where N depends on the contents. For BF images, N=1 and each image is 

an RGB image. For FL images or unmixed component images, N = number of bands, which is 

usually > 1, and each image is a grayscale image. 

A thumbnail RGB image is provided, and this is a good image to use as an icon in graphical 

image lists. Note that the thumbnail can be used for qualitative sample identification, but 

should not be used to assess relative brightness of different images. This comes after the 

baseline images, meaning it is the second image in BF (RGB) images, and the (N+1)st image 

for  FL images or unmixed component images. 
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Next come the reduced-resolution images (if present). The pyramid contains enough levels 

that the image size is no larger than 2K x 2K at the coarsest resolution. 

For whole-slide scans, there are two more non-tiled images after these: an optional RGB 

image of the label, and a macro (low-resolution) RGB image of the whole slide.  

Overall, the arrangement is illustrated below in Table D.1. 

TABLE D.1. Images 

Description RGB / 
mono 

Tile / 
Strip 

Resolution Notes 

Baseline image Varies Varies Full Tiled if > 2K x 2K 
RGB for BF, else mono 

More full-resolution 
images Mono Varies Full If N > 1 

Thumbnail RGB Strip ~500 x 500 -- 

Half-resolution images Varies Varies Half Only if baseline is tiled 

Quarter, eighth, etc. Varies Varies Quarter, 
eighth, etc. 

Continues until 2K x 2K or 
smaller 

Macro (overview) 
image of whole slide 

RGB Strip ~2000 x 
4000 

Required for whole-slide 
scans Optional for simple 
RGB images and extracted 
components 

Label image RGB Strip ~500 x 500 Optional, whole-slide scans 

DETECTION 

Readers can recognize Akoya tissue images via the contents of the “Software” TIFF tag (see 

below). The file suffix is .qptiff for whole slide scans. Some TIFF tags contain “PerkinElmer” for 

historical reasons; they remain to retain 3rd party reader compatibility. 

METADATA 

Metadata is contained in two locations: within standard TIFF tags as listed in the table below, 

and within the ImageDescription string, using a set of XML tags described below. These are 
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provided for each image (IFD) in the file, and describe that image rather than the baseline 

image or the scan as a whole. The ScanProfile tag is only provided on the first, baseline image 

as it may be large. 

TABLE D.2. TIFF tags 

TIFF Tag Optional? Description of contents 

Software  Starts with “PerkinElmer-QPI” 

ImageDescription  Further metadata in XML format (see next 
section) 

ImageWidth  Width of the image in pixels 

ImageLength  Height of the image in pixels 

ResolutionUnit  
Unit used for resolution and position (see 
below) 

XResolution  Pixel X resolution (see below) 

YResolution  Pixel Y resolution (see below) 

XPosition Y 
Sample X location in ResolutionUnits. This is 
ULHC location except for Macro image which 
reports its image center. 

YPosition Y 
Sample Y location in ResolutionUnits. This is 
ULHC location except for Macro image which 
reports its image center. 

SampleFormat  Integer (1) for BF, FL; or float (3) for extracted 
components 

SMinSampleValue  Minimum signal value in the image  

SMaxSampleValue  Maximum signal value in the image  

BitsPerSample  8 (FL); 8, 8, 8 (RGB); or 32 (unmixed 
component) 

SamplesPerPixel  1 (FL or unmixed component) or 3 (RGB) 

NewSubfileType  0 for full-resolution images, 1 for reduced res 
images 

TileWidth Y Tile width (512) if tiled format is used 

TileLength Y Tile height (512) if tiled format is used 
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TIFF Tag Optional? Description of contents 

TileOffsets Y List of tile offsets, if tiled format is used 

TileByteCounts Y Size of each (compressed) tile, if tiled format is 
used 

StripOffsets Y List of strip offsets, if tiled format is not used 

RowsPerStrip Y 
Number of rows per strip, if tiled format is not 
used 

StripByteCounts Y Size of each (compressed) strip, if tiled format 
is not used 

PlanarConfiguration  1 (chunky) for RGB images, 2 (planar) otherwise 

PhotometricInterpretation  
2 (RGB) for RGB images, 1 (BlackIsZero) 
otherwise 

DateTime  Acquisition time 

Compression  May be None, CCITT Group 3, PackBits, LZW, or 
JPEG 

JPEG fields Y 
JPEG fields are defined when JPEG 
compression is used 

 

ResolutionUnit, XResolution and YResolution are required fields in a valid TIFF file. When the 

true resolution of the image is known, ResolutionUnit will be 3 (cm) and XResolution and 

YResolution will be pixels/cm. When the true resolution is not known, ResolutionUnit will be 2 

(inch) and XResolution and YResolution will be 96 (pixels/inch).  Pixels from Akoya Biosciences 

instruments are always square so XResolution and YResolution will always have the same 

value. 

The TIFF spec is not explicit about the data type and value for SMinSampleValue and 

SMaxSampleValue; the writer uses the same data type as the image pixels (byte or float). 

Image Description Contents 

The ImageDescription tag contains a string in XML format. The string contains a top-level 

<PerkinElmerQPI-ImageDescription> element. Nested within this element are child elements 

with the tag names and values as listed in the table below. Elements appear in the order listed. 
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Values are stored as text content of the element. Elements are required unless otherwise 

specified. See the example below. 

TABLE D.3. Image Description tags 

Tag Optional? Contents 

DescriptionVersion  
Version of the image description field itself, a 
single number. This document describes 
version 4 of the field. 

AcquisitionSoftware  Software used to acquire the image. 

Identifier   GUID in string format. This is an identifier for 
the image file itself. 

SlideID Y ID of the slide that this image was taken 
from. 

SampleDescription Y Text description of the sample. 

OperatorName Y 
Name of the operator as reported by the 
operating system running the acquisition 
software. 

Barcode Y Barcode text of the slide this image was 
taken from. 

ComputerName Y 
Name of the computer on which the slide 
was scanned. 

ImageType  

A string identifying the type of image within 
the file (Table 1), with the following values: 

• FullResolution 
• ReducedResolution 
• Thumbnail 
• Overview 
• Label 

IsUnmixedComponent  “True” for unmixed multispectral images, 
otherwise “False”. 

ExposureTime  

Exposure time as an integer number of 
microseconds. For unmixed images, this is 
the exposure time for the dominant 
wavelength band for the component (FL); or 
the brightest wavelength in the cube (BF). 
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Tag Optional? Contents 

SignalUnits  

A byte wwww tttt where the tttt nibble 
indicates the signal unit type from the 
following:  

• raw counts 
• normalized 

(counts/second/gain/fullscale/binning) 
• OD (optical density) 
• dark-corrected counts 

  

and the wwww nibble indicates how the 
signal is weighted across the spectral bands 
(or colors): 

• average across all bands  
• total summed signal across all bands 
• peak signal in highest-valued band 

For example, a value of 68 (hex 44) encodes 
OD units with peak-signal weighting. 

Name Y 
Band name for FL whole slide scans, 
component name for extracted components. 
Not present for RGB images. 

Color Y 

Color to use when rendering this band, as 
decimal R, G, B byte triplet. Present for FL 
whole slide scans or extracted components. 
Not present for RGB images. 

Responsivity Y 
Instrument responsivity, if available, for FL 
whole-slide and unmixed images. See below 
for details. 

Objective Y 

Objective name, if known, otherwise not 
present. This does not imply a specific pixel 
resolution – see the XResolution and 
YResolution standard TIFF tags instead. 

ScanProfile Y 

Element containing scan and/or and unmix 
parameters. It is valid XML whose contents 
are opaque to most readers. It is only 
provided on the first (baseline) image and is 
omitted from all other IFDs. 

ProtocolName Y Name of the acquisition protocol. 
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Tag Optional? Contents 

ValidationCode  Used for internal data integrity checks – 
readers can ignore this. 

ImagingCycle Y 
Zero-based acquisition cycle for CODEX 
imagery 

Biomarker Y String indicating target such as CD8, Ki67, 
etc. 

ScaleFactor Y 

After allowing for bit-depth conversion, pixel 
values in this dataset have been scaled by 
this factor. For example, if a 12-bit image is 
stored in an 8-bit image, and counts were 
scaled from 4095 to 255, this would be 1; if 
counts were scaled from 3102 to 255, 
ScaleFactor would be 1.3201. Default is 1.  

AutofluorescenceSubtracted Y 

String containing ‘true’ or ‘false’, indicating 
whether this dataset has been subtraction-
corrected by a background 
(autofluorescence) image. Treated as ‘false’ 
by default. 

LampType Y 

String with the FL lamp type: 
• Unknown (default) 
• PriorLumen200 
• PriorLumen220 
• XCiteMultiBandLed 
• PriorMimicLed 
• SolaLed 
• Colibri7 

InstrumentType Y 

String with the instrument type, one of the 
following: 

• Unknown (default) 
• Keyence700 
• Keyence800 
• AxioObserver 
• Dmi8 
• PhenoImager HT 
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Tag Optional? Contents 

CameraType Y 

String with the camera sensor type, one of 
the following: 

• SonyICX285AL 
• HamamatsuC11440 
• IMX265 
• IMX421 

ExcitationFilter Y 

Description of excitation filter with sub-
elements listed below. 
If present, all its sub-elements must be 
provided. 

Name  String with the filter public name. 

Manufacturer  
String with the manufacturer or OEM 
supplier. 

PartNo  String with the manufacturer part number. 

Bands  Collection of bands each as described below. 

Band  
Description of a band with child tags noted 
below. 

Name  String with the band name. 

Cuton  Cuton wavelength of this band in nm. 

Cutoff  Cutoff wavelength of this band in nm. 

CameraSettings Y 

Description of the camera settings used for 
this image with sub-elements listed below.  
If present, all its sub-elements must be 
provided. 

Gain  Gain factor, such as 1, 3, etc. 

Binning  Binning extent, such as 1 for full-resolution, 2 
for 2x2 binning. 

OffsetCounts  Offset count setting for the camera. 
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Tag Optional? Contents 

BitDepth  

Bit resolution used to read out the camera. 
This may differ from the resolution used to 
store this image (for example, it may be 
acquired with 12-bit resolution but saved in a 
QPTIFF file with 8-bit resolution). 

Orientation  

String containing one of the following values: 
• ‘Normal’ (default) 
• ‘Rotate180’ 
• ‘MirrorV’ 
• ‘MirrorH’ 

ROI Y 

Description of the sensor ROI contributing to 
the image. 
Coordinates are sensor pixels before binning. 
Even if the CameraSettings are provided, this 
field is optional. 

X  
X origin of ROI. Left-most pixel in sensor array 
is 0. 

Y  Y origin of ROI. Top-most pixel in sensor array 
is 0. 

Width  Width of ROI. 

Height  Height of ROI. 

 

For whole slide images (BF and FL), SignalUnits will be 64 (hex 40) (raw counts, peak signal). 

For unmixed images, SignalUnits will reflect the unmix settings. 

Instrument Responsivity 

The <Responsivity> tag is a container for a list of normalized instrument response values. This 

tag is present for whole-slide FL images from PhenoImager HT and unmixed FL multispectral 

images originating from PhenoImager HT.   

For whole-slide images, the <Responsivity> tag will contain one <Filter> tag. The < Filter> tag 

contents will be different for each image within the TIFF file, reflecting the filter used to take 

the image.  
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For unmixed component images, the <Responsivity> tag will contain one <Band> tag for each 

band in the original image file. The <Band> tags are repeated for each unmixed component 

image. 

The overview, thumbnail and label images do not have <Responsivity> tags. 

Each <Filter> or <Band> tag describes the instrument responsivity for acquisitions using that 

filter or band. Their contents are described in Table D.4. 

TABLE D.4. Contents of Filter and Band tags 

Tag Contents 

Name The name of the filter (whole-slide image) or band (component image). 

Response 

The instrument response to the reference artifact, normalized for 
exposure. This is raw counts / (2bit depth × exposure time × gain × binning 
area), where bit depth is the bit depth of the imagery, exposure time is in 
seconds, gain is the gain setting of the camera, and binning area is 1 for 
1×1, 4 for 2×2, etc. 

Date The date and time of the reference image in UTC, ISO 8601 format. 

FilterID 

Detailed description of the acquisition filter, as  
 
{ExcitationFilter band name}_ 
{ExcitationFilter manufacturer}:{ExcitationFilter part number} / 
{EmissionFilter manufacturer}:{EmissionFilter part number} 
 
The {ExcitationFilter band name}_ prefix may be omitted if there is only a 
single excitation band. 
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Sample ImageDescription 

Sample ImageDescription for the DAPI band of a FL whole-slide image, containing a single 

<Filter> tag: 

<?xml version="1.0" encoding="utf-8"?> 

<PerkinElmer-QPI-ImageDescription> 

    <DescriptionVersion>1</DescriptionVersion> 

    <AcquisitionSoftware>VectraScan 1.0.0</AcquisitionSoftware> 

    <ImageType>Full Resolution</ImageType> 

    <Identifier>AABED946-BB58-44FB-95B3-48E177E3BB83</Identifier> 

    <IsUnmixedComponent>False</IsUnmixedComponent> 

    <ExposureTime>50</ExposureTime> 

    <SignalUnits>64</SignalUnits> 

    <Name>DAPI</Name> 

    <Color>0,0,255</Color> 

    <Responsivity> 

      <Filter> 

        <Name>DAPI</Name> 

        <Response>30.7</Response> 

        <Date>2015-10-22T13:10:18.0618849Z</Date> 

        <FilterID>Semrock: FF02-409/LP-25 Emission/Semrock: FF01-377/50-25 

Excitation</FilterID> 

      </Filter> 

    </Responsivity> 

    <Objective>4x</Objective> 

    <ScanProfile><! - - this will be a serialized scan protocol. It is valid 

XML but otherwise opaque - - > 

    </ScanProfile> 

    <ValidationCode>4281ff86778db65892c05151d5de738d<ValidationCode> 

</PerkinElmer-QPI-ImageDescription>  
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APPENDIX E. SEGMENTATION MAP TIFF 
SPECIFICATION 

inForm now exports the tissue segmentation map, the object/cell compartment label images, 

and a process region label image in a single file. The file is a multi-image TIFF file where all 

images are 32-bit images. The tissue segmentation map, if present, is the first image; the 

object or cell label images follow, lastly the process region image, if present. Cell 

compartments come in order {nucleus, cytoplasm, membrane} ; only segmented 

compartments are included. 

Metadata about each image is stored as XML within the image’s ImageDescription tag.  

Tissue Segmentation  

The tissue segmentation image is a class map; the value at each pixel is that pixel's tissue 

category ID. In certain cases, the class cannot be calculated, and for such pixels the value is 

255. Category IDs begin at 0. 

The XML structure for the Tissue Segmentation Image Description is: 

<?xml version="1.0" encoding="utf-16"?> 

 <TissueClassMap> 

  <Version>1</Version> 

  <Entry> 

   <Name>{first tissue class name}</Name> 

   <Color>{alpha},{red},{green},{blue}</Color> 

   <ID>{guid string}</ID> 

  </Entry> ... 

  <Entry> 

    <Name>{last tissue class name}</Name> 

    <Color>{alpha},{red},{green},{blue}</Color> 

    <ID>{guid string}</ID> 

  </Entry> 

 </TissueClassMap> 
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The XML contains one <Entry> element for each tissue category. The position of the <Entry> 

element corresponds to the category ID. Colors are specified as four decimal integers in the 

range 0-255. 

Object and Cell Segmentation 

The object and cell segmentation images are label images; the value of each pixel is the ID of 

the object or cell which contains that pixel. The map will report 0 if no object was present, 

which may mean that the area was background or that a particular compartment was not 

found within that cell. The object ID is the same as the ID reported in inForm tables. A label 

image can contain over 2 billion objects. 

The XML structure for both the Object and Cell Segmentation Image Descriptions is the same: 

<?xml version="1.0" encoding="utf-16"?>  

<SegmentationImage> 

  <Version>1</version> 

<CompartmentType>{type}</CompartmentType>   

 </SegmentationImage> 

 
 
where {type} is Nucleus, Cytoplasm, or Membrane for cells, or "Object" for object segmentation. 

Process Regions 

The process region image is a label image; the value of each pixel is the ID of the process 

region which contains that pixel. The map will report 0 if no region was present, which means 

that portion of the image was not processed. The region ID is the same as the ID reported in 

inForm tables. 

The XML structure for the Process Region Image Description is: 

<?xml version="1.0" encoding="utf-16"?> 

<ProcessRegionImage> 

<Version>1</Version> 

</ProcessRegionImage> 
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APPENDIX F. COMPOSITE IMAGE AND PHENOTYPE 
MAP TIFF SPECIFICATION 

inForm exports Composite Images, Composite with Phenotype Map images, and Phenotype 

Map images as multi-image TIFFs where all images are 8-bit RGB images. The Composite 

Image has one layer for each Fluorescence Composite View. The Composite with Phenotype 

Map and Phenotype Map images have one layer for each Phenotyping Schema. 

Metadata about each image layer is stored as XML within the image’s ImageDescription tag. 

The XML structure for the Image Description is: 

<?xml version="1.0" encoding="utf-16"?> 

<ImageDescription> 

 <Version>1</Version> 

 <PhenotypeSchema> 

  <Name>{phenotyping Schema name}</Name> 

  <Phenotypes> 

   <Entry> 

    <Name>{phenotype name}</Name> 

    <Color>{alpha},{red},{green},{blue}</Color> 

   </Entry> 

   { ...other entries } 

  </Phenotypes> 

 </PhenotypeSchema> 

 <Composite> 

  <Name>{composite view name}</Name> 

  <Components> 

   <Entry> 

    <Marker>{marker name}</Marker> 

    <Color>{alpha},{red},{green},{blue}</Color> 

   </Entry> 

  { ...other components } 

  </Components> 

 </Composite> 

</ImageDescription> 
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The XML contains one <Entry> element in the <Phenotypes> block for each phenotype 

possibility in that Phenotyping Schema, and one <Entry> element in the <Components> block 

for each component included in that Fluorescence Composite View. Colors are specified as 

four decimal integers in the range 0-255. 

If an image has no composite view, only the PhenotypeSchema block is included; if it has no 

phenotype map—only the Composite block is included.   
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APPENDIX G. ADAPTIVE CELL SEGMENTATION TIPS 

This section contains tips for Adaptive Cell Segmentation. 

WHAT IS ADAPTIVE CELL SEGMENTATION? 

Adaptive Cell Segmentation allows you to use algorithms that account for variations in 

staining and background levels within and across images to identify cellular compartments 

from multiple image planes. These features provide improved segmentation performance 

compared to previous versions of inForm when images contain mixtures of cell types with very 

different nuclear morphologies. With inForm 2.4, you can segment individual immune and 

cancer cells in densely packed, complex morphologies, including areas with lots of 

inflammation, for more accurate multi-parameter cell identification and spatial analysis using 

the new cell segmentation capabilities of inForm.  

With inForm version 2.4, now you can: 

• Segment highly varying tumor and lymphocyte nuclei, when nuclei differ in size, 

density, and homogeneity, and when there is background signal. 

• More accurately segment individual nuclei in densely packed fields of lymphocytes and 

when cells are a complex mix of immune and cancer cells, compared to previous 

versions of inForm. 

• Include markers in addition to DAPI to identify nuclei. 

• Optimize segmentation with a move-able real-time preview window. 

CONSIDERATIONS BEFORE USE 

• Adaptive cell segmentation should only be used when commencing new projects. 

• Projects developed and saved using inForm 2.3 that include cell segmentation cannot 

be opened using inForm 2.4. 
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• If you want to apply new inForm 2.4 functionality to an existing project, save the project 

developed using v2.3 with post-segmentation image analysis steps removed. Then it 

can be opened in inForm 2.4. 

STEPS FOR ADAPTIVE CELL SEGMENTATION 

Configure New Project 

Select the Adaptive Cell Segmentation radio-button in the Find Features column. (See Figure 

G.1.) 

NOTE: The classic Object-based cell segmentation algorithm is still available using 

inForm 2.4, but the Counterstain-base option is no longer available. 

 

FIGURE G.1. Configure Project – Adaptive Cell Segmentation. 

Choose Which Cellular Compartments to Segment 

NOTE: As with previous versions, the adaptive cell segmentation algorithm can only 

detect cells with nuclear signal. 
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1. If you choose to segment the membrane compartment, we highly recommend also 

segmenting the cytoplasm.  

2. To reduce visual clutter, turn off the membrane and cytoplasm segmentation masks 

until after optimizing the nuclear splitting. 

Add Nuclear Stains 

NOTE: We recommend choosing the strongest, most abundant nuclear component first. 

In many cases, this will be the DAPI stain.  

1. Click the Add… button to add stains to be used for segmentation.  

2. Configure the DAPI signal by clicking the ‘…’ button. 

a. New with inForm 2.4, when you start a configuration, a live preview region displays 

in the current image. This preview provides immediate feedback as you adjust 

parameters throughout the segmentation steps.  

b. The window area is set and cannot be changed, but it can be dragged to any area 

within the tissue image. To zoom in on the window, use the scroll function of the 

mouse or select the Zoom button. 

c. The Live Preview Window provides immediate feedback as segmentation 

parameters are adjusted with each step. (See Figure G.2.) The dotted red circle 

indicates where to choose which cellular compartments to segment. Red arrows 

indicate required selections for DAPI configuration. 
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FIGURE G.2. Live Preview - DAPI Configuration Window. 

 
3. Use the Typical Intensity Slider to adjust the threshold until you have detected all 

pixels expressing nuclear signals. This step is ONLY to collect signal you believe is real 

for the field-of-view at hand.  

NOTE: We recommend turning off all other stains during this step. It may be 

easier to switch to the simulated brightfield pathology view.  

NOTE: Moving the Typical Intensity Slider left (lower value) collects more signal 

from faint nuclei. (See Figure 14.3.) Moving slider right (higher value) collects less 

signal. (See Figure 14.4.) Yellow boxes indicate regions of DAPI signal that may 

require fine tuning to determine validity for serial section analysis. Red arrows 

indicate settings requiring configuration for DAPI detection. 

a. Moving the slider left (lower value) collects more signal from faint nuclei. (See 

Figure G.3.) 
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FIGURE G.3. Slide Left - Lower Value - Settings Requiring Configuration. 

 
b. Moving the slider right (higher value) collects less signal from faint nuclei. (See 

Figure G.4.) 

 

FIGURE G.4. Slider Right - Higher Value. 

 
4. If smaller nuclei are being missed, an adjustment to the Minimum Nuclear Size setting 

is required. This can be adjusted in the Nuclear Component Splitting panel. 

Multiple Nuclear Stains 

With inForm 2.4, it is now possible to select more than one nuclear signal for segmentation. 

For example, FoxP3, with strong staining, can at times cover the DAPI signal. With previous 
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versions of inForm, this could result in the cell not being detected. Using adaptive cell 

segmentation, you can have the confidence that all cells expressing a nuclear stain are 

identified. 

1. Click the Add button to add additional nuclear stains to be used for segmentation.  

2. Click the ‘…’ button to configure the stain. 

NOTE: It is possible to select more than one nuclear signal for segmentation. For 

example, FoxP3, with strong staining, can at times block the DAPI signal. Yellow 

circles indicate regions of FoxP3 signal. Red arrows indicate required selections 

for FoxP3 configuration. (See Figure G.5.) 

 

a. Use the Typical Intensity (Relative) Slider to adjust the threshold until you have 

detected all pixels expressing nuclear signals. 

i. Moving the slider right (higher values) reduces the amount of splitting. 

ii. Moving the slider left (lower values) increases the amount of splitting.  

 
FIGURE G.5. Multiple Nuclear Stains. 
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Split Nuclear Clusters into Individual Nuclei 

It is now possible to describe the quality of the nuclear stain. This will permit better splitting of 

cells, especially when the nuclear stain is non-homogeneous with holes. 

1. After you have identified all the nuclear stains and captured all pixels expressing 

nuclear signal, use the Nuclear Component Splitting panel to adjust splitting 

parameters.  

2. Configure the nuclear splitting sensitivity by clicking the ‘…’ button. 

NOTE: Moving the Nuclear Splitting Settings Slider right (higher value) reduces 

the amount of splitting. (See Figure 14.7.) Moving the slider left (lower value) 

increases the amount of splitting. (See Figure 15.1.) Red arrows indicate the 

settings requiring configuration for nuclear splitting. 

a. Use the Nuclear Splitting Settings Slider to adjust the splitting threshold: 

i. Moving the slider right (higher values) reduces the amount of splitting. (See 

Figure G.6.) 

 

FIGURE G.6. Slider Right - Higher Values. 

 
ii. Moving the slider left (lower values) increases the amount of splitting. (See 

Figure G.7.) 
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FIGURE G.7. Slider Left - Lower Values. 

 
We recommend optimizing this step before identifying assist markers. 

Select Membrane or Cytoplasm Stains to Aid Nuclear Segmentation 

NOTE: When cells are highly clustered, the use of membrane or cytoplasm stains may 

become necessary to better split individual nuclei. 

Add Membrane or Cytoplasm Stains 

Select the Cytoplasm and Membrane check boxes. Choose stains that can best assist your 

nuclear staining. 

• We recommend adding the strongest and most specifically stained membrane 

components first. The assist segmentation algorithm gives priority to nuclear splitting 

lines that are attributed to image components higher up in the list of components to 

be segmented. Please note, for successful segmentation, not all components need to 

be selected to aid nuclear splitting. 

• We recommend optimizing splitting before adding the next component. 

NOTE: With adaptive cell segmentation, having a ‘pan immune marker’ such as 

CD45 may result in better identification of all immune cells. 

NOTE: Cytoplasm segmentation does not take into account any signals from 

identified cytoplasm components. Pixels to designate cytoplasm are identified 
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based on proximity to nuclear edge, within the user-selected distance, and inside 

of membrane compartment. 

Configure the Component 

1. Click the ‘…’ button next to the first added stain.

2. Select the cellular compartment that will find the stain’s signal and then select the Use 

this signal to assist in nuclear splitting check box.

NOTE: A membrane stain can be used to both assist nuclear splitting and to 

segment the membrane compartments. It places rings around segmented nuclei 

according to user-selected parameters, as per Segment Cytoplasm.

3. Repeat for other added stains.

Split Using Membrane or Cytoplasm Stains 

Use the Assisting Component Splitting panel to adjust parameters. This panel is only available 

when the Use this signal to assist in nuclear splitting check box has been selected. 

NOTE: Moving the Assisting Component Splitting Settings Slider right (higher value) 

reduces the amount of splitting. Moving the slider left (lower value) increases the 

amount of splitting. Yellow boxes indicate tumor regions where nuclear splitting is 

affected by assist marker; the stroma remains unaffected. Red arrows indicate settings 

requiring configuration for the assisting component. 

• Use the Assisting Component Splitting Settings Slider to adjust the splitting threshold:

o Moving the slider right (higher values) reduces the amount of splitting. (Figure

G.8.)



USER GUIDE | inForm 

 

AKOYABIO.COM 226  

 
FIGURE G.8. Slider Right - Higher Value. 

o Moving the slider left (lower values) increases the amount of splitting. (See 

Figure G.9.) 

 
FIGURE G.9. Slider Left - Lower Values. 

 
NOTE: Adjustment of the splitting sensitivity will affect all markers you have selected to 

assist in nuclear splitting. 

Further Refinement of Nuclear Shapes 

In the Other Settings panel, it is possible to further refine the nuclear segmentation results. 

This setting is “on” by default. 

• Any nuclei with an empty hole can be filled in by increasing the “Fill Holes Smaller 

Than” value. 
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• We generally recommend selecting the Refine cells after segmentation option, which 

rounds out sharp edges on the nuclear segmentation mask in addition to compacting 

the nuclear compartment slightly. 

Segment Cytoplasm  

Adjust the Cytoplasm Thickness setting to define the distance (in pixels) from the boundary of 

each cell’s nucleus to the out boundary of its cytoplasm. 

NOTE: The Cytoplasm Settings panel is only available when the Cytoplasm 

compartment has been selected for segmentation. 

• With many samples, we find a Cytoplasm Thickness setting of 6 (pixels) works well, but 

adjust accordingly. This distance should be adjusted on visual inspection of the results, 

so that cytoplasm segmentation approximately matches the average size of cells. 

Segment Membrane 

NOTE: The Membrane Settings panel is only available when the Membrane 

compartment has been selected for segmentation. 

1. Set the Membrane Search Distance.  

a. Adjust the Membrane Search Distance to define the distance (in pixels) from the 

boundary of each cell’s nucleus to search for membrane signals. 

b. The Membrane Segmentation algorithm will detect or define the membrane 

compartment based on detected peak signals between the edge of the nucleus 

and the Membrane Search Distance. If no significant peak signal is detected, the 

membrane is set to the nearest stop point: 

• Membrane Search Distance. 

• Neighboring Cell Membrane.  

• Cytoplasm Thickness, if Cytoplasm segmentation was selected. If Cytoplasm 

Segmentation is not selected, (c) becomes half of the search distance. 
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When segmenting the membrane compartment, we strongly recommend selecting the 

cytoplasm for segmentation. The default membrane segment will collapse to the nucleus if no 

peak signals are found, with a distance determined by the Cytoplasm Thickness. This is 

particularly helpful with lymphocytes with no membrane signal or with those that have a 

small cytoplasm compartment. 

The interface requires that the Membrane Search Distance is set larger than the Cytoplasm 

Thickness, so the algorithm can search for signal over larger distances but collapse back to a 

smaller nuclear size if no signals are found. (See Figure G.10.) 

 

 
FIGURE G.10. Membrane Search Distance and Cytoplasm Thickness. 

 
With many samples, we find a Membrane Search Distance of 20 (pixels) works well, but adjust 

accordingly. 

2. Configure the Membrane. 

a. Click the ‘…’ button. 

NOTE: It is now possible to describe the quality of the membrane stain. This 

will permit better splitting of cells, especially when the membrane stain is 

discontinuous or non-specific. 

b. Use the slider to adjust the membrane detection threshold: 

i. Moving the slider to the right (higher value) collects less signal. 
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ii. Moving the slider to the left (lower value) collects more signal from weaker 

membrane signals. (See Figure G.11.) 

 
FIGURE G.11. Membrane Detection Threshold. 

 
Please follow the YouTube link below to watch a video demonstrating each step of the inForm 

2.4 adaptive cell segmentation process: 

https://www.youtube.com/watch?v=VAX92f2ar-M&feature=youtu.be 

 

https://www.youtube.com/watch?v=VAX92f2ar-M&feature=youtu.be


USER GUIDE | inForm 

 

AKOYABIO.COM 230  

ADDITIONAL TIPS AND TRICKS 

1. What signals are used when configuring the splitting threshold? 

• The Nuclear Component Splitting panel only uses stains configured for the nuclear 

compartment. 

• The Assisting Component Splitting panel only uses stains where the Use this signal 

to assist in nuclear splitting check box is selected. 

2. Only when a user chooses to segment the cytoplasm and membrane will the 

membrane and cytoplasm settings show. We recommend having the cytoplasm 

component selected when segmenting the membrane as this helps to increase the 

search distance for the membrane stain ridge. 

3. How does the Minimum Nuclear Size found in the Nuclear Component Splitting and 

Assisting Component Splitting panels differ? 

The Minimum Nuclear Size found in Nuclear Component Splitting plays two roles: 

• Before any splitting occurs, any individual islands of nuclear pixels that are smaller 

than this value are discarded. 

• When splitting based on nuclear components (i.e., splitting due to a valley in DAPI 

intensity), no individual splits are made that create nuclei smaller than this value. 

The Minimum Nuclear Size found in Assisting Component Splitting has one role: o 

When splitting based on membrane/cytoplasm components (i.e., splitting due to a 

peak in membrane intensity), no individual splits are made that create nuclear smaller 

than this value. If no membrane signal is found overlaying a particular island of nuclear 

pixels, this parameter does not matter, defaulting to settings in the Nuclear 

Component Splitting.  

• If the nuclear signal is patchy, you might want to keep the minimum size in 

Nuclear Component Splitting large to avoid getting a large tumor nucleus split 

into many tiny nuclei. At the same time, if you’re confident in the membrane 

staining, you could make the minimum size in Assisting Component Splitting 
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much smaller so you’re allowed to split very dense immune cells into smaller 

objects using the membrane signal. That way you can keep your larger tumor cells 

from being over-split while the immune cells can be more aggressively split by 

membrane-assist. 
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APPENDIX H. AKOYA SOFTWARE VERSION 
COMPATIBILITY 

Some files are read by multiple Akoya acquisition and analysis software programs to facilitate 

unmixing and analysis workflows. Due to major updates in the combined release of 

PhenoImager HT 2.0.0, Phenochart 2.0.0, and inForm 3.0.0 software, outputs from these 

versions are not backward compatible with previous versions of software. However, files from 

previous versions of software are forward compatible. These compatibility considerations are 

detailed in Table H.1. 

TABLE H.1. Akoya software compatibility considerations 

   
VectraPolaris 

1.x.x 
PhenoImager 

HT 2.x.x 
Phenochart 

1.x.x 
Phenochart 

2.x.x 
inForm 

2.x.x 
inForm 

3.x.x 

Scanning protocols 
created in VectraPolaris 
1.x.x can be opened by  

Yes Yes N/A N/A N/A N/A 

Scanning protocols 
created in 
PhenoImager HT 2.x.x 
can be opened by  

No Yes N/A N/A N/A N/A 

QPTIFF images 
acquired with 
VectraPolaris 1.x.x can 
be opened by  

N/A N/A Yes Yes Yes Yes 

QPTIFF images 
acquired with 
PhenoImager HT 2.x.x 
can be opened by  

N/A N/A Some * Yes No Yes 

IM3 images acquired 
with VectraPolaris 1.x.x 
can be opened by  

N/A N/A N/A N/A Yes Yes 

IM3 images acquired 
with PhenoImager HT 
2.x.x can be opened by  

N/A N/A N/A N/A Yes Yes 

Annotations created by 
Phenochart 1.x.x can be 
opened by  

Yes Yes Yes Yes Yes Yes 

Annotations created by 
Phenochart 2.x.x can be 
opened by  

No Yes No Yes No Yes 
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VectraPolaris 

1.x.x 
PhenoImager 

HT 2.x.x 
Phenochart 

1.x.x 
Phenochart 

2.x.x 
inForm 

2.x.x 
inForm 

3.x.x 

Algorithms created by 
inForm 2.x.x can be 
opened by  

N/A N/A N/A N/A Yes Yes 

Algorithms created by 
inForm 3.x.x can be 
opened by  

N/A N/A N/A N/A No Yes 

Projects created by 
inForm 2.x.x can be 
opened by  

N/A N/A N/A N/A Yes Yes ** 

Projects created by 
inForm 3.x.x can be 
opened by  

N/A N/A N/A N/A No Yes 

Spectra extracted in 
inForm 2.x.x can be 
exported as an 
unmixing library for HT 
2.x.x by  

N/A N/A N/A N/A No Yes 

Spectra extracted in 
inForm 3.x.x can be 
exported as an 
unmixing library for HT 
2.x.x by  

N/A N/A N/A N/A No Yes 

 
* Standard 8-bit QPTIFFs can be opened for viewing, but not all annotation features are available. Extended Range or 

Unmixed QPTIFFs cannot be opened.  

** Two considerations:  

1. Due to slight changes to the assignment of cell IDs, phenotyping training sets from inForm 2.x.x cannot be 

used for re-training phenotyping classifiers in inForm 3.x.x. In this case, inForm 3.x.x will post a message that 

you can run the algorithm's phenotype step with its current training, or use inForm 2.8 or earlier to add 

training cells or revise phenotyping.  

2. For projects created in inForm 2.8 with imagery that has 10+ channels, phenotyping computation may 

become unusably slow in inForm 3.x.x. It is recommended that inForm 2.8 projects with imagery that has 10+ 

channels are only run in inForm 2.8. New projects created in inForm 3.0 do not have this issue.  
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APPENDIX I. INFORM EULA 

The following is an agreement (the "Agreement") between you and Akoya Biosciences, Inc., 100 Campus 
Drive, 6th Floor, Marlborough, MA 01752 ("Akoya") for software known as Research Use Only inForm®, including 
any updates, upgrades or enhancement provided by Akoya and any and all accompanying documentation 
(collectively, the "Software").  

 

AKOYA IS WILLING TO LICENSE THE SOFTWARE TO YOU ONLY UPON THE CONDITION THAT YOU 
ACCEPT ALL OF THE TERMS CONTAINED IN THIS AGREEMENT. PLEASE READ THE TERMS CAREFULLY 
BEFORE USING THE SOFTWARE, AS INSTALLING AND/OR USING THE SOFTWARE WILL INDICATE YOUR 
AGREEMENT TO THEM. IF YOU DO NOT AGREE TO ALL OF THE TERMS AND CONDITIONS IN THIS 
AGREEMENT, AKOYA IS NOT WILLING TO LICENSE THE SOFTWARE TO YOU, AND YOU (1) MAY NOT USE 
THE SOFTWARE AND (2) MUST CONTACT AKOYA WITHIN THREE (3) DAYS OF RECEIPT TO ARRANGE FOR 
THE RETURN OF THE SOFTWARE. BY INSTALLING AND/OR USING THE SOFTWARE, YOU ALSO 
REPRESENT AND WARRANT THAT YOU HAVE THE AUTHORITY TO AGREE TO AND BE BOUND BY THE 
TERMS OF THE AGREEMENT. 

 

1. Single Use License. The Software is licensed to you and not sold, and you acknowledge that there is no 
transfer of title or ownership of the Software to you. Subject to the terms and conditions of this Agreement 
and your payment of the license fees for the Software, Akoya hereby grants to you a restricted, non-exclusive, 
non-transferable, non-assignable, non-sublicensable and revocable single-use license to use, for your internal 
research purposes only, the executable code version of the Software and the accompanying documentation 
in hard copy or electronic format. Akoya grants no other licenses hereunder, except for the Research Use Only 
inForm® Software set forth above. Nothing in this Agreement shall be construed as a general internal use 
license. For the avoidance of doubt, no right to use inForm® in Diagnostic Applications is granted under this 
Agreement. Akoya RESERVES ALL RIGHTS NOT EXPRESSLY GRANTED BY THIS AGREEMENT. 

 

2. Specific Restrictions. You may use the Software only on a single computer. You may make only one (1) 
copy of the Software, solely for backup purposes, and such copy must reproduce and include all copyright 
notices indicating Akoya’s ownership of the Software. Except as expressly permitted by applicable law or 
Akoya, you agree that neither you nor a third party acting on your behalf, directly or indirectly, shall: (i) 
decompile, disassemble or reverse engineer the Software or otherwise attempt to derive the source code of 
the Software or underlying ideas, techniques or algorithms, including the review of data structures or similar 
materials produced by the Software; (ii) modify, alter, translate, or create derivative works of the Software; (iii) 
lease, rent, loan, commercially share or otherwise use the Software in any manner to provide service bureau, 
commercial time-sharing or other computer services to third parties; (iv) transmit the Software or provide its 
functionality, in whole or in part, over the Internet or other network; (v) use the Software for any purpose other 
than solely for your internal research; (vi) use the Software to provide any analytics or diagnostics or otherwise 
for the benefit of any third party; (vii) sell, distribute, publish, rent, lease, sublicense, assign possession, allow 
use of or otherwise transfer the Software or any copy of the Software to a third party; (viii) create any 
computer software program or documentation which is similar to or competitive with the Software; (ix) 
encumber, disclose or otherwise make available the Software to any third-party; or (x) remove, modify or 
obscure any copyright, trademark, or other proprietary rights notice in or on the Software. This Agreement 
may not be assigned in whole or in part, except that either party may assign this Agreement without the 
other party’s prior written consent in the event of a merger with an affiliate or other reorganization with an 
affiliate. Any attempted assignment contrary to the terms of this Agreement shall be void.  

 

3. Ownership of Software. As between the parties, Akoya owns all right, title and interest, including all 
existing or future copyrights, trademarks, tools, know-how, and processes, in and to the Software and any 
copies, modifications, alterations or derivative works thereof. You shall have no title to or ownership of the 
Software. As between the parties, Akoya shall retain all rights to market, license and/or sell the Software. The 
Software (including accompanying documentation) constitutes the unpublished confidential information 
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and trade secrets of Akoya. You (i) acknowledge, and agree not to contest, Akoya's rights in the Software; and 
(ii) agree not to disclose and to take reasonable steps to protect any and all confidential information of Akoya 
regarding the Software or that is otherwise disclosed to you in connection with this Agreement. You agree 
that you are responsible for ensuring your employees and agents are prohibited from taking any action 
otherwise prohibited to you under this Agreement and to notify Akoya promptly and in writing of the 
circumstances surrounding any possession, use or knowledge of the Software or any part thereof known to 
you which is prohibited hereunder. You recognize that the covenants contained in this Agreement are 
reasonable and necessary to protect the legitimate interests of Akoya, that Akoya would not have entered 
into this Agreement in the absence of such covenants, and that your breach or threatened breach of such 
covenants shall cause Akoya irreparable harm and significant injury, the amount of which shall be extremely 
difficult to estimate and ascertain, thus making any remedy at law or in damages inadequate. Therefore, you 
agree that Akoya shall be entitled, without the necessity of posting any bond or security, to the issuance of 
injunctive relief by any court of competent jurisdiction enjoining any breach or threatened breach of such 
covenants and for any other relief such court deems appropriate. This right shall be in addition to any other 
remedy available to Akoya at law or in equity. 

 

4. Termination. The license granted in Section 1 above is effective until terminated. This Agreement is 
conditioned upon your continued compliance with the terms and conditions hereof and will terminate 
automatically without notice from Akoya if you fail to comply with any term or condition of this Agreement. 
Furthermore, Akoya may terminate this Agreement at any time upon thirty (30) days’ notice. Upon 
termination of this Agreement, your license to use the Software or any part thereof shall immediately 
terminate, and you shall immediately destroy all copies of the Software (including all accompanying 
documentation) and any other confidential and proprietary information you have received during or in 
connection with this Agreement. Termination of this Agreement by Akoya shall not entitle you to a refund of 
any fees paid for the license of the Software. 

 

5. Limited Warranty. The sole and exclusive warranty applicable to software and firmware products provided 
by Akoya for use with a processor is as follows: Akoya warrants that such software and firmware will 
substantially conform to Akoya's documentation and program manuals current at the time of shipment to 
you when properly installed on the processor. The limited warranty set forth above shall not apply if the 
claimed problem or issue is caused by: the malfunction of computer hardware or software not provided by 
Akoya; your negligence or fault; your failure to follow the instructions set forth in the documentation; changes 
in the hardware or other software not authorized by Akoya; modifications or changes to the Software not 
made or suggested by Akoya; or your failure to implement and maintain a proper backup and recovery 
system. Your exclusive remedy under this Section 5 shall be, at Akoya's option, the replacement or correction 
of the problem or issue causing the non-conformance with the above warranty as promptly as possible 
following notice of such non-conformity, or a refund of the price paid for the Software. 

 

6. No Other Warranties. EXCEPT FOR THE LIMITED WARRANTY STATED IMMEDIATELY ABOVE AND TO THE 
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE SOFTWARE IS PROVIDED "AS IS" WITHOUT 
WARRANTY OF ANY KIND, AND AKOYA EXPRESSLY DISCLAIMS ANY AND ALL IMPLIED WARRANTIES, 
INCLUDING WITHOUT LIMITATION ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, OR NON-INFRINGEMENT OF THIRD PARTY RIGHTS. AKOYA DOES NOT REPRESENT OR WARRANT 
THAT THE RESULTS OR THE USE OF THE SOFTWARE WILL BE CORRECT, ACCURATE OR RELIABLE, WILL 
MEET YOUR REQUIREMENTS, OR THAT THE SOFTWARE WILL OPERATE UNINTERRUPTED OR ERROR-FREE, 
OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. Some jurisdictions do not allow the exclusion of 
implied warranties, so the above disclaimer may not apply to you. YOU ASSUME ALL RISK ASSOCIATED WITH 
THE USE, RESULTS, AND PERFORMANCE OF THE SOFTWARE. 

 

7. Limitation of Liability. IN NO EVENT SHALL AKOYA, ITS AFFILIATES OR SUPPLIERS, OR THEIR RESPECTIVE 
EMPLOYEES, OFFICERS OR AGENTS, BE LIABLE FOR ANY DAMAGES ARISING OUT OF THE DELIVERY, 
INSTALLATION, PERFORMANCE, OR USE OR INABILITY TO USE THE SOFTWARE, INCLUDING WITHOUT 
LIMITATION INCIDENTAL, SPECIAL, CONSEQUENTIAL, PUNITIVE, EXEMPLARY, INDIRECT OR DIRECT 
DAMAGES (INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, RE-RUN 
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TIME, INACCURATE INPUT, WORK DELAYS, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL 
DAMAGES OR LOSSES), WHETHER IN AN ACTION IN CONTRACT, TORT (INCLUDING NEGLIGENCE AND 
STRICT LIABILITY) OR OTHERWISE, AND EVEN IF AKOYA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES, AND REGARDLESS OF WHETHER ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE. AKOYA’S 
AGGREGATE LIABILITY ARISING OUT OF OR RELATING TO THIS AGREEMENT, FOR ANY AND ALL DAMAGES 
THAT YOU MIGHT INCUR (REGARDLESS OF THE FORM OF ACTION GIVING RISE TO SUCH LIABILITY, 
WHETHER IN CONTRACT, TORT OR OTHERWISE) SHALL NOT EXCEED THE PRICE PAID BY YOU FOR THE 
LICENSE OF THE SOFTWARE. Some jurisdictions do not allow the exclusion or limitation of liability for 
consequential or incidental damages. In such jurisdictions, our liability is limited to the greatest extent 
permitted by law. 

 

8. U.S. Government End Users. The Software qualifies as commercial computer software for purposes of the 
Federal Acquisition Regulations (FAR) §52.227-19 and the Department of Defense Supplement to the FAR 
(DFARS) §52.227.7013. If the Software is acquired by a civilian government agency, it is furnished with only the 
minimum Restricted Rights provided by FAR 52.227-19. If the Software is acquired by a military agency, it is 
furnished with only the minimum Restricted Rights provided by DFARS 52.227-7013(c)(1)(ii). 

 

9. Miscellaneous. This Agreement contains the entire agreement of the parties with respect to the subject 
matter hereof and supersedes any proposal or prior agreement, written or oral, and any other 
communications between the parties relating to the subject matter hereof. No modification or waiver of any 
provision of this Agreement shall be effective unless in writing and signed by the parties. No delay or failure 
on the part of any party in exercising any right under this Agreement shall impair any such right or any 
remedy of such party, nor shall it be construed to be a waiver of any continuing breach or default under this 
Agreement. No action, regardless of form, arising out of the transactions contemplated herein may be 
brought by either party more than one (1) year after the cause of action has accrued. In the event any 
provision of this Agreement is held to be unenforceable, the remaining provisions of this Agreement will 
remain in full force and effect. This Agreement shall be governed by the laws of the State of Delaware without 
regard to principles of conflicts of laws. Any disputes relating hereto shall be adjudicated only in any court of 
competent jurisdiction in the State of Delaware, and you hereby consent to the exclusive jurisdiction of those 
courts. This Agreement shall not be governed by the United Nations Convention on Contracts for the 
International Sale of Goods, the application of which is expressly excluded. You may not assign or otherwise 
transfer this Agreement or any of your rights or obligations therein without the prior written consent of 
Akoya. You may not use the Software for any unlawful purpose nor export or re-export the Software except as 
authorized by law. 

 

10. TIFF module: This software uses the LibTIFF 4.0.6 library (http://www.libtiff.org/)  

The TIFF module used is Copyright © 1988-1997 Sam Leffler Copyright © 1991-1997 Silicon Graphics, Inc.  

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear 
in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics 
may not be used in any advertising or publicity relating to the software without the specific, prior written 
permission of Sam Leffler and Silicon Graphics.  

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR 
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.  

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING 
FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND 
ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF 
THIS SOFTWARE.  
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11. This software uses the Vigra 1.6.0 library (http://hci.iwr.uni-heidelberg.de/vigra/) 

This software includes machine-executable object code generated by a source language processor from the 
Vigra libraries covered by the VIGRA license. These libraries have not been modified by Akoya and all rights 
are reserved by the copyright holder. This software is provided "as is" without express or implied warranty, and 
with no claim as to its suitability for any purpose. 

The Vigra library is Copyright © 2008, Ulrich Kothe, Heidelberg Collaboratory for Image Processing 

The VIGRA License 

================= 

(identical to the MIT X11 License) 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation 
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to 
permit persons to whom the Software is furnished to do so, subject to the following conditions:  

The above copyright notice and this permission notice shall be included in all copies or substantial portions of 
the Software.  

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN THE SOFTWARE. 

 

12. This software uses the Boost 1.68.0 library (http://www.boost.org/ ) 

This software includes machine-executable object code generated by a source language processor from the 
Boost libraries covered by the Boost license. These libraries have not been modified by Akoya and all rights 
are reserved by the copyright holder. This software is provided "as is" without express or implied warranty, and 
with no claim as to its suitability for any purpose. 

 

The Boost license is reproduced below: 

Boost Software License - Version 1.0 - August 17th, 2003 

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the software 
and accompanying documentation covered by this license (the "Software") to use, reproduce, display, 
distribute, execute, and transmit the Software, and to prepare derivative works of the Software, and to permit 
third-parties to whom the Software is furnished to do so, all subject to the following: 

The copyright notices in the Software and this entire statement, including the above license grant, this 
restriction and the following disclaimer, must be included in all copies of the Software, in whole or in part, and 
all derivative works of the Software, unless such copies or derivative works are solely in the form of machine-
executable object code generated by a source language processor. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE 
DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR 
THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

 

13. This software uses the CommandLine 1.6.0.0 library 
(https://github.com/commandlineparser/commandline) 

This software makes use of the CommandLine libraries. These libraries have not been modified by Akoya and 
all rights are reserved by the copyright holder. This software is provided "as is" without express or implied 
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warranty, and with no claim as to its suitability for any purpose. The libraries are covered by the MIT License, 
which is reproduced below: 

 

The MIT License (MIT) 

Copyright (c) 2005 - 2012 Giacomo Stelluti Scala 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation 
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to 
permit persons to whom the Software is furnished to do so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial portions of 
the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN THE SOFTWARE. 

 

14. This software uses the NLog libraries (https://github.com/NLog/NLog) 

This software makes use of the NLog libraries. These libraries have not been modified by Akoya and all rights 
are reserved by the copyright holder. This software is provided "as is" without express or implied warranty, and 
with no claim as to its suitability for any purpose. The libraries are covered by the BSD license, which is 
reproduced below: 

 

The BSD for NLog license: 

Copyright (c) 2004-2021 Jaroslaw Kowalski <jaak@jkowalski.net>, Kim Christensen, Julian Verdurmen. All 
rights reserved.  

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.  

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.  

* Neither the name of Jaroslaw Kowalski nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.  

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

15. This software uses the bzip2 program and libbizip2 libraries (http://www.bzip.org) 

This software makes use of the bzip2 program and associated libbzip2 libraries. The program and libraries 
have not been modified by Akoya and all rights are reserved by the copyright holder. This software is provided 
"as is" without express or implied warranty, and with no claim as to its suitability for any purpose. 
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The libraries are covered by the bzip2 license, which is reproduced below: 

This program, "bzip2", the associated library "libbzip2", and all documentation, are copyright (C) 1996-2006 
Julian R Seward. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

2. The origin of this software must not be misrepresented; you must not claim that you wrote the original 
software. If you use this software in a product, an acknowledgment in the product documentation would be 
appreciated but is not required. 

3. Altered source versions must be plainly marked as such, and must not be misrepresented as being the 
original software. 

4. The name of the author may not be used to endorse or promote products derived from this software 
without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Julian Seward, Cambridge, UK. 

jseward@bzip.org 

bzip2/libbzip2 version 1.0.4 of 20 December 2006 

 

16. This software uses the libjpeg-turbo 1.5.0 library (http://libjpeg-turbo.virtualgl.org) 

This software makes use of the libjpeg-turbo library. This library has not been modified by Akoya and all rights 
are reserved by the copyright holder. This software is provided "as is" without express or implied warranty, and 
with no claim as to its suitability for any purpose. The library is covered by the libjpeg-turbo License. 
Additionally, libjpeg-turbo incorporates parts of libjpeg which is covered by the BSD license. 

 

The libjpeg-turbo license is reproduced below: 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met: 

- Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

- Neither the name of the libjpeg-turbo Project nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS", AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
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TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

The BSD for libjpeg license is reproduced below: 

The authors make NO WARRANTY or representation, either express or implied, with respect to this software, 
its quality, accuracy, merchantability, or fitness for a particular purpose. This software is provided "AS IS", and 
you, its user, assume the entire risk as to its quality and accuracy. 

This software is copyright (C) 1991-2010, Thomas G. Lane, Guido Vollbeding. 

All Rights Reserved except as specified below. 

Permission is hereby granted to use, copy, modify, and distribute this software (or portions thereof) for any 
purpose, without fee, subject to these conditions: 

(1) If any part of the source code for this software is distributed, then this README file must be included, with 
this copyright and no-warranty notice unaltered; and any additions, deletions, or changes to the original files 
must be clearly indicated in accompanying documentation. 

(2) If only executable code is distributed, then the accompanying documentation must state that "this 
software is based in part on the work of the Independent JPEG Group". 

(3) Permission for use of this software is granted only if the user accepts full responsibility for any undesirable 
consequences; the authors accept NO LIABILITY for damages of any kind. 

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified 
library. If you use our work, you ought to acknowledge us. 

Permission is NOT granted for the use of any IJG author's name or company name in advertising or publicity 
relating to this software or products derived from it. This software may be referred to only as "the 
Independent JPEG Group's software". 

We specifically permit and encourage the use of this software as the basis of commercial products, provided 
that all warranty or liability claims are assumed by the product vendor. 

 

17. This software uses the zlib1 1.2.8 library (http://www.zlib.net) 

This software makes use of the zlib1 library. This library has not been modified by Akoya and all rights are 
reserved by the copyright holder. This software is provided "as is" without express or implied warranty, and 
with no claim as to its suitability for any purpose. The library is covered by the zlib1 License. 

 

The zlib 1 license is reproduced below: 

(C) 1995-2012 Jean-loup Gailly and Mark Adler 

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held 
liable for any damages arising from the use of this software. 

Permission is granted to anyone to use this software for any purpose, including commercial applications, and 
to alter it and redistribute it freely, subject to the following restrictions: 

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original 
software. If you use this software in a product, an acknowledgment in the product documentation would be 
appreciated but is not required. 

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the 
original software. 

3. This notice may not be removed or altered from any source distribution. 

 

18. This software may use the RServeCLI2 library (https://github.com/SurajGupta/RserveCLI2) 

Original work Copyright (c) 2011 Oliver M. Haynold and other contributors. 

Modified work Copyright (c) 2013 Suraj Gupta 
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All rights reserved. 

 Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met: 

 * Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

 * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

 * Neither the name of the copyright holder(s) nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT HOLDER(S) BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

 

19. This software uses Newtonsoft.Json library (https://www.newtonsoft.com/json) 

This software makes use of the Newtonsoft JSON libraries. These libraries have not been modified by Akoya 
and all rights are reserved by the copyright holder. This software is provided "as is" without express or implied 
warranty, and with no claim as to its suitability for any purpose. The libraries are covered by the MIT license, 
which is reproduced below: 

 

The MIT License (MIT) 

Copyright (c) 2007 James Newton-King 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation 
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to 
permit persons to whom the Software is furnished to do so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial portions of 
the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN THE SOFTWARE. 

 

 

 

Should you have any question concerning this Agreement, you may contact Akoya by writing to Akoya 
Biosciences, 100 Campus Drive, 6th Floor, Marlborough, MA 10752. You may also call +1 855.896.8401 
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